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Read This First
Welcome to the Thermo Scientific Exactive Plus system! Exactive Plus™
is a member of the Thermo Scientific family of mass spectrometer (MS)
detectors that are powered by Orbitrap™ technology.

About This Guide
This Exactive Plus Software Manual provides reference information
about the parameters in the Instrument Configuration window, the
Instrument Setup window, and the Exactive Plus Tune window. For
information about the operating procedures for the Exactive Plus mass
spectrometer, we recommend that you read the Exactive Plus Operating
Manual in its entirety.

Who Uses This Guide
This Exactive Plus Software Manual is intended for all personnel that
need to perform measurements with the Exactive Plus mass
spectrometer, especially the key operator. This manual should be kept
near the instrument to be available for quick reference.

Scope of This Guide
The Exactive Plus Software Manual includes the following chapters:
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•

Chapter 1: “Instrument Configuration Window” describes the
Instrument Configuration window, which displays configuration
information.

•

Chapter 2: “Exactive Plus Readback Status Page for the Information
View” describes the page that allows controlling the instrument
from the Roadmap view of the Xcalibur Home Page window.

•

Chapter 3: “Instrument Setup” describes Instrument Setup, which is
used to specify instrument settings.

•

Chapter 4: “Explore Exactive Plus Tune” provides information
about Exactive Plus Tune, its views, functions, and features.

•

Chapter 5: “Procedures in Exactive Plus Tune” provides information
about procedures in Exactive Plus Tune.

•

Chapter 6: “Reference Information” provides information about
various file types.
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Related Documentation
In addition to this guide, Thermo Fisher Scientific provides the
following documents for the Exactive Plus mass spectrometer:
•

Exactive Series Preinstallation Requirements Guide

•

Exactive Plus QuickStart Guide

•

Exactive Plus Operating Manual

•

Manuals for the delivered ion sources and other software.

You can access PDF files of the documents listed above and of this guide
from the data system computer. The Exactive Plus Tune software also
provides Help.
❖

To view product manuals

Go to Start > Programs > Thermo Exactive Series > Manuals.
❖

To open Help

•

From the Exactive Plus Tune window, choose Help > Help
Content.

•

If available for a specific window or dialog box, click Help or press
F1 for information about setting parameters.

For more information, including upcoming application notes, visit
www.thermoscientific.com.
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Contacting Us
There are several ways to contact Thermo Fisher Scientific.

Assistance
For technical support and ordering information, visit us on the Web:
www.thermoscientific.com/ms
Service contact details are available under:
www.unitylabservice.com

Customer Information Service
cis.thermo-bremen.com is the Customer Information Service site aimed
at providing instant access to
•

latest software updates

•

manuals, application reports, and brochures.

NOTICE Thermo Fisher Scientific recommends that you register with
the site as early as possible. ▲
To register visit register.thermo-bremen.com/form/cis and fill in the
registration form. Once you registration has been finalized you will
receive confirmation by e-mail.

Changes to the Manual
❖

To suggest changes to this manual

•

Please send your comments (in German or English) to:
Editors, Technical Documentation
Thermo Fisher Scientific (Bremen) GmbH
Hanna-Kunath-Str. 11
28199 Bremen
Germany

•

Send an e-mail message to the Technical Editor at
documentation.bremen@thermofisher.com

You are encouraged to report errors or omissions in the text or index.
Thank you.
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Typographical Conventions
This section describes typographical conventions that have been
established for Thermo Fisher Scientific manuals.

Signal Word
Make sure you follow the precautionary statements presented in this
manual. The special notices appear different from the main flow of text:
NOTICE Points out possible material damage and other important
information in connection with the instrument. ▲

Data Input
Throughout this manual, the following conventions indicate data input
and output via the computer:

iv

•

Messages displayed on the screen are represented by capitalizing the
initial letter of each word and by italicizing each word.

•

Input that you enter by keyboard is identified by quotation marks:
single quotes for single characters, double quotes for strings.

•

For brevity, expressions such as “choose File > Directories” are used
rather than “pull down the File menu and choose Directories.”

•

Any command enclosed in angle brackets < > represents a single
keystroke. For example, “press <F1>” means press the key labeled
F1.

•

Any command that requires pressing two or more keys
simultaneously is shown with a plus sign connecting the keys. For
example, “press <Shift> + <F1>” means press and hold the <Shift>
key and then press the <F1> key.

•

Any button that you click on the screen is represented in bold face
letters. For example, “click Close”.
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Topic Headings
The following headings are used to show the organization of topics
within a chapter:

Chapter 1

Chapter Name

Second Level Topics
Third Level Topics
Fourth Level Topics

Thermo Fisher Scientific
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Instrument Configuration Window
NOTICE Never change the settings in this window except during
installation of the instrument. Any changes in this window affect the
data acquisition or the functionality of your instrument. A later change
will rarely solve problems users have to face. ▲
The Instrument Configuration window displays Exactive Plus
configuration information. See Figure 1-1.

Figure 1-1.

Instrument Configuration window
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Instrument Configuration Window

The Instrument Configuration window has the following parameters:
Parameter

Description

Path to instrument files

Displays the location of the instrument files.
To change the path, click the folder button on the right side of the text box. A
dialog box appears where you can select another location.

Path to log files

Displays the location of the log files. For information about the content of the log
files, see “Log Files” on page 6-2.
To change the path, click the folder button on the right side of the text box. A
dialog box appears where you can select another location

Base port

Displays the first TCP/UDP port in use for this particular instrument. Leave the
field empty for an automatic assignment.

Network address

Displays the hardware address of the network card installed in the instrument.
Leave the field empty for an automatic assignment.

IP address

Displays the IP address. Leave the field empty for an automatic assignment.

Public Name

Displays the name that is shown in the About dialog box of Exactive Plus Tune.

Instrument type

Displays the configured instrument type, that is Exactive Plus.

IP address range

Displays the IP address or IP address range which should be assigned to the
instrument during its starting phase. Use the numeric form, for example
“172.16.2.1-172.16.2.15”.
NOTICE Change only when advised by your network administrator. ▲

Message box

Displays information about the instrument and connection status.

Buttons

Apply

Saves your changes in this window.

Reset changes

Discards your changes in this window.

Help

Displays the Help for this window.
❖

To display this window

1. Choose Programs > Thermo Foundation 2.0 > Instrument
Configuration.
2. From the Instrument Configuration window, click Exactive Plus Orbitrap MS in the Configured Devices area.
3. Click Configure.

1-2
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Information View

Chapter 2

The readback status of each Xcalibur-configured instrument appears on
the Status page of the Information view. When you click an instrument,
Xcalibur displays current readings for the instrument on a page below
the Run Manager pane. See Figure 2-2.
Right-click any of the instruments to display a shortcut menu where you
can switch your instrument to On, Off, or Standby mode.
NOTICE This view is normally displayed on the left side of the Home
Page window. If this view is not displayed, the view has been turned
off. ▲

Figure 2-2.
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Exactive Plus Readback Status Page for the Information View
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Exactive Plus Readback Status Page for the Information View

The following functions are available:
Button

Description

Communication Status

Shows the actual communication status of the system:
• Green: communication with instrument is ok.
• Yellow: only service is accessible (no instrument).
• Red: communication is broken (no instrument, no service).

Instrument Status

Shows the actual hardware status of the system (top instrument tree
state):
• Green: all readbacks are in specifications (green hooks).
• Red: one or more readbacks are out of range.

Performance Status

Shows the actual performance status of the system:
• Green: the last evaluation/calibration was successful.
• Yellow: last evaluation/calibration was successful, but is out of
date.
• Red: the evaluation/calibration was not successful.

Tune

Opens the Exactive Plus Tune window.
❖

To open this page

1. From the Home Page window, choose View > Info View to display
the Information view.
2. Click the Status tab.
3. Click Exactive Plus - Orbitrap MS.

2-2
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Instrument Setup
After you have selected in the Instrument Configuration program which
instruments you want Xcalibur to control, use Instrument Setup to
specify your instrument settings.
Contents

Thermo Fisher Scientific

•

Instrument Setup Window

•

Experiment Setup Page

•

Summary Page

•

Dialog Boxes of the Method Editor

Exactive Plus Software Manual (P/N 1323070, Revision A)

3-1

Instrument Setup
Instrument Setup Window

Instrument Setup Window
The Instrument Setup window displays the icons of the instruments
that you have selected using the Instrument Configuration window. (See
the View bar on the left side of the window.) See Figure 3-3. If you have
configured more instruments than can be displayed on your screen, a
vertical scroll bar appears in the View bar so that you can access all of the
instruments.

Figure 3-3.

Instrument Setup window
To enter the setup parameters for a particular instrument, click the icon
for that instrument. Xcalibur displays one or more pages of parameters
to be set for the one you selected.
NOTICE Prior to using the Instrument Setup window, use the
Instrument Configuration program to select the instruments to be used
for your experiment. ▲

3-2
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Instrument Setup Window

Use Instrument Setup to specify settings for your instruments after you
have selected with the Instrument Configuration program the
instruments that you want Xcalibur to control. The Instrument Setup
window displays the setup parameters required for each instrument that
you select on the View bar. These might include your autosampler,
LC pump, mass spectrometer, divert valves, syringe pump, contact
closure timing sequence, and/or all other Xcalibur supported
instruments that you have configured.
You can create new methods, modify existing methods, and save method
files.
❖

To display this window

•

Click

•

Alternatively, choose GoTo > Instrument Setup.

from the Roadmap view of the Home Page window.

View Bar
The View bar is a vertical bar on the left of the Instrument Setup
window. It contains buttons for each of the instruments that you have
selected by using the Instrument Configuration program.

Menus
Instrument Setup contains the following menus:
•

File Menu for the Instrument Setup Window

•

Help Menu for the Instrument Setup Window

Toolbar
Instrument Setup Window Toolbar

File Menu for the Instrument Setup Window
The File menu provides commands for file and program operations. It
has the following commands:

Thermo Fisher Scientific

Command

Description

New

Create a new method file having the
appropriate extension.

Open

Find and open a file that already exists.
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Command

Description

Save

Save the active method. Changes will be
recorded in Audit Trail after the method is
saved.

Save As

Edit user and description information, as well
as view header information about the active
file.
Xcalibur opens the Save As dialog box.
Changes will be recorded in Audit Trail after
the method is saved.

3-4

Summary
Information

Edit user and description information, as well
as view header information about the active
file.

Change Study
Name

Select a dataset from a predefined list of names.

Audit Trail

View all auditable events and changes made to
data files in the current application.

Print

Print the parameters in your instrument
method.

Print Preview

View your page setup so that you can see what
it looks like before printing it.

Print Setup

Select the following printing options: printer,
form, orientation, and one- or two-sided
printing.

Most Recently
Used Files

View the paths and names of the last four files
used. These are located above the Exit
command. Both open and closed files are
displayed. Click a displayed file to load it. If
the selected file was closed, it will be opened.

Exit

Close the active window. If you exit before
clicking OK from an active dialog box,
Xcalibur asks if you want to save your changes.
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The text of this menu item might be different
if the administrator chose to use another name
for a dataset. For example, this menu item
might be Change Job Name.
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Help Menu for the Instrument Setup Window
The Help menu lists the following commands:
Command

Description

Exactive Plus - Orbitrap
MS Help

Open the Configuration and Setup Help
for the instrument.

Instrument Setup Help

Open Xcalibur Help and display Help for
the Instrument Setup window.

Help On Current Item

View Help for the Instrument Setup page
that is currently displayed.

Exactive Plus - Orbitrap
MS Contents and Index

View the Contents, Index, and Find Help
pages for the selected instrument.

Xcalibur Help

Open Xcalibur Help.

Glossary

Open the Xcalibur glossary.

How to use Online Help

Open Help that describes how to use the
Help viewer.

About Instrument Setup

View the version number of the
Instrument Setup program and the
Thermo Fisher Scientific copyright
notice.

Instrument Setup Window Toolbar
The toolbar provides symbol shortcuts for frequently used commands.
The following functions are available:

Thermo Fisher Scientific

Button

Description

New

Create a new instrument method.

Open

Find and open an existing file.

Save

If your method has not been saved before,
clicking Save opens the Save As dialog box. Select
the name and location for your instrument
method. When you click Save, the File Summary
Information Dialog Box opens. Enter header
information for your instrument method. The file
is saved when you click OK.

Print

Print the parameters in your instrument method.

Home Page

View the Home Page window - Roadmap view.
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Button

Description

Help

View Help for the Instrument Setup page that is
currently displayed.

Method Editor
Use the Method Editor to specify the type of mass spectrometer
experiment you plan to perform. See Figure 3-4.

Figure 3-4.

Method Editor
The Method Editor comprises the following pages:
•

Experiment Setup Page

•

Summary Page

❖

To display this view

Click Instrument Setup from the Roadmap View of the Home
Page window or choose GoTo > Instrument Setup.

3-6
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Instrument Setup
Experiment Setup Page

Experiment Setup Page
Use the Experiment Setup page to set up Exactive Plus mass
spectrometer experiments. You use this page to specify values for the
Exactive Plus parameters and save the parameters in an instrument
method. See Figure 3-5.

Global Settings pane

Graph pane

Properties pane

Workflows pane

Figure 3-5.

Method Editor—Experiment Setup page
The Experiment Setup page comprises four major windows:

Thermo Fisher Scientific

•

Global Settings Pane

•

Workflows Pane

•

Graph Pane

•

Properties Pane
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Experiment Setup Page

Global Settings Pane
The Global Settings pane is located on the top left side of the
Experiment Setup page. It gives access to global lists, tune files, external
hardware, chromatogram, and scan groups. See Figure 3-6.

Figure 3-6.

Method Editor—Global Settings pane

The Global Settings pane contains the following panes:
•

Global Lists

•

Tune Files

•

External Hardware

•

Chromatogram

•

Scan Groups

Click the title bar of an individual pane to display it. Click again to hide
it.

3-8
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Global Lists
Use the Global Lists pane to specify parent, reject, and/or non-data
dependent masses with customizable and independent time windows.
See Figure 3-7. Scan events that reference the mass lists that you create
here run only if there is a corresponding mass/time window at that
particular retention time. Active mass lists are saved with the method.

Figure 3-7.

Method Editor—Global Lists

The following dialog boxes are available:
•

Lock Masses Dialog Box

•

Inclusion List Dialog Box

•

Exclusion List Dialog Box

To display a dialog box, click the respective icon.
Tune Files
The Tune Files pane shows a graphical representation of the tune files
usage during the various phases of the experiment. See Figure 3-8. In
addition to the base tunefile, you can specify up to 50 other tune files.

Figure 3-8.

Method Editor—Tune Files
❖

To assign tune files

1. Do one of the following:
•

Point to a position on the time bar and right-click. Choose
Change to another tunefile at <time at pointer position> in
the shortcut menu.

•

Change the value of the Switch Count parameter in the
Properties of Tunefiles pane.

2. In the Properties of Tunefiles pane, click the button adjacent to the
respective box of the Base Tunefile or New Tunefile parameter and

Thermo Fisher Scientific
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browse for the new tune method file. See Figure 3-9. Select the tune
files and assign them to the experiment phases.

Figure 3-9.

Properties of Tunefiles

The name and path way of the tune files will be shown on the
respective time bar on the Tune Files pane.
❖

To change the starting time for tune files

•

Position the cursor between adjacent tune files and drag the scan
event along the time bar.

•

In the Properties of Tunefiles pane, enter the time in the box of the
At parameter of the respective Element.

❖

To remove a tune file

1. Position the cursor between adjacent tune files
2. Right-click to display the shortcut menu and choose Remove
change to tunefile at <time at pointer position>. The tune file to
the right is removed.
❖

To zoom on the Tune Files pane

•

Position the mouse pointer within the time axis area and drag the
mouse across the time area of interest.

•

To zoom in, position the mouse pointer within the pane and roll the
mouse wheel forward.

•

To zoom out, roll the wheel backward.

•

To increase the zooming factor by two, keep the <Shift> key pressed
while using the mouse wheel.

❖

To unzoom the Tune Files pane

Right-click in the pane to display the shortcut menu. Choose
Unzoom.

3-10
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❖

To display this view

On the External Hardware pane, expand the Tune Files item.
External Hardware
Use the External Hardware pane to configure and control optional
hardware.
Divert Valve a / Divert Valve b
The Divert Valve items show graphic representations of the activities of
the optional switching valves during the active acquisition. See
Figure 3-10. The normal LC flow through the switching valve
(Position 1-2) is to the mass spectrometer. When the switching valve is
activated (Position 1-6), LC flow is diverted to waste.

Figure 3-10. Properties of a switching valve that is used
❖

To display this view

On the External Hardware pane, expand the Divert Valve a or
Divert Valve b item.
Use the shortcut menu of a Divert Valve item and the parameters of its
Properties pane to control its activities:
❖

To activate a switching valve

•

Right-click in the pane to display the shortcut menu. Choose
Activate. The gray color

changes to the blue color

. See Figure 3-10.

Thermo Fisher Scientific
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•

Click the valve symbol to select it. Set the Used parameter on the
Properties pane to True.

❖

To deactivate a switching valve

•

Right-click in the pane to display the shortcut menu. Choose
Deactivate. The blue color changes to a gray color
Figure 3-11.

•

. See

Click the valve symbol to select it. Set the Used parameter on the
Properties pane to False.

Figure 3-11. Properties of a switching valve that is not used
❖

To change the start position of a switching valve

•

Right-click in the pane to display the shortcut menu. Depending on
the active start position, choose Start in 1-6 or Start in 1-2. The
valve changes its start position.

•

Click the valve symbol to select it. Depending on the active start
position, set the Start in 1-2 parameter on the Properties pane to
True or False.

❖

To add a switch position for a switching valve

1. Activate the switching valve as described above.
2. Do one of the following:
•

Use the mouse:

a. Move the mouse pointer to the position on the time line where
you want to establish a switch position (5 minutes, for example).
b. Right-click in the pane to display the shortcut menu. Choose
Add switch at 5.00.

3-12
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•

Use the Properties pane:

a. Click the valve symbol to select it.
b. Set the Switch count parameter on the Properties pane to 1.
A step in the line of the graphic representation indicates the new
switch point. See Figure 3-10.
3. To change the time of the switch position, do one of the following:

❖

•

Drag the step that indicates the switch position to the new time.

•

On the Properties pane, set the At parameter of the respective
Element to the new time.

To delete a switch position

1. Move the mouse pointer to the switch position on the time line (at 5
minutes, for example).
2. Right-click in the pane to display the shortcut menu. Choose
Remove switch at 5.00.
Syringe
The Syringe item shows a graphic representation of the activities of the
optional syringe pump during the active acquisition. See Figure 3-12.

Figure 3-12. Syringe Pump pane
❖

To display this view

On the External Hardware pane, expand the Syringe Pump item.

Thermo Fisher Scientific
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Use the shortcut menu of the Syringe Pump item and the parameters of
its Properties pane to control the activity of the syringe pump:
❖

To activate the syringe pump

•

Right-click in the pane to display the shortcut menu. Choose
Activate. The gray color

changes to the red color

. See Figure 3-12.
•

Click the valve symbol to select it. Set the Used parameter on the
Properties pane to True.

❖

To deactivate the syringe pump

•

Right-click in the pane to display the shortcut menu. Choose
Deactivate. The red color changes to a gray color

.

•

Click the valve symbol to select it. Set the Used parameter on the
Properties pane to False.

❖

To change the start position of the syringe pump

•

Right-click in the pane to display the shortcut menu. Depending on
the active start position, choose Start in ON or Start in OFF. The
pump changes its start position.

•

Click the syringe symbol to select it. Depending on the active start
position, set the Start in Off parameter on the Properties pane to
True or False.

❖

To add a switch position for the syringe pump

1. Activate the syringe pump as described above.
2. Do one of the following:
•

Use the mouse:

a. Move the mouse pointer to the position on the time line where
you want to establish a switch position (5 minutes, for example).
b. Right-click in the pane to display the shortcut menu. Choose
Add switch at 5.00.
•

Use the Properties pane:

a. Click the syringe symbol to select it.
b. Set the Switch count parameter on the Properties pane to 1.
A step in the line of the graphic representation indicates the new
switch point. See Figure 3-12.
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3. To change the time of the switch position, do one of the following:

❖

•

Drag the step that indicates the switch position to the new time.

•

On the Properties pane, set the At parameter of the respective
Element to the new time.

To delete a switch position

1. Move the mouse pointer to the switch position on the time line (at
5 minutes, for example).
2. Right-click in the pane to display the shortcut menu. Choose
Remove switch at 5.00.
Contact Closure
The Contact Closure item shows a graphic representation of the contact
closure activities during the active acquisition. See Figure 3-13.

Figure 3-13. Contact closure
❖

To display this view

On the External Hardware pane, expand the Contact Closure item.
Use the shortcut menu of the Contact Closure item and the parameters
of its Properties pane to control the contact closure activities:
❖

To activate the contact closure

•

Right-click in the pane to display the shortcut menu. Choose
Activate. The gray color

changes to the green color

. See Figure 3-13.
•

Click the contact closure symbol to select it. Set the Used parameter
on the Properties pane to True.

❖

To deactivate the contact closure

•

Right-click in the pane to display the shortcut menu. Choose
Deactivate. The green color changes to a gray color
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•

Click the contact closure symbol to select it. Set the Used parameter
on the Properties pane to False.

❖

To change the start position of the contact closure

•

Right-click in the pane to display the shortcut menu. Depending on
the active start position, choose Start in Open or Start in Closed.
The contact closure changes its start position.

•

Click the contact closure symbol to select it. Depending on the
active start position, set the Start in Closed parameter on the
Properties pane to True or False.

❖

To add a switch position for the contact closure

1. Activate the contact closure as described above.
2. Do one of the following:
•

Use the mouse:

a. Move the mouse pointer to the position on the time line where
you want to establish a switch position (5 minutes, for example).
b. Right-click in the pane to display the shortcut menu. Choose
Add switch at 5.00.
•

Use the Properties pane:

a. Click the contact closure symbol to select it.
b. Set the Switch count parameter on the Properties pane to 1.
A step in the line of the graphic representation indicates the new
switch point. See Figure 3-12.
3. To change the time of the switch position, do one of the following:

❖

•

Drag the step that indicates the switch position to the new time.

•

On the Properties pane, set the At parameter of the respective
Element to the new time.

To delete a switch position

1. Move the mouse pointer to the switch position on the time line (at
5 minutes, for example).
2. Right-click in the pane to display the shortcut menu. Choose
Remove switch at 5.00.
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Chromatogram
The chromatogram display shows the chromatogram for the selected
raw file. See Figure 3-14. If you have previously obtained a raw file
(*.raw) of the chromatographic component separation, you can open
this file.

Figure 3-14. Chromatogram Display
❖

To display a chromatogram

1. In the Properties of Chromatogram pane, click into the empty field
of the Rawfile parameter to display the
button. See Figure 3-15.

Figure 3-15. Selecting a rawfile
2. Click the
button to open a dialog box where you can browse for
the raw file.
3. Select the raw file.
4. If available, select a scan filter.
5. Select a trace type. See Figure 3-9.

Figure 3-16. Properties of Chromatogram
The software updates the chromatogram immediately after a change.
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❖

To zoom on the chromatogram

•

Position the mouse pointer within the time axis area and drag the
mouse across the time area of interest.

•

To zoom in, position the mouse pointer within the chromatogram
and roll the mouse wheel forward.

•

To zoom out, roll the wheel backward.

•

To increase the zooming factor by two, keep the <Shift> key pressed
while using the mouse wheel.

❖

To unzoom the chromatogram

Right-click in the Scan Groups pane to display the shortcut menu.
Choose Unzoom.
NOTICE The chromatogram is also zoomed when the time axis of the
Scan Groups is zoomed. ▲
❖

To display this view

On the External Hardware pane, expand the Chromatogram item.
Scan Groups
In the Scan Groups pane, time bars represent the scan events during the
acquisition. See Figure 3-17. The Scan Groups pane is filled when you
drag experiment symbols from the Workflows pane to the Graph pane.

Figure 3-17. Scan Groups
Use the Properties pane of a scan event to control the activities during
individual experiments. Red triangles ( ) to the left side of a time bar
indicate active scan events.
❖

To display the active scan events at a certain time

Click the time line at the position. A red arrow (

) indicates the

selected time. A green triangle ( ) to the left side of the time bar
indicates the active scan event. If scan events overlap at the selected
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time, green triangles appear for each active scan event. The bottom
part of the Properties pane shows the parameters for the selected
scan event.
❖

To change start and end time of a scan event

•

Drag the left and right edges of the time bar to the desired positions
on the time line.

•

Enter the times in the Minimum and Maximum boxes of the
runtime parameter on the Properties pane.

❖

To zoom on the Scan Groups pane

•

Position the mouse pointer within the time axis area and drag the
mouse across the time area of interest.

•

To zoom in, position the mouse pointer within the pane and roll the
mouse wheel forward.

•

To zoom out, roll the wheel backward.

•

To increase the zooming factor by two, keep the <Shift> key pressed
while using the mouse wheel.

❖

To unzoom the Scan Groups pane

Right-click in the pane to display the shortcut menu. Choose
Unzoom.
NOTICE The Scan Groups pane is also zoomed when the time axis of
the chromatogram display is zoomed. ▲
❖

To display this view

On the External Hardware pane, expand the Scan Groups item.

Workflows Pane
The Workflows pane is located on the bottom left side of the
Experiment Setup page. It gives access to predefined templates.
Every single experiment is associated with a descriptive icon. This icon
can be dragged from the Workflows pane to the Graph pane. When
selected, the icon gives an overview to the operator, which experiment
and which associated options are active currently. Therefore, this icon
changes dependent on the settings.
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System Templates
The System Templates folder contains predefined templates for
experiments. See Figure 3-18.

Figure 3-18. Available system templates
You cannot delete the system templates.
The following experiment templates are available:
Template

Workflow Symbol

Description

Full MS

The Full MS is a workflow to acquire full
MS scans, where the ions of the set m/z range
define the analyzer detection window. The
workflow consists of only one scan event, because
there are no necessary interscan dependencies.

AIF only

The AIF only is a workflow to acquire HCD
MS scans, where the ions of the set m/z range
define the analyzer detection window. The
workflow consists of only one scan event, because
there are no necessary interscan dependencies.

Full MS - AIF

The Full MS / AIF workflow contains two scan
events (SE), which are alternately acquired. SE1
is a full MS scan and SE2 is an AIF scan,
fragmenting all ions from the mass range defined
in SE1.
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Template

Workflow Symbol

Full MS - dd-AIF (TopN)

Description

The TopN workflow contains two scan events
(SE). The first one (SE1) is a full MS and is
acting as the master scan for SE2, which is a Data
Dependent AIF (dd-AIF). With this workflow, it
is possible to select the N most intense peaks (or
charge state cluster if using exclude isotopes) that
are observed in the Full MS-SIM before
fragmenting all ions by HCD to get fragments.
The product of the set loop count, which is
defining the number of repetitions of SE2 per
cycle, is resulting in the total number of
precursors N that should be selected in one scan
cycle (SE1-SE2), if enough candidates are
available.
The ions from SE1 will be evaluated by various
selection criteria, defined in the Data Dependent
settings part, to restrict the pool of candidates to
ions with specific properties.

Graph Pane
The Graph pane is located at the middle bottom side of the Experiment
Setup window. It shows graphic representations of the scan events
during the acquisition. See Figure 3-19.

Figure 3-19. Graphic representation of the experiment
❖

To add an experiment to the active method

1. Drag an experiment symbol from the Workflows pane to the gray
bar in the Graph pane. For each symbol, a corresponding time bar is
displayed in the Scan Groups pane.
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2. Use the Properties pane of a scan event to control the activities
during individual experiments.
❖

To delete an experiment

1. Right-click the experiment symbol to display the shortcut menu.
2. Choose Delete this <Name of Workflow>.
❖

To zoom in or out on the Graph pane

•

Position the mouse pointer within the pane and roll the mouse
wheel forward to zoom in.

•

Roll the wheel backward to zoom out.

The zoom factor ranges from 0.25 to 2. The actual zoom factor is
displayed in the top right corner of the Graph pane.

Properties Pane
The Properties pane is located on the right side of the Experiment Setup
page. See Figure 3-20.

Figure 3-20. Properties pane
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The pane consists of two parts:
•

Properties of the Method
The upper part is always available. It shows the properties of the
active method.

The lower part depends on the item that is selected on the left side of
the Experiment Setup page. One of the following tables is displayed:
•

Properties of Tunefiles
The table shows the properties of the tune files selected in the
Global Settings pane.

•

Properties of Divert Valve A / Divert Valve B
The table shows the properties of the switching valve selected in the
Global Settings pane.

•

Properties of Syringe
The table shows the properties of the syringe pump selected in the
Global Settings pane.

•

Properties of Contact Closure
The table shows the properties of the contact closure selected in the
Global Settings pane.

•

Thermo Fisher Scientific

The table shows the parameters for the experiment symbol selected
in the Graph pane:
-

Properties of Full MS

-

Properties of AIF

-

Properties of Full MS / AIF

-

Properties of Full MS / dd-AIF
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Properties of the Method
The properties of the method include the following parameters:
Parameter

Description

Global Settings

use lock masses

Use the list box to specify how lock masses are used in the active instrument method.
The following options are available:
•
•

•

off
No lock masses are used.
best
Only the most intense lock mass of the global list that is found in the spectrum is
used for a calibration.
if all present
Lock masses are used only when all masses of the global lock mass list are present
during the acquisition.

NOTICE If timed lock masses are used, the Exactive Plus mass spectrometer takes into
account only those lock masses whose time windows cover the current retention
time. ▲
Time

Method duration

Use this box to specify the total mass spectrometer acquire time, in minutes, for the
run. Exactive Plus Tune rescales the Segments bar to correspond to the specified
acquire time.
To change the time, click the arrows in the spin box to increment [up arrow] or
decrement [down arrow] the value. Alternatively, you can enter the time in the spin
box text field. The valid range for the time is from 0.1 to 10000 minutes.

Properties of Tunefiles
The properties of the Tune Files item include the following parameters:
Parameter

Description

General

Switch Count

Use this spin box to enter the number of switch positions that are to occur during a run.
The valid range of positions is 0 through 50. Entering “0” results in the switch
remaining either On or Off throughout the run. Enter a number between “1” and “50”
to change the state from Off to On or On to Off at multiple specified times during a
run.
The number of positions on the Retention Time bar corresponds to the number of
switch positions you specify using this spin box. When you enter a number different
from 0, a corresponding number of Element parameter groups is displayed on the
Properties pane.
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Parameter

Description

Base Tunefile

Use this box to specify the current tune method file. To change the tune method file,
click the button adjacent to the box and browse for the new tune method file.
NOTICE A red dot in the left column indicates that no tune file is selected. ▲

Elementn (n=1–50)

Use the parameters of the Element groups to specify properties for the active item during individual switching
events. The displayed parameters depend on the active item.
At

Use this spin box to specify the time of the switching event.
To change this value, click the arrows in the spin box to increment [up arrow] or
decrement [down arrow] the value. Alternatively, enter a value in the spin box text field.

New Tunefile

Use this box to specify the tune method file for the new element. To change the tune
method file, click the button adjacent to the box and browse for the new tune method
file.
NOTICE A red dot in the left column indicates that no tune file is selected. ▲
❖

To show this view

Click the Tunefiles symbol in the Global Settings pane.
Properties of Divert Valve A / Divert Valve B
The properties of a switching valve include the following parameters:
Parameter

Description

General

Used

Use this field to specify whether the switching valve is used during the acquisition or
not. To use the switching valve, set the field to True. To not use the switching valve, set
the field to False. Double-click into the field to change the status.

Start in 1-2

Use this field to specify whether the initial position of the switch at the start of a run is
1-2 or 1-6. To start the switching valve in position 1-2, set the field to True. To start the
switching valve in position 1-6, set the field to False. Double-click into the field to
change the status.

Switch Count

Use this spin box to enter the number of switch positions that are to occur during a run.
The valid range of positions is 0 through 50. Entering “0” results in the switch
remaining either On or Off throughout the run. Enter a number between “1” and “50”
to change the state from Off to On or On to Off at multiple specified times during a
run.
The number of positions on the Retention Time bar corresponds to the number of
switch positions you specify using this spin box.
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Parameter

Description

Elementn (n=1–50)

Use the parameters of the Element groups to specify properties for the active item during individual switching
events. The displayed parameters depend on the active item.
At

Use this spin box to specify the time of the switching event.
To change this value, click the arrows in the spin box to increment [up arrow] or
decrement [down arrow] the value. Alternatively, enter a value in the spin box text field.

Switches to

This display field shows the status to which the contact closure is switched.
❖

To show this view

Click the Divert Valve a / Divert Valve b symbol in the External
Hardware pane.
Properties of Syringe
The properties of the Syringe item include the following parameters:
Parameter

Description

General

Used

Use this field to specify whether the syringe pump is used during the acquisition or not.
To use the syringe pump, set the field to True. To not use the syringe pump, set the
field to False. Double-click into the field to change the status.

Start in Off

Use this field to specify whether the initial state of the switch at the start of a run is On
or Off. To start the acquisition with the syringe pump in Off status, set the field to
True. To start the acquisition with the syringe pump in On status, set the field to False.
Double-click into the field to change the status.

Stop at end of run

Use this field to have the Exactive Plus mass spectrometer turn the syringe pump off
when the run is completed. To turn the syringe pump off, set the field to True. To not
have the mass spectrometer turn the syringe pump off after the run, set the field to
False. Double-click into the field to change the status.

Switch Count

Use this spin box to enter the number of switch positions that are to occur during a
run. The valid range of positions is 0 through 50. Entering “0” results in the switch
remaining either On or Off throughout the run. Enter a number between “1” and “50”
to change the state from Off to On or On to Off at multiple specified times during a
run.
The number of positions on the Retention Time bar corresponds to the number of
switch positions you specify using this spin box.

Pump Setup

Use the settings in this area to specify the syringe type and flow rate of the syringe pump.
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Parameter

Description

Syringe type

Use this list box to specify the syringe type (Hamilton, Unimetrics, or Other). If you
select Hamilton or Unimetrics, you must specify the volume of the syringe in the
Volume list box. If you select Other, you must specify the inside diameter of the syringe
in the Inner diameter spin box.

Flow Rate

Use this spin box to set the volume of solvent solution passing through the syringe
pump per unit time. The acceptable range of values depends on the selected syringe
diameter.
To change this value, click the arrows in the spin box to increment [up arrow] or
decrement [down arrow] the value. Alternatively, enter a value in the spin box text field.

Inner diameter

Use this spin box to specify the inside diameter for syringes other than Hamilton and
Unimetrics syringes. The acceptable range of values is 0.1 to 35 mm.
To change this value, click the arrows in the spin box to increment [up arrow] or
decrement [down arrow] the value. Alternatively, enter a value in the spin box text field.

Volume (μL)

Use this list box to specify the syringe volume for Hamilton and Unimetrics syringes.
The acceptable values depend on the syringe type:
•
•

Hamilton:
0.5, 1, 2, 5, 10, 25, 50, 100, 250, and 500 μL.
Unimetrics:
10, 25, 50, 100, 250, 500, 1000, 2500, 5000, 10000, 25000, and 50000 μL.

Elementn (n=1–50)

Use the parameters of the Element groups to specify properties for the active item during individual switching
events. The displayed parameters depend on the active item.
At

Use this spin box to specify the time of the switching event.
To change this value, click the arrows in the spin box to increment [up arrow] or
decrement [down arrow] the value. Alternatively, enter a value in the spin box text field.

Switches to

This display field shows the status to which the syringe pump is switched.
❖

To show this view

Click the Syringe symbol in the External Hardware pane.
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Properties of Contact Closure
The properties of the Contact Closure item include the following
parameters:
Parameter

Description

General

Used

Use this field to specify whether a timed contact closure program is used in an
experiment method or not. To use the contact closure, set the field to True. To not use
the contact closure, set the field to False. Double-click into the field to change the
status.

Start in Closed

Use this field to specify whether the initial status of the contact closure at the start of a
run is On or Off. To start the acquisition with the syringe pump in Closed status, set
the field to True. To start the acquisition with the contact closure in Open status, set
the field to False. Double-click into the field to change the status.

Switch Count

Use this spin box to select the number of switch positions that are to occur during a
run. The valid range of positions is 0 through 50. Selecting “0” results in the switch
remaining either Closed or Open throughout the run. Selecting a number between “1”
and “50” allows you to change the state from Closed to Open or Open to Closed at
multiple specified times during a run.
The number of positions on the Retention Time bar corresponds to the number of
switch positions you specify using this spin box.

Elementn (n=1–50)

Use the parameters of the Element groups to specify properties for the active item during individual switching
events. The displayed parameters depend on the active item.
At

Use this spin box to specify the time of the switching event.
To change this value, click the arrows in the spin box to increment [up arrow] or
decrement [down arrow] the value. Alternatively, enter a value in the spin box text
field.

Switches to

This display field shows the status to which the contact closure is switched.
❖

To show this view

Click the Contact Closure symbol in the External Hardware pane.
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Properties of Chromatogram
The properties of the Chromatogram item include the following
parameters:
Parameter

Description

General

Rawfile

Use this field to select a previously obtained raw data file corresponding to a similar
chromatographic separation. Click the button adjacent to the box and browse for the
raw file.
NOTICE A red dot in the left column indicates that no raw file is selected. ▲

Filter

Scan filter

Use this field to select a scan description that tells the Exactive Plus data system how to
filter the raw data.

Selection

Trace type

Use this field to select a chromatogram plot type. The software updates the
chromatogram immediately after a change. The following options are available:
• TIC
Plots the sum of all the ion intensities.
• Neutral Fragment
Plots the sum of the ion intensities of the ions that produce a neutral fragment
with a mass specified in the Neutral Fragment spin box.
• Base Peak
Plots the ion intensity of the most intense ion in the chromatogram.
• Mass Range
Plots the sum of the ion intensities only for ions in the mass range or ranges
specified in the Range(s) box.

Neutral Fragment

This field is available when you have selected Neutral Fragment as trace type.
To enter the m/z value, click the arrows in the spin box to increment [up arrow] or
decrement [down arrow] the value. Alternatively, enter a value in the spin box text
field.

Mass Ranges

Use this field to specify the range or ranges of mass-to-charge ratios (m/z) that the
Exactive Plus mass spectrometer can analyze. Use a dash (-) to separate the low and
high masses of a range. Use a comma (,) to separate ranges.
This field is not available when you have selected TIC as trace type.

Mass Tolerance

Tolerance

For Neutral Fragment, Mass Range, and Base Peak plot types, use the spin box to
specify the value of the mass tolerance. Enter a value in the range from 0 to 2000 and
select the appropriate option in the Units field.
To change this value, click the arrows in the spin box to increment [up arrow] or
decrement [down arrow] the value. Alternatively, enter a value in the spin box text
field.
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Parameter

Description

Unit

Use this field to select the units that are used in processing the raw file. Select either the
mmu (millimass units) option or the ppm (parts per million) option.
❖

To show this view

Click the Chromatogram symbol in the External Hardware pane.
Properties of Full MS
The properties of a Full MS experiment include the following
parameters:
Parameter

Description

General

Runtime

Use this box to specify the duration in minutes of the active scan event. Click into the
field to display the spin boxes for the start time (Minimum) and the end time
(Maximum) of the scan event.
To change a value, click the arrows in the spin box to increment [up arrow] or
decrement [down arrow] the value. Alternatively, you can enter a value in the spin box
text field. The valid range for the start time is from 0 to (end time minus 0.01)
minutes. The valid range for the end time is from (start time plus 0.01) to 10000
minutes.
Alternatively, drag the left and right edges of the corresponding time bar to the desired
positions on the time line in the Scan Groups pane.

Polarity

Use this list box to toggle between positive ion and negative ion polarity.

In-source CID

Use this spin box to enter the in-source CID collision energy. To change the value, click
the arrows in the spin box to increment [up arrow] or decrement [down arrow] the
value. You can set the CID collision energy to any value from 0 to 100 eV. A value of
0 eV means that the collision energy is switched off.

Full MS

Use the parameters in this group to specify the properties of the master scan(s).
Microscans

Use this spin box to select the number of microscans to be performed. To change the
value, click the arrows in the spin box to increment [up arrow] or decrement [down
arrow] the value. Alternatively, you can enter a value in the spin box text field. The
valid range is from 1 to 10 microscans.

Resolution

Use this list box to select the mass resolution used during the selected scan event. The
mass resolution of the Orbitrap analyzer is proportional to 1/sqrt(m/z). The scan time
increases with increasing resolution and detect time. Available options are 17500,
35000, 70000, or 140000.

AGC target

Use this list box to select the AGC target value for the selected scan event. The AGC
target value controls the number of ions that are injected into the Orbitrap analyzer.
Available options are 5e5, 1e6 (default), 3e6, or 5e6.
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Parameter

Description

Maximum IT

Use this list box to type or click a maximum injection time for AGC. For example, type
12. The valid range is from 1 to 3000 milliseconds.

Scan range

Use the spin boxes in this field to set values for Minimum, Maximum, Center, and
Width for the current scan range. To change the value, click the arrows in the spin box
to increment [up arrow] or decrement [down arrow] the value.
•

•

•

•

Minimum
Select the minimum value for the scan range (in mass-to-charge ratio units). You
can enter any value from 50.0 to 2500.0. The default value is 200.
Maximum
Select the maximum value for the scan range (in mass-to-charge ratio units). You
can enter any value from 50.0 to 6000.0. The default value is 2000.
Center
Select the center mass (in mass-to-charge ratio units) of the scan range. You can
enter any value from 50.2 to 4250.0. The default value is 1075.
Width
Select the width of the scan range (in mass-to-charge ratio units). You can enter any
value from 0.4 to 5600.0. The default value is 1850.
❖

To show this view

Click the Full MS symbol in the Graph pane.
Properties of AIF
The properties of an AIF experiment include the following parameters:
Parameter

Description

General

Runtime

Use this box to specify the duration in minutes of the active scan event. Click into the
field to display the spin boxes for the start time (minimum) and the end time
(maximum) of the scan event.
To change a value, click the arrows in the spin box to increment [up arrow] or decrement
[down arrow] the value. Alternatively, you can enter a value in the spin box text field.
The valid range for the start time is from 0 to (end time minus 0.01) minutes. The valid
range for the end time is from (start time plus 0.01) to 10000 minutes.
Alternatively, drag the left and right edges of the corresponding time bar to the desired
positions on the time line in the Scan Groups pane.

Polarity

Use this list box to toggle between positive ion and negative ion polarity.

In-source CID

Use this spin box to enter the in-source CID collision energy. To change the value, click
the arrows in the spin box to increment [up arrow] or decrement [down arrow] the
value. You can set the CID collision energy to any value from 0 to 100 eV. A value of
0 eV means that the collision energy is switched off.
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Parameter

Description

AIF

Microscans

Use this spin box to select the number of microscans to be performed. To change the
value, click the arrows in the spin box to increment [up arrow] or decrement [down
arrow] the value. Alternatively, you can enter a value in the spin box text field. The valid
range is from 1 to 10 microscans.

Resolution

Use this list box to select the mass resolution used during the selected scan event. The
mass resolution of the Orbitrap analyzer is proportional to 1/sqrt(m/z). The scan time
increases with increasing resolution and detect time. Available options are 17500,
35000, 70000, or 140000.

AGC target

Use this list box to select the AGC target value for the selected scan event. The AGC
target value controls the number of ions that are injected into the Orbitrap analyzer.
Available options are 5e5, 1e6, 3e6, or 5e6.

Maximum IT

Use this list box to type or click a maximum injection time for AGC. For example, type
12. The valid range is from 1 to 3000 milliseconds.

NCE

Use this list box to set the normalized collision energy. This dimensionless number is
approximately equivalent to the HCD collision energy (in eV) for a reference ion of
mass 500 and charge 1. The actual HCD energy is calculated on basis of mass and
charge of the selected precursor ion.
To change the NCE value, click the arrows in the spin box to increment [up arrow] or
decrement [down arrow] the value. You can set NCE to any value from 10 to 200.
Default is 35.

Stepped NCE

Use this list box to set up “Stepped Collision Energy” in the method: NCE is used as
center energy, Stepped NCE is x% of this center energy. The Exactive Plus mass
spectrometer will perform a three step fragmentation on the precursor ion. All fragments
created in the three steps are collected and sent to the Orbitrap analyzer for one scan
detection.
Example:
NCE is set to 35 and Stepped NCE to 20%. NCE in step 1 is 28 (35–35×20%), NCE
in step 2 is 35, and NCE in step 3 is 42 (35+35×20%).
To change the Stepped NCE, click the arrows in the spin box to increment [up arrow] or
decrement [down arrow] the value. You can set Stepped NCE either to – (no Stepped
NCE) or to any value from 0.1 to 90%. Default is –.
However, the actual possible range for Stepped NCE depends on the active value for
NCE. The Method Editor limits the possible range such that the resulting HCD energy
stays within the allowed range of 10 to 200 eV. When you change the value for NCE,
the Method Editor adjusts the active value of the Stepped NCE, if necessary. Stepped
NCE is not available when NCE is set to 10 or 200.
Examples:
• NCE = 100; possible range for Stepped NCE = 0.1 to 90%
• NCE = 35; possible range for Stepped NCE = 0.1 to 71.4%
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Parameter

Description

Scan range

Use the spin boxes in this field to set values for Minimum, Maximum, Center, and
Width for the current scan range. To change the value, click the arrows in the spin box
to increment [up arrow] or decrement [down arrow] the value.
•

•

•

•

Minimum
Select the minimum value for the scan range (in mass-to-charge ratio units). You can
enter any value from 50.0 to 2500.0. The default value is 200.
Maximum
Select the maximum value for the scan range (in mass-to-charge ratio units). You can
enter any value from 50.0 to 6000.0. The default value is 2000.
Center
Select the center mass (in mass-to-charge ratio units) of the scan range. You can enter
any value from 50.2 to 4250.0. The default value is 1075.
Width
Select the width of the scan range (in mass-to-charge ratio units). You can enter any
value from 0.4 to 5600.0. The default value is 1850.
❖

To show this view

Click the AIF symbol in the Graph pane.
Properties of Full MS / AIF
The properties of a Full MS / AIF experiment include the following
parameters:
Parameter

Description

General

Runtime

Use this box to specify the duration in minutes of the active scan event. Click into the
field to display the spin boxes for the start time (minimum) and the end time
(maximum) of the scan event.
To change a value, click the arrows in the spin box to increment [up arrow] or decrement
[down arrow] the value. Alternatively, you can enter a value in the spin box text field.
The valid range for the start time is from 0 to (end time minus 0.01) minutes. The valid
range for the end time is from (start time plus 0.01) to 10000 minutes.
Alternatively, drag the left and right edges of the corresponding time bar to the desired
positions on the time line in the Scan Groups pane.

Polarity

Use this list box to toggle between positive ion and negative ion polarity.

In-source CID

Use this spin box to enter the in-source CID collision energy. To change the value, click
the arrows in the spin box to increment [up arrow] or decrement [down arrow] the value.
You can set the CID collision energy to any value from 0 to 100 eV. A value of 0 eV
means that the collision energy is switched off.
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AIF

Microscans

Use this spin box to select the number of microscans to be performed. To change the
value, click the arrows in the spin box to increment [up arrow] or decrement [down
arrow] the value. Alternatively, you can enter a value in the spin box text field. The valid
range is from 1 to 10 microscans.

Resolution

Use this list box to select the mass resolution used during the selected scan event. The
mass resolution of the Orbitrap analyzer is proportional to 1/sqrt(m/z). The scan time
increases with increasing resolution and detect time. Available options are 17500, 35000,
70000, or 140000.

AGC target

Use this list box to select the AGC target value for the selected scan event. The AGC
target value controls the number of ions that are injected into the Orbitrap analyzer.
Available options are 5e5, 1e6, 3e6, or 5e6.

Maximum IT

Use this list box to type or click a maximum injection time for AGC. For example, type
12. The valid range is from 1 to 3000 milliseconds.

NCE

Use this list box to set the normalized collision energy. This dimensionless number is
approximately equivalent to the HCD collision energy (in eV) for a reference ion of
mass 500 and charge 1. The actual HCD energy is calculated on basis of mass and charge
of the selected precursor ion.
To change the NCE value, click the arrows in the spin box to increment [up arrow] or
decrement [down arrow] the value. You can set NCE to any value from 10 to 200.
Default is 35.

Stepped NCE

Use this list box to set up “Stepped Collision Energy” in the method: NCE is used as
center energy, Stepped NCE is x% of this center energy. The Exactive Plus mass
spectrometer will perform a three step fragmentation on the precursor ion. All fragments
created in the three steps are collected and sent to the Orbitrap analyzer for one scan
detection.
Example:
NCE is set to 35 and Stepped NCE to 20%. NCE in step 1 is 28 (35–35×20%), NCE in
step 2 is 35, and NCE in step 3 is 42 (35+35×20%).
To change the Stepped NCE, click the arrows in the spin box to increment [up arrow] or
decrement [down arrow] the value. You can set Stepped NCE either to – (no Stepped
NCE) or to any value from 0.1 to 90%. Default is –.
However, the actual possible range for Stepped NCE depends on the active value for
NCE. The Method Editor limits the possible range such that the resulting HCD energy
stays within the allowed range of 10 to 200 eV. When you change the value for NCE, the
Method Editor adjusts the active value of the Stepped NCE, if necessary. Stepped NCE is
not available when NCE is set to 10 or 200.
Examples:
• NCE = 100; possible range for Stepped NCE = 0.1 to 90%
• NCE = 35; possible range for Stepped NCE = 0.1 to 71.4%
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Scan range

Use the spin boxes in this field to set values for Minimum, Maximum, Center, and
Width for the current scan range. To change the value, click the arrows in the spin box to
increment [up arrow] or decrement [down arrow] the value.
•

•

•

•

Minimum
Select the minimum value for the scan range (in mass-to-charge ratio units). You can
enter any value from 50.0 to 2500.0. The default value is 200.
Maximum
Select the maximum value for the scan range (in mass-to-charge ratio units). You can
enter any value from 50.0 to 6000.0. The default value is 2000.
Center
Select the center mass (in mass-to-charge ratio units) of the scan range. You can enter
any value from 50.2 to 4250.0. The default value is 1075.
Width
Select the width of the scan range (in mass-to-charge ratio units). You can enter any
value from 0.4 to 5600.0. The default value is 1850.
❖

To show this view

Click the Full MS / AIF symbol in the Graph pane.
Properties of Full MS / dd-AIF
The properties of a Full MS / dd-AIF experiment include the following
parameters:
Parameter

Description

General

Runtime

Use this box to specify the duration in minutes of the active scan event. Click into the
field to display the spin boxes for the start time (minimum) and the end time
(maximum) of the scan event.
To change a value, click the arrows in the spin box to increment [up arrow] or
decrement [down arrow] the value. Alternatively, you can enter a value in the spin box
text field. The valid range for the start time is from 0 to (end time minus 0.01)
minutes. The valid range for the end time is from (start time plus 0.01) to 10000
minutes.
Alternatively, drag the left and right edges of the corresponding time bar to the desired
positions on the time line in the Scan Groups pane.

Polarity

Use this list box to toggle between positive ion and negative ion polarity.

In-source CID

Use this spin box to enter the in-source CID collision energy. To change the value,
click the arrows in the spin box to increment [up arrow] or decrement [down arrow]
the value. You can set the CID collision energy to any value from 0 to 100 eV. A value
of 0 eV means that the collision energy is switched off.
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Inclusion

Because this experiment requires inclusion masses, this field is always set to on
(inclusion list enabled).

Exclusion

Use this field to enable the exclusion masses list that is attached to the active
instrument method. Available options are on (exclusion list enabled) and – (exclusion
list disabled). Default setting is –.

Full MS

Microscans

Use this spin box to enter the number of microscans to be performed. To change the
value, click the arrows in the spin box to increment [up arrow] or decrement [down
arrow] the value. Alternatively, you can enter a value in the spin box text field. The
valid range is from 1 to 10 microscans.

Resolution

Use this list box to select the mass resolution used during the selected scan event. The
mass resolution of the Orbitrap analyzer is proportional to 1/sqrt(m/z). The scan time
increases with increasing resolution and detect time. Available options are 17500,
35000, 70000, or 140000.

AGC target

Use this list box to select the AGC target value for the selected scan event. The AGC
target value controls the number of ions that are injected into the Orbitrap analyzer.
Available options are 5e5, 1e6, 3e6, or 5e6.

Maximum IT

Use this list box to type or click a maximum injection time for AGC. For example, type
12. The valid range is from 1 to 3000 milliseconds.

Scan range

Use the spin boxes in this field to enter values for Minimum, Maximum, Center, and
Width for the current scan range. To change the value, click the arrows in the spin box
to increment [up arrow] or decrement [down arrow] the value.
•

•

•

•

Minimum
Select the minimum value for the scan range (in mass-to-charge ratio units). You
can enter any value from 50.0 to 2500.0. The default value is 200.
Maximum
Select the maximum value for the scan range (in mass-to-charge ratio units). You
can enter any value from 50.0 to 6000.0. The default value is 2000.
Center
Select the center mass (in mass-to-charge ratio units) of the scan range. You can
enter any value from 50.2 to 4250.0. The default value is 1075.
Width
Select the width of the scan range (in mass-to-charge ratio units). You can enter any
value from 0.4 to 5600.0. The default value is 1850.

dd-AIF

Microscans

Use this spin box to enter the number of microscans to be performed. To change the
value, click the arrows in the spin box to increment [up arrow] or decrement [down
arrow] the value. Alternatively, you can enter a value in the spin box text field. The
valid range is from 1 to 10 microscans.

Resolution

Use this list box to select the mass resolution used during the selected scan event. The
mass resolution of the Orbitrap analyzer is proportional to 1/sqrt(m/z). The scan time
increases with increasing resolution and detect time. Available options are 17500,
35000, 70000, or 140000.
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AGC target

Use this list box to select the AGC target value for the selected scan event. The AGC
target value controls the number of ions that are injected into the Orbitrap analyzer.
Available options are 5e5, 1e6, 3e6, or 5e6.

Maximum IT

Use this list box to type or click a maximum injection time for AGC. For example, type
12. The valid range is from 1 to 3000 milliseconds.

Loop count

Use this spin box to enter the number of repetitions of the corresponding scan event
before continuing with the next scan event or workflow cycle.
To change the value, click the arrows in the spin box to increment [up arrow] or
decrement [down arrow] the value. Alternatively, you can enter a value in the spin box
text field. The valid range is from 1 (no repetition) to 100 repetitions.

TopN

This field displays the maximum number of the most abundant precursors that will be
selected per cycle.

Fixed first mass

Use this box to specify whether to use a first mass of the Data Dependent scan. To
change the first mass, click the arrows in the spin box to increment [up arrow] or
decrement [down arrow] the value. You can set Fixed first mass either to – (no Fixed
first mass) or to any value from m/z 50 to 2499.9. Default is –.

NCE

Use this list box to set the normalized collision energy. This dimensionless number is
approximately equivalent to the HCD collision energy (in eV) for a reference ion of
mass 500 and charge 1. The actual HCD energy is calculated on basis of mass and
charge of the selected precursor ion.
To change the NCE value, click the arrows in the spin box to increment [up arrow] or
decrement [down arrow] the value. You can set NCE to any value from 10 to 200.
Default is 35.

Thermo Fisher Scientific

Exactive Plus Software Manual (P/N 1323070, Revision A)

3-37

Instrument Setup
Experiment Setup Page

Parameter
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Stepped NCE

Use this list box to set up “Stepped Collision Energy” in the method: NCE is used as
center energy, Stepped NCE is x% of this center energy. The Exactive Plus mass
spectrometer will perform a three step fragmentation on the precursor ion. All
fragments created in the three steps are collected and sent to the Orbitrap analyzer for
one scan detection.
Example:
NCE is set to 35 and Stepped NCE to 20%. NCE in step 1 is 28 (35–35×20%), NCE
in step 2 is 35, and NCE in step 3 is 42 (35+35×20%).
To change the Stepped NCE, click the arrows in the spin box to increment [up arrow]
or decrement [down arrow] the value. You can set Stepped NCE either to – (no
Stepped NCE) or to any value from 0.1 to 90%. Default is –.
However, the actual possible range for Stepped NCE depends on the active value for
NCE. The Method Editor limits the possible range such that the resulting HCD
energy stays within the allowed range of 10 to 200 eV. When you change the value for
NCE, the Method Editor adjusts the active value of the Stepped NCE, if necessary.
Stepped NCE is not available when NCE is set to 10 or 200.
Examples:
• NCE = 100; possible range for Stepped NCE = 0.1 to 90%
• NCE = 35; possible range for Stepped NCE = 0.1 to 71.4%

dd Settings

Use the parameters in this group to specify criteria for selecting one or more ions of interest on which to
perform subsequent scans.
Intensity threshold

This field displays the minimum intensity that a mass peak requires to initiate a data
dependent scan.
To change the intensity threshold, click the arrows in the spin box to increment [up
arrow] or decrement [down arrow] the value. You can set the intensity threshold either
to – (no threshold) or to any value from 1 to 1e15. Default is 3.3e5.
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Apex trigger

To obtain the highest quality data in the shortest period of time, it is best to defer data
acquisition until near the apex of a chromatographic peak. Using the chromatographic
peak apex detection provides numerous benefits for Data Dependent LC/MS,
including:
•
•
•
•
•

Improved quality and signal levels
Shorter ion injection times
Reduced acquisition of chemical background
Less dependence on static or dynamic exclusion lists
Reduced retriggering of scans on tailing chromatographic peaks

Use this box to enter start (Minimum) and end (Maximum) of a retention time
window in seconds. If the Exactive Plus mass spectrometer finds an apex within the
window, it triggers a Data Dependent acquisition for the corresponding m/z or range of
m/z. The mass spectrometer also triggers a Data Dependent scan when the end of the
time window is reached without detecting an apex. The apex trigger always depends on
other selection criteria (for example, underfill ratio).
•

•

Charge exclusion

Minimum
Enter the minimum value for the time window (in seconds). You can enter any
value from – (0) to 360. The default value is –.
Maximum
Enter the maximum value for the time window (in seconds). You can enter any
value from – (0) to 360. The default value is –.

Use the check boxes in this field to reject individual charge states or undetermined
charge states as precursors for Data Dependent MS scans.
The following options are available:
•
•
•
•

Peptide match

– (charge exclusion disabled)
unassigned (charge state not determined)
1–8 (at least one charge state is selected)
>8

Use this field to enable the Exactive Plus mass spectrometer to select small molecules
with peptide-like isotopic distributions for Data Dependent scanning. The mass
spectrometer recognizes the monoisotopic mass of an isotopic distribution by
comparing isotopic intensity ratios to typical peptide-like distributions.
The following options are available:
•
•
•

on (peptide match enabled)
– (peptide match disabled)
preferred (peaks with peptide match are triggered with preference to peaks without
peptide match)

Default setting is preferred.
Exclude isotopes

Thermo Fisher Scientific
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Dynamic exclusion

Use this box to enter a time to prevent an ion from triggering a subsequent Data
Dependent scan after it has already triggered a Data Dependent scan. The available
range is from – (no dynamic exclusion) to 50000 seconds. The default is 10 seconds.
Dynamic exclusion is valuable if the Exactive Plus mass spectrometer has obtained a
sufficient amount of data on an ion or if the base peak corresponds to a contaminant or
an ion of non interest. If you enable dynamic exclusion, and if the mass spectrometer
performs a Data Dependent scan on an ion, that ion is placed on the exclusion list (a
temporary reject mass list) for a user-specified period of time. Then, when the mass
spectrometer performs another Data Dependent scan on another ion, that ion is also
placed on the exclusion list, and so on.

if idle

Use this field to select the behavior of the Exactive Plus mass spectrometer when it has
finished the Data Dependent scans that were triggered by a mass that meets the
established criteria for Data Dependent actions. Available options are do not pick
others and pick others. Default setting is do not pick others.
This parameter is available only when at least one of the parameters Inclusion or Tags is
set to on.
❖

To show this view

Click the Full MS / dd-AIF symbol in the Graph pane.
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Summary Page
The Summary page displays the parameters for mass spectrometer setup,
syringe pump, divert valves, and contact closure that you specified on
the Experiment Setup page.
❖

To zoom in or out on the Summary page

•

Position the mouse pointer within the pane, press the <Ctrl> key,
and roll the mouse wheel forward to zoom in.

•

Position the mouse pointer within the pane, press the <Ctrl> key,
and roll the wheel backward to zoom out.

NOTICE The content of this page will be printed together with the
information for other instruments. ▲
❖

To display this page

In the Instrument Setup window, click the Summary tab.
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Dialog Boxes of the Method Editor
This section provides a reference to the dialog boxes in the Method
Editor:
Use the dialog boxes for global lists to define properties for masses that
are used for setting up the experiments in the Method Editor:
•

Lock Masses Dialog Box

•

Inclusion List Dialog Box

•

Exclusion List Dialog Box

Lock Masses Dialog Box
Use the Lock Masses dialog box to select a lock mass list for the active
instrument method and to edit it. See Figure 3-21. Lock masses are
peaks in the spectrum that the Exactive Plus mass spectrometer uses for
internal mass calibration. Using lock masses improves the mass accuracy
of the mass analyzer. If you do not specify any lock masses, the mass
spectrometer uses the external mass calibration.
The dialog box allows defining a time window of activity for each lock
mass (=timed lock masses). If Start or End is left blank, the lock mass is
active from the beginning or until the end of the method, respectively.
In the latter case, the End field displays “end”. The usage of lock masses
during the active instrument method is specified on the Properties pane
of the method.
The table shows the properties of the masses contained in the active lock
mass list (*.lock-masses). To change the sort order, click the respective
table column header. To invert the sort order, click again.

Figure 3-21. Method Editor—Lock Masses dialog box
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The Lock Masses dialog box has the following parameters:
Parameter

Description

Mass [m/z]

Enter the mass of the lock mass into the field (with
a maximum of five decimals).
To change this value, click the arrows in the spin
box to increment [up arrow] or decrement [down
arrow] the value. Alternatively, enter a value in the
spin box text field.

Polarity

Use this list box to toggle between positive ion and
negative ion polarity.
NOTICE During a scan, the Exactive Plus mass
spectrometer uses only the lock masses with a
polarity that matches the active ion mode. ▲

Start [min]

Enter the start time in minutes. Alternatively, you
can enter a time in seconds (by appending the
letter s) or in hours (by appending the letter h). The
software automatically converts your input into
minutes.

End [min]

Enter the end time in minutes. Alternatively, you
can enter a time in seconds (by appending the
letter s) or in hours (by appending the letter h). The
software automatically converts your input into
minutes.

Comment

Enter a comment for the lock mass into the field.
This field is optional.

❖

To display this dialog box

1. In the Method Editor, expand the Global Lists pane.
2. Click the

button.

Title Bar
The title bar of a global list displays the name of the dialog box. A
“modified” indicates a file with unsaved changes.
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File Menu
The File menu provides commands for file operations. It has the
following commands:
Command

Description

Import
<Ctrl> + <I>

Opens a dialog box where you can select an existing mass collection. In addition to
the program-specific data files, you can select *.csv or *.txt files that meet the
requirements of the program. All available masses are replaced by the masses
contained in the imported file. Click Open to import the file.

Export
<Ctrl> + <S>

Opens a dialog box that you can use to save the active mass collection. In addition
to using the program-specific data files, you can save the mass collection as
tabulator-separated file (*.txt, for example) or comma-separated file (*.csv, for
example). Enter a new file name, select the file type, and select the location (disk
and directory) where you want to save it. Alternatively, you can select an existing
file. Click Save to save the file.

Export selected
<Ctrl> + <Shift> + <S>

Opens a dialog box that you can use to save the selected masses. In addition to
using the program-specific data files, you can save the mass collection as
tabulator-separated file (*.txt, for example) or comma-separated file (*.csv, for
example). Enter a new file name, select the file type, and select the location (disk
and directory) where you want to save it. Alternatively, you can select an existing
file. Click Save to save the file.
This command is available only when at least one line in the dialog box is selected.

Minimize
<Ctrl> + <F4>

Closes the dialog box. Your edits will be retained. Alternatively, click the Done
button at the right side of the menu bar.

Edit Menu
The Edit menu provides commands for editing the active file. It has the
following commands:
Command

Description

Undo until last save
<Ctrl> + <Z>

Discards all changes to the active file that have not been saved.

Copy
<Ctrl> + <C>

Copies the data of the selected mass to the clipboard.

Replace by clipboard
<Ctrl> + <V>

Replaces the available masses by the content of the clipboard.
NOTICE The clipboard stores lock mass data as tabulator-separated text files. When
the data in the clipboard are not in this format, the command is not available. ▲

Help Menu
Displays the Help for this dialog box.
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Inclusion List Dialog Box
Use the Inclusion List dialog box to edit a list of specific masses
(inclusion masses) that can activate a Data Dependent action. See
Figure 3-22. The dialog box allows defining a time window of activity
for each inclusion mass. If Start or End is left blank, the inclusion mass
is active from the beginning or until the end of the method, respectively.
In the latter case, the End field displays “end”.
When a inclusion mass list is used in a Data Dependent experiment, the
ions will be selected for the Data Dependent scan event, only if they:
1. appear in the referring master scan (mostly the full scan) and
2. fulfill all of the other defined selection criteria, such as Underfill
ratio.
The table shows the properties of the masses contained in the active
inclusion masses list (*.include-masses). To change the sort order, click
the respective table column header. To invert the sort order, click again.

Figure 3-22. Method Editor—Inclusion List dialog box
The Inclusion List dialog box has the following parameters:
Parameter

Description

Mass [m/z]

Enter the mass of the inclusion mass into the field (with a maximum of five decimals).

Polarity

Use this list box to toggle between positive ion and negative ion polarity.
NOTICE During a scan, the Exactive Plus mass spectrometer uses only the inclusion masses
with a polarity that matches the active ion mode. ▲

Start [min]

Enter the start of the time window (in minutes) that corresponds to the mass in this row.
Alternatively, you can enter a time in seconds (by appending the letter s) or in hours (by
appending the letter h). Exactive Plus Tune automatically converts your input into minutes.

End [min]

Enter the end of the time window in minutes. Alternatively, you can enter a time in seconds
(by appending the letter s) or in hours (by appending the letter h). Exactive Plus Tune
automatically converts your input into minutes.
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Parameter

Description

NCE

Enter the RF amplitude (as a percentage) used to fragment ions. The valid range is 10 to
200%. The default normalized collision energy value is 35%. A high normalized collision
energy value results in more energy deposition (which generally leads to more
fragmentation). A low normalized collision energy value results in less energy deposition
(which generally leads to less fragmentation).

CS [z]

Enter the charge state of the ion to be fragmented. The valid range is 1–25. The required
collision energy for fragmenting an ion depends on its charge state. The higher the charge
state, the lower the required collision energy. If this field is left blank any charge state will be
accepted, even unassigned.

Comment

Enter a comment for the inclusion mass into the field. This field is optional.
❖

To display this dialog box

1. In the Method Editor, expand the Global Lists pane.
2. Click the

button.

Title Bar
The title bar of a global list displays the name of the dialog box. A
“modified” indicates a file with unsaved changes.
File Menu
The File menu provides commands for file operations. It has the
following commands:
Command

Description

Import
<Ctrl> + <I>

Opens a dialog box where you can select an existing mass collection. In addition to
the program-specific data files, you can select *.csv or *.txt files that meet the
requirements of the program. All available masses are replaced by the masses
contained in the imported file. Click Open to import the file.

Export
<Ctrl> + <S>

Opens a dialog box that you can use to save the active mass collection. In addition
to using the program-specific data files, you can save the mass collection as
tabulator-separated file (*.txt, for example) or comma-separated file (*.csv, for
example). Enter a new file name, select the file type, and select the location (disk
and directory) where you want to save it. Alternatively, you can select an existing
file. Click Save to save the file.

Export selected
<Ctrl> + <Shift> + <S>

Opens a dialog box that you can use to save the selected masses. In addition to
using the program-specific data files, you can save the mass collection as
tabulator-separated file (*.txt, for example) or comma-separated file (*.csv, for
example). Enter a new file name, select the file type, and select the location (disk
and directory) where you want to save it. Alternatively, you can select an existing
file. Click Save to save the file.
This command is available only when at least one line in the dialog box is selected.
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Command

Description

Minimize
<Ctrl> + <F4>

Closes the dialog box. Your edits will be retained. Alternatively, click the Done
button at the right side of the menu bar.

Edit Menu
The Edit menu provides commands for editing the active file. It has the
following commands:
Command

Description

Undo until last save
<Ctrl> + <Z>

Discards all changes to the active file that have not been saved.

Copy
<Ctrl> + <C>

Copies the data of the selected mass to the clipboard.

Replace by clipboard
<Ctrl> + <V>

Replaces the available masses by the content of the clipboard.
NOTICE The clipboard stores lock mass data as tabulator-separated text files. When
the data in the clipboard are not in this format, the command is not available. ▲

Help Menu
Displays the Help for this dialog box.

Exclusion List Dialog Box
Use the Exclusion List dialog box to edit a list of specific masses
(exclusion masses) that will not trigger a subsequent Data Dependent
scan even if they are present. See Figure 3-23. The dialog box allows
defining a time window of activity for each exclusion mass. If Start or
End is left blank, the exclusion mass is active from the beginning or
until the end of the method, respectively. In the latter case, the End field
displays “end”.
To use an exclusion list in a experiment, set the Exclusion parameter on
the Parameter pane to on.
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The table shows the properties of the masses contained in the active
exclusion masses list (*.exclude-masses). To change the sort order, click
the respective table column header. To invert the sort order, click again.

Figure 3-23. Method Editor—Exclusion List dialog box
The Exclusion List dialog box has the following parameters:
Parameter

Description

Mass [m/z]

Enter the mass of the exclusion mass into the field (with a maximum of five decimals).

Polarity

Use this list box to toggle between positive ion and negative ion polarity.
NOTICE During a scan, the Exactive Plus mass spectrometer uses only the exclusion masses
with a polarity that matches the active ion mode. ▲

Start [min]

Enter the start of the time window (in minutes) that corresponds to the mass in this row.
Alternatively, you can enter a time in seconds (by appending the letter s) or in hours (by
appending the letter h). The software automatically converts your input into minutes.

End [min]

Enter the end of the time window in minutes. Alternatively, you can enter a time in seconds
(by appending the letter s) or in hours (by appending the letter h). The software
automatically converts your input into minutes.

CS [z]

Enter the charge state of the ion to be excluded. The valid range is 1–25. The required
collision energy for fragmenting an ion depends on its charge state. The higher the charge
state, the lower the required collision energy.

Comment

Enter a comment for the exclusion mass into the field. This field is optional.
❖

To display this dialog box

1. In the Method Editor, expand the Global Lists pane.
2. Click the

button.

Title Bar
The title bar of a global list displays the name of the dialog box. A
“modified” indicates a file with unsaved changes.
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File Menu
The File menu provides commands for file operations. It has the
following commands:
Command

Description

Import
<Ctrl> + <I>

Opens a dialog box where you can select an existing mass collection. In addition to
the program-specific data files, you can select *.csv or *.txt files that meet the
requirements of the program. All available masses are replaced by the masses
contained in the imported file. Click Open to import the file.

Export
<Ctrl> + <S>

Opens a dialog box that you can use to save the active mass collection. In addition
to using the program-specific data files, you can save the mass collection as
tabulator-separated file (*.txt, for example) or comma-separated file (*.csv, for
example). Enter a new file name, select the file type, and select the location (disk
and directory) where you want to save it. Alternatively, you can select an existing
file. Click Save to save the file.

Export selected
<Ctrl> + <Shift> + <S>

Opens a dialog box that you can use to save the selected masses. In addition to
using the program-specific data files, you can save the mass collection as
tabulator-separated file (*.txt, for example) or comma-separated file (*.csv, for
example). Enter a new file name, select the file type, and select the location (disk
and directory) where you want to save it. Alternatively, you can select an existing
file. Click Save to save the file.
This command is available only when at least one line in the dialog box is selected.

Minimize
<Ctrl> + <F4>

Closes the dialog box. Your edits will be retained. Alternatively, click the Done
button at the right side of the menu bar.

Edit Menu
The Edit menu provides commands for editing the active file. It has the
following commands:
Command

Description

Undo until last save
<Ctrl> + <Z>

Discards all changes to the active file that have not been saved.

Copy
<Ctrl> + <C>

Copies the data of the selected mass to the clipboard.

Replace by clipboard
<Ctrl> + <V>

Replaces the available masses by the content of the clipboard.
NOTICE The clipboard stores lock mass data as tabulator-separated text files. When
the data in the clipboard are not in this format, the command is not available. ▲

Help Menu
Displays the Help for this dialog box.
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Chapter 4

Explore Exactive Plus Tune
This chapter provides information about Exactive Plus Tune, its views,
functions, and features.
Contents

Thermo Fisher Scientific
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Exactive Plus Tune Overview
The Exactive Plus Tune program is used to operate the Exactive Plus
mass spectrometer. Figure 4-24 shows Exactive Plus Tune. To access
information about Exactive Plus Tune, use the title bar, the toolbar,
menu commands, display views, and Help.

Figure 4-24. Exactive Plus Tune
❖

To display this window

•

Choose Start > Programs > Thermo Exactive Series > Tune, or

•

Click

on the desktop.

NOTICE When you are running Exactive Plus Tune, an Exactive Plus
Tune icon ( ) is displayed in the Microsoft™ Windows™ system tray.
Double-click the icon to display the Exactive Plus Tune window
when it is minimized. Right-click the icon to display a shortcut menu
that provides commands for restoring or terminating Exactive Plus
Tune. ▲

Title Bar
The Exactive Plus Tune title bar displays the name of the program, the
name of the current Tune Method, and the instrument status. An
asterisk indicates a Tune Method with unsaved changes.
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Menus
The Exactive Plus Tune menu bar displays the available menus. The
Exactive Plus Tune menus are as follows:
•

File Menu

•

Windows Menu

•

Reports Menu

•

Help Menu

On the far right side of the menu bar, the active user role is displayed.

Toolbar
The Toolbar provides symbol shortcuts for frequently used commands.
It is located below the title bar of the Exactive Plus Tune window.

Tasks Panel
The tasks panel on the left side of the Exactive Plus Tune window
comprises six windows:
•

The Instrument Control Window on the left side of the Exactive
Plus Tune window comprises three windows:
- Scan Parameters Window for defining a scan depending on the
scan mode and scan type combination.
- API Source window for displaying and editing parameters of the
API source. The window adapts name and parameters of the
currently detected source. At present, Exactive Plus Tune
provides the following API source windows:
ESI Source Window
HESI Source Window
NSI Source Window
APCI Source Window
APPI Source Window
DART Source Window
MALDI Source Window
- Acquisition Window for acquiring and storing measurement
data.

•

Thermo Fisher Scientific

Tune Window for optimizing the tune of the mass spectrometer.
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•

Mass Traces Window for selecting mass traces that are displayed in
the Analysis Graphs Window.

•

Calibrate Window for performing an automatic optimization of the
calibration parameters.

•

Evaluate Window for performing an automatic check of the
instrument precision.

•

Vacuum / Bakeout Window for displaying the pressure values at the
vacuum gauges and performing an instrument bakeout.

Display Panel
The display panel on the right side of the Exactive Plus Tune window
comprises up to five windows:

4-4

•

Spectrum Window for displaying a real-time data plot. The
spectrum window is always visible.

•

Instrument Status Window for displaying instrument parameters.

•

Messages Window for displaying current status information about
the instrument, the control service, or other programs.

•

Analysis Graphs Window for displaying a real-time graph.

•

Debug Messages Window for displaying messages that can be used
during software development. The debug messages window is not
available for standard users.
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Exactive Plus Tune Menus
The Exactive Plus Tune window has the following menus:
•

File Menu

•

Windows Menu

•

Reports Menu

•

Help Menu

User Role
On the far right side of the menu bar, the active user role is displayed.
Click on the entry (Advanced, for example) to display a list that displays
the available user roles. To change the active user role, click on the
respective entry.
The number of available user roles depends on the installed licenses. See
“License Dialog Box” on page 4-63.

File Menu
The File menu provides commands for file and program operations. It
has the following commands:
Command

Description

Load Tune File

Displays a dialog box that you can use to find and
open a tune file (*.mstune) that already exists.

Save Tune File

Saves the active tune file with the current settings.
NOTICE Do not overwrite the default tune file
C:\Xcalibur\methods\HESI_Installation.mstune! ▲

Save Tune File as Opens a dialog box that you can use to enter a new
file name and to select the location (disk and
directory) where you want to save it. Click Save to
save the tune file with the current settings.
NOTICE Do not overwrite the default tune file
C:\Xcalibur\methods\HESI_Installation.mstune! ▲
Terminate

Thermo Fisher Scientific

Closes the active window. If the active tune file
contains unsaved changes, a dialog box warns about
losing data when you terminate the program.
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Windows Menu
The Windows menu provides commands for customizing the
information displayed in the Exactive Plus Tune window. The system
highlights the icon to the left of a command if the window is active.
Deselect the command to hide the window.
The Windows menu has the following commands:
Command

Description

View > Show all

Displays all windows of Exactive Plus Tune.

Tooltips

Displays a short description of an item on
the Exactive Plus Tune window when you
rest the mouse pointer over it.

Spectrum

Displays the Spectrum Window.
The Spectrum Window is always visible.

Instrument Status

Displays/Hides the Instrument Status
Window.

Messages

Displays/Hides the Messages Window.

Analysis Graphs

Displays/Hides the Analysis Graphs
Window.

Debug Messages

Displays/Hides the Debug Messages
Window.
The debug messages window is not available
for standard users. ▲

NOTICE Exactive Plus Tune may open some windows (the analysis
graphs window, for example) without user interaction if new important
information is available. ▲

Reports Menu
The Reports menu groups commands that provide information about
calibration reports. It has the following commands:
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Command

Description

Spectral Mass Calibration
(neg) > Latest

Opens the latest negative mode
calibration report in PDF format.
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Command

Description

Spectral Mass Calibration
(neg) > Last

Displays the list of up to five (5) negative
mode calibration reports.
To open a report, double-click any of the
spectral mass calibration from the list.

Spectral Mass Calibration
(pos) > Latest

Opens the latest positive mode
calibration report in PDF format.

Spectral Mass Calibration
(pos) > Last

Displays the list of up to five (5) positive
mode calibration reports.
To open a report, double-click any of the
spectral mass calibration from the list.

All Reports

Opens a new window with a list of all
previously acquired spectral mass
calibrations.

Help Menu
The Help menu groups commands that provide information about
Exactive Plus Tune. It has the following commands:

Thermo Fisher Scientific

Command

Description

Help Overview

Displays Exactive Plus Tune Help.

Help Content

Displays the table of contents for Exactive Plus
Tune Help.

Help Index

Displays the index for Exactive Plus Tune Help.

About

Displays the About dialog box with information
about the instrument and the current Exactive Plus
Tune version.
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Toolbar
The Exactive Plus Tune toolbar provides symbol shortcuts for frequently
used commands. It is located below the title bar of the Exactive Plus
Tune window. To activate a toolbar function, click the corresponding
toolbar button.
Some symbols provide information about the current statuses of
respective instrument components either by their color or by displaying
a tooltip when you rest the mouse pointer on them.
The following functions are available:
Button

Description

General instrument state
On / Standby / Off

Click to toggle between the instrument operating statuses On,
Standby, and Off. The button reflects the instrument status:
• When the mass spectrometer is On, Exactive Plus Tune

Run by Xcalibur
•

displays
.
When the mass spectrometer is in Standby, Exactive Plus
Tune displays

•

.

When the mass spectrometer is Off, Exactive Plus Tune
displays

.

The status of this button controls also the statuses of gas flow and
syringe pump use (if present).
If the mass spectrometer is controlled by an Xcalibur sequence,
Exactive Plus Tune displays
. The acquisition can only be
stopped from Xcalibur Sequence Setup View.
Open

Displays a dialog box that you can use to find and open a
*.mstune file that already exists. Alternatively, choose File > Load
Tune File.

Save

Opens a dialog box that you can use to select the location (disk
and directory) where you want to save the tune file. Alternatively,
choose File > Save Tune File as.
This button is not available when the settings of the active tune
file are not changed.
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Button

Description

Divert Valve A
Position 1 or Position 2

Divert Valve B
Position 1 or Position 2

Click to switch the valve position directly. The button reflects the
valve status (connected positions, Valve “a”).

Click to switch the valve position directly. The button reflects the
valve status (connected positions, Valve “b”).

Syringe Pump Settings

Click to switch on/off the syringe pump (if present). A symbol in
the lower right corner of the button indicates the current status of
Syringe Pump On or Syringe the syringe pump:
Pump Off
• When the syringe pump is On, Exactive Plus Tune displays
.
•

When the syringe pump is Off, Exactive Plus Tune displays
.

•

When the syringe pump is in an unknown status, Exactive
Plus Tune displays

.

Click the down arrow to display the Syringe Pump Settings
dialog box. Here, you can specify syringe pump parameters or
manually operate the syringe pump.
Communication Status

Shows the actual communication status of the system:
• Green: communication with instrument is ok.
• Yellow: only service is accessible (no instrument).
• Red: communication is broken (no instrument, no service).

Hardware Status

Shows the actual hardware status of the system (top instrument
tree state):
• Green: all readbacks are in specifications (green hooks).
• Red: one or more readbacks are out of range.
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Button

Description

Performance Status

Shows the actual performance status of the system:
• Green: the last evaluation/calibration was successful.
• Yellow: the last evaluation/calibration was successful, but is
out of date.
• Red: the evaluation/calibration was not successful.
By default, the performance status icon turns yellow 25 hours
after the last successful mass calibration or check. With exception
of standard users, users can change this value in the System node
of the instrument status window according to their mass accuracy
requirements.
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Procedure active

If a procedure is active (for example, system bakeout or tune)
Exactive Plus Tune displays an animated icon next to the
performance status button.

Acquisition indicator

If the mass spectrometer is acquiring data, Exactive Plus Tune
displays an animated icon next to the performance status button.
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Tasks Panel
Use the windows of the tasks panel to perform procedures that maintain
the quality of measurements with the Exactive Plus mass spectrometer.
The tasks panel is always visible. The windows in the tasks panel can be
minimized or maximized. Click the title bar of an individual window to
display it.

Instrument Control Window
Use the windows of the Instrument Control window to enter individual
physical settings and to acquire scans. The following windows are
available:
•

Scan Parameters Window

•

API Source Window (one of the following)
- ESI Source Window
- HESI Source Window
- NSI Source Window
- APCI Source Window
- APPI Source Window
- DART Source Window
- MALDI Source Window

•

Acquisition Window

The Instrument Control window is always visible. Click the title bar of
an individual window to display it. Click again to hide it. To change the
order of windows within the Instrument Control window, drag
individual windows by their title bars to the new places.
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Scan Parameters Window
Use the Scan Parameters window to define a scan depending on the
selected scan mode and scan type combination. See Figure 4-25. The
Exactive Plus mass spectrometer updates the scan parameters only after
you click Apply or select the Hot link check box.

Figure 4-25. Scan Parameters window
The Scan Parameters window has the following parameters:
Parameter

Description

History

Click to display the Scan Parameters History dialog box. Here, select from a list of
recent scans based on short scan descriptions. The maximum number of list items is
100.
After a change of parameters, the history is updated when you click Apply or when
you change the status of the Hot link check box.

Scan Range

Displays the current scan range. To change the settings, click into the field to
display the Scan Range dialog box.

Fragmentation

Displays the current settings for HCD fragmentation and in-source
CID fragmentation. If no fragmentation type is selected, the text field shows None.
To change the settings, click into the field to display the Fragmentation dialog box.
NOTICE Automatic tuning is disabled when in-source CID fragmentation is on. ▲

Resolution

Use this list box to select the mass resolution for FTMS analysis. The mass
resolution of the Orbitrap analyzer is proportional to 1/sqrt(m/z). The scan time
increases with increasing resolution and detect time. Available options are 17500,
35000, 70000, or 140000.

Polarity

Use this list box to toggle between positive ion and negative ion polarity.
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Parameter

Description

Microscans

Use this list box to select the number of microscans to be performed. Available
options are 1, 2, 3, 4, 5, and 10 microscans.

Lock masses

Displays the active lock masses. During a scan, the Exactive Plus mass spectrometer
uses only the lock masses with a polarity that matches the ion mode. If no lock
masses are selected, the text field shows Off. To change the settings, click into the
field to display the Lock Masses dialog box.
NOTICE Exactive Plus Tune allows using active lock masses in user-defined
calibration mass lists. ▲

AGC target

Use this list box to select the AGC target value. The AGC target value controls the
number of ions that are injected into the Orbitrap analyzer. Available options are
5e5, 1e6, 3e6, and 5e6.

Maximum inject time

Use this list box to type or click a maximum injection time for AGC. For example,
type 12. The valid range is from 1 to 3000 milliseconds.

Buttons

Apply

Sends all changes to the instrument.

Help

Displays the Help for this window.

Hot Link

Select the Hot link check box to allow Exactive Plus Tune to send any changes
immediately to the instrument. A green frame around the parameter box indicates
an active hot link.
❖

To display this window

Click the Scan Parameters window title bar in the Instrument
Control window.
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ESI Source Window
Use the ESI source window to specify electrospray ionization (ESI)
source parameters. See API Source Settings for Various LC Flow Rates
for recommended settings. The Exactive Plus mass spectrometer updates
the ESI source parameters only after you click Apply or with the Hot
link check box being selected. See Figure 4-26.

Figure 4-26. ESI source window
NOTICE This window is available only when the Exactive Plus mass
spectrometer has detected an installed ESI source. ▲
The ESI source window has the following parameters:
Parameter

Description

Sheath Gas Flow Rate

Displays the setpoint ESI source sheath gas flow rate (in arbitrary units). To
change the setpoint flow rate, click the arrows in the Sheath Gas Flow Rate spin
box to increment [up arrow] or decrement [down arrow] the value. You can set
the sheath gas flow rate to any value from 0 to 80 units. Alternatively, you can
enter a value in the spin box text field. The mass spectrometer changes the flow
rate when you click Apply or with the Hot link check box being selected.
The Sheath Gas Flow Rate readback is to the right of the spin box. This readback
displays the actual flow rate (in arbitrary units).

Aux Gas Flow Rate

Displays the setpoint ESI source auxiliary gas flow rate (in arbitrary units). To
change the setpoint flow rate, click the arrows in the Aux Gas Flow Rate spin box
to increment [up arrow] or decrement [down arrow] the value. You can set the
flow rate to any value from 0 to 40 units. Alternatively, you can enter a value in
the spin box text field. The mass spectrometer changes the flow rate when you
click Apply or with the Hot link check box being selected.
The Aux Gas Flow Rate readback is to the right of the spin box. This readback
displays the actual flow rate (in arbitrary units).
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Parameter

Description

Sweep Gas Flow Rate

Displays the setpoint ESI source sweep gas flow rate. To change the setpoint flow
rate, click the arrows in the Sweep Gas Flow Rate spin box to increment [up
arrow] or decrement [down arrow] the value. You can set the flow rate to any
value from 0 to 10 units. Alternatively, you can enter a value in the spin box text
field. The mass spectrometer changes the flow rate when you click Apply or with
the Hot link check box being selected.
The Sweep Gas Flow Rate readback is to the right of the spin box. This readback
displays the actual flow rate (in arbitrary units).

Spray Voltage

Displays the setpoint ESI source spray voltage (absolute value, in kilovolts). To
change the setpoint spray voltage, click the arrows in the Spray Voltage spin box
to increment [up arrow] or decrement [down arrow] the value. You can set the
spray voltage to any value from 0.0 to 8.0 kV. The sign of the spray voltages
changes automatically with the ion polarity mode: positive for positive ions and
negative for negative ions. Alternatively, you can enter a value in the spin box text
field. The mass spectrometer changes the spray voltage when you click Apply or
with the Hot link check box being selected.
The Spray Voltage readback is to the right of the spin box. This readback displays
the actual spray voltage (absolute value, in kilovolts).

Spray Current

This readback displays the actual ESI source spray current (in microamperes).
The ESI spray current is typically less than 5 μA.

Capillary Temperature

Displays the setpoint ESI source heated capillary temperature (in degrees
Celsius). To change the setpoint heated capillary temperature, click the arrows in
the Capillary Temp spin box to increment [up arrow] or decrement [down arrow]
the value. You can set the heated capillary temperature to any value from 0 to 450
°C. Alternatively, you can enter a value in the spin box text field. The mass
spectrometer changes the heated capillary temperature when you click Apply or
with the Hot link check box being selected.
The Capillary Temperature readback is to the right of the spin box. This
readback displays the actual temperature (in degrees Celsius) of the heated
capillary.
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Parameter

Description

S-Lens RF Level

Displays a numerical factor that the Exactive Plus mass spectrometer uses, along
with the lowest and highest mass, to calculate the S-lens RF amplitude.
The magnitude of the S-lens RF level affects the mass spectrum as follows:
•
•
•
•

Decreasing the S-lens RF level will decrease the amount of fragmentation of
fragile ions in the S-lens.
Decreasing the S-lens RF level will decrease the transmission of high m/z ions
through the S-lens and increase the transmission of the low m/z ions.
Increasing the S-lens RF level will increase the amount of fragmentation of
fragile ions in the S-lens.
Increasing the S-lens RF level will increase the transmission of high m/z ions
through the S-lens and decrease the transmission of the low m/z ions.

To change the S-lens RF level, click the arrows in the S-Lens Level spin box to
increment [up arrow] or decrement [down arrow] the value. You can set the
S-lens RF level to any value from 0 to 100. Alternatively, you can enter a value in
the spin box text field. The mass spectrometer changes the S-lens RF level when
you click Apply or with the Hot link check box being selected.
NOTICE For stable ions, the default value, 50, provides a good starting point. By
default, the S-lens RF level remains at 50 during all calibrations. ▲
Buttons

Apply

Sends all changes to the instrument.

Help

Displays the Help for this window.

Hot Link

Select the Hot link check box to allow Exactive Plus Tune to send any changes
immediately to the instrument. A green frame around the parameter box
indicates an active hot link.
❖

To display this window

Click the ESI source window title bar in the Instrument Control
window.
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HESI Source Window
Use the HESI source window to specify heated-electrospray ionization
(H-ESI) source parameters. See API Source Settings for Various LC
Flow Rates for recommended settings. The Exactive Plus mass
spectrometer updates the H-ESI source parameters only after you click
Apply or with the Hot link check box being selected. See Figure 4-27.

Figure 4-27. HESI source window
NOTICE This window is available only when the Exactive Plus mass
spectrometer has detected an installed H-ESI source. The H-ESI source
is the standard API source of the Exactive Plus mass spectrometer. ▲
The HESI source window has the following parameters:
Parameter

Description

Sheath Gas Flow Rate

Displays the setpoint H-ESI source sheath gas flow rate (in arbitrary units). To
change the setpoint flow rate, click the arrows in the Sheath Gas Flow Rate spin
box to increment [up arrow] or decrement [down arrow] the value. You can set
the sheath gas flow rate to any value from 0 to 80 units. Alternatively, you can
enter a value in the spin box text field. The mass spectrometer changes the flow
rate when you click Apply or with the Hot link check box being selected.
The Sheath Gas Flow Rate readback is to the right of the spin box. This readback
displays the actual flow rate (in arbitrary units).
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Parameter

Description

Aux Gas Flow Rate

Displays the setpoint H-ESI source auxiliary gas flow rate (in arbitrary units). To
change the setpoint flow rate, click the arrows in the Aux Gas Flow Rate spin box
to increment [up arrow] or decrement [down arrow] the value. You can set the
flow rate to any value from 0 to 40 units. Alternatively, you can enter a value in
the spin box text field. The mass spectrometer changes the flow rate when you
click Apply or with the Hot link check box being selected.
The Aux Gas Flow Rate readback is to the right of the spin box. This readback
displays the actual flow rate (in arbitrary units).

Sweep Gas Flow Rate

Displays the setpoint H-ESI source sweep gas flow rate. To change the setpoint
flow rate, click the arrows in the Sweep Gas Flow Rate spin box to increment [up
arrow] or decrement [down arrow] the value. You can set the flow rate to any
value from 0 to 10 units. Alternatively, you can enter a value in the spin box text
field. The mass spectrometer changes the flow rate when you click Apply or with
the Hot link check box being selected.
The Sweep Gas Flow Rate readback is to the right of the spin box. This readback
displays the actual flow rate (in arbitrary units).

Spray Voltage

Displays the setpoint H-ESI source spray voltage (absolute value, in kilovolts). To
change the setpoint spray voltage, click the arrows in the Spray Voltage spin box
to increment [up arrow] or decrement [down arrow] the value. You can set the
spray voltage to any value from 0.0 to 8.0 kV. The sign of the spray voltages
changes automatically with the ion polarity mode: positive for positive ions and
negative for negative ions. Alternatively, you can enter a value in the spin box text
field. The mass spectrometer changes the spray voltage when you click Apply or
with the Hot link check box being selected.
The Spray Voltage readback is to the right of the spin box. This readback displays
the actual spray voltage (absolute value, in kilovolts).

Spray Current

This readback displays the actual H-ESI source spray current (in microamperes).
The H-ESI spray current is typically less than 5 μA.

Capillary Temperature

Displays the setpoint H-ESI source heated capillary temperature (in degrees
Celsius). To change the setpoint heated capillary temperature, click the arrows in
the Capillary Temp spin box to increment [up arrow] or decrement [down arrow]
the value. You can set the heated capillary temperature to any value from 0 to 450
°C. Alternatively, you can enter a value in the spin box text field. The mass
spectrometer changes the heated capillary temperature when you click Apply or
with the Hot link check box being selected.
The Capillary Temperature readback is to the right of the spin box. This
readback displays the actual temperature (in degrees Celsius) of the heated
capillary.
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Parameter

Description

S-Lens RF Level

Displays a numerical factor that the Exactive Plus mass spectrometer uses, along
with the lowest and highest mass, to calculate the S-lens RF amplitude.
The magnitude of the S-lens RF level affects the mass spectrum as follows:
•
•
•
•

Decreasing the S-lens RF level will decrease the amount of fragmentation of
fragile ions in the S-lens.
Decreasing the S-lens RF level will decrease the transmission of high m/z ions
through the S-lens and increase the transmission of the low m/z ions.
Increasing the S-lens RF level will increase the amount of fragmentation of
fragile ions in the S-lens.
Increasing the S-lens RF level will increase the transmission of high m/z ions
through the S-lens and decrease the transmission of the low m/z ions.

To change the S-lens RF level, click the arrows in the S-Lens Level spin box to
increment [up arrow] or decrement [down arrow] the value. You can set the
S-lens RF level to any value from 0 to 100. Alternatively, you can enter a value in
the spin box text field. The mass spectrometer changes the S-lens RF level when
you click Apply or with the Hot link check box being selected.
NOTICE For stable ions, the default value, 50, provides a good starting point. By
default, the S-lens RF level remains at 50 during all calibrations. ▲
Heater Temperature

Displays the setpoint temperature (in degrees Celsius) of the H-ESI source
heater, which heats the auxiliary gas. To change the setpoint vaporizer
temperature, click the arrows in the Heater Temp spin box to increment [up
arrow] or decrement [down arrow] the value. You can set the vaporizer
temperature to any value from 0 to 600 °C. Alternatively, you can enter a value in
the spin box text field. The mass spectrometer changes the vaporizer temperature
when you click Apply or with the Hot link check box being selected.
The Heater Temperature readback is to the right of the spin box. This readback
displays the actual temperature (in degrees Celsius) of the vaporizer.

Buttons

Apply

Sends all changes to the instrument.

Help

Displays the Help for this window.

Hot Link

Select the Hot link check box to allow Exactive Plus Tune to send any changes
immediately to the instrument. A green frame around the parameter box
indicates an active hot link.
❖

To display this window

Click the HESI source window title bar in the Instrument Control
window.
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NSI Source Window
Use the NSI source window to specify nanospray ionization (NSI)
source parameters. See Figure 4-28. The Exactive Plus mass
spectrometer updates the NSI source parameters only after you click
Apply or with the Hot link check box being selected.

Figure 4-28. NSI source window
NOTICE This window is available only when the Exactive Plus mass
spectrometer has detected an installed NSI source. ▲
The NSI source window has the following parameters:
Parameter

Description

Sheath Gas Flow Rate

Displays the setpoint NSI source sheath gas flow rate (in arbitrary units). To
change the setpoint flow rate, click the arrows in the Sheath Gas Flow Rate spin
box to increment [up arrow] or decrement [down arrow] the value. You can set
the sheath gas flow rate to any value from 0 to 80 units. Alternatively, you can
enter a value in the spin box text field. The mass spectrometer changes the flow
rate when you click Apply or with the Hot link check box being selected.
The Sheath Gas Flow Rate readback is to the right of the spin box. This readback
displays the actual flow rate (in arbitrary units).

Aux Gas Flow Rate

Displays the setpoint NSI source auxiliary gas flow rate (in arbitrary units). To
change the setpoint flow rate, click the arrows in the Aux Gas Flow Rate spin box
to increment [up arrow] or decrement [down arrow] the value. You can set the
flow rate to any value from 0 to 40 units. Alternatively, you can enter a value in
the spin box text field. The mass spectrometer changes the flow rate when you
click Apply or with the Hot link check box being selected.
The Aux Gas Flow Rate readback is to the right of the spin box. This readback
displays the actual flow rate (in arbitrary units).
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Parameter

Description

Sweep Gas Flow Rate

Displays the setpoint NSI source sweep gas flow rate. To change the setpoint flow
rate, click the arrows in the Sweep Gas Flow Rate spin box to increment [up
arrow] or decrement [down arrow] the value. You can set the flow rate to any
value from 0 to 10 units. Alternatively, you can enter a value in the spin box text
field. The mass spectrometer changes the flow rate when you click Apply or with
the Hot link check box being selected.
The Sweep Gas Flow Rate readback is to the right of the spin box. This readback
displays the actual flow rate (in arbitrary units).

Spray Voltage

Displays the setpoint NSI source spray voltage (absolute value, in kilovolts). To
change the setpoint spray voltage, click the arrows in the Spray Voltage spin box
to increment [up arrow] or decrement [down arrow] the value. You can set the
spray voltage to any value from 0.0 to 8.0 kV. The sign of the spray voltages
changes automatically with the ion polarity mode: positive for positive ions and
negative for negative ions. Alternatively, you can enter a value in the spin box text
field. The mass spectrometer changes the spray voltage when you click Apply or
with the Hot link check box being selected.
The Spray Voltage readback is to the right of the spin box. This readback displays
the actual spray voltage (absolute value, in kilovolts).

Spray Current

This readback displays the actual NSI source spray current (in microamperes).
NSI spray current is typically less than 5 μA.

Capillary Temperature

Displays the setpoint NSI source heated capillary temperature (in degrees
Celsius). To change the setpoint heated capillary temperature, click the arrows in
the Capillary Temp spin box to increment [up arrow] or decrement [down arrow]
the value. You can set the heated capillary temperature to any value from 0 to 450
°C. Alternatively, you can enter a value in the spin box text field. The mass
spectrometer changes the heated capillary temperature when you click Apply or
with the Hot link check box being selected.
The Capillary Temperature readback is to the right of the spin box. This
readback displays the actual temperature (in degrees Celsius) of the heated
capillary.
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Parameter

Description

S-Lens RF Level

Displays a numerical factor that the Exactive Plus mass spectrometer uses, along
with the lowest and highest mass, to calculate the S-lens RF amplitude.
The magnitude of the S-lens RF level affects the mass spectrum as follows:
•
•
•
•

Decreasing the S-lens RF level will decrease the amount of fragmentation of
fragile ions in the S-lens.
Decreasing the S-lens RF level will decrease the transmission of high m/z ions
through the S-lens and increase the transmission of the low m/z ions.
Increasing the S-lens RF level will increase the amount of fragmentation of
fragile ions in the S-lens.
Increasing the S-lens RF level will increase the transmission of high m/z ions
through the S-lens and decrease the transmission of the low m/z ions.

To change the S-lens RF level, click the arrows in the S-Lens Level spin box to
increment [up arrow] or decrement [down arrow] the value. You can set the
S-lens RF level to any value from 0 to 100. Alternatively, you can enter a value in
the spin box text field. The mass spectrometer changes the S-lens RF level when
you click Apply or with the Hot link check box being selected.
NOTICE For stable ions, the default value, 50, provides a good starting point. By
default, the S-lens RF level remains at 50 during all calibrations. ▲
Buttons

Apply

Sends all changes to the instrument.

Help

Displays the Help for this window.

Hot Link

Select the Hot link check box to allow Exactive Plus Tune to send any changes
immediately to the instrument. A green frame around the parameter box
indicates an active hot link.
❖

To display this window

Click the NSI source window title bar in the Instrument Control
window.
APCI Source Window
Use the APCI source window to set up an atmospheric pressure
chemical ionization (APCI) experiment. See API Source Settings for
Various LC Flow Rates for recommended settings. The Exactive Plus
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mass spectrometer updates the APCI source parameters only after you
click Apply or with the Hot link check box being selected. See
Figure 4-29.

Figure 4-29. APCI source window
NOTICE This window is available only when the Exactive Plus mass
spectrometer has detected an installed APCI source. ▲
The APCI source window has the following parameters:
Parameter

Description

Sheath Gas Flow Rate

Displays the setpoint APCI source sheath gas flow rate (in arbitrary units). To
change the setpoint flow rate, click the arrows in the Sheath Gas Flow Rate spin
box to increment [up arrow] or decrement [down arrow] the value. You can set
the sheath gas flow rate to any value from 0 to 80 units. Alternatively, you can
enter a value in the spin box text field. The mass spectrometer changes the flow
rate when you click Apply or with the Hot link check box being selected.
The Sheath Gas Flow Rate readback is to the right of the spin box. This readback
displays the actual flow rate (in arbitrary units).

Aux Gas Flow Rate

Displays the setpoint APCI source auxiliary gas flow rate (in arbitrary units). To
change the setpoint flow rate, click the arrows in the Aux Gas Flow Rate spin box
to increment [up arrow] or decrement [down arrow] the value. You can set the
flow rate to any value from 0 to 40 units. Alternatively, you can enter a value in
the spin box text field. The mass spectrometer changes the flow rate when you
click Apply or with the Hot link check box being selected.
The Aux Gas Flow Rate readback is to the right of the spin box. This readback
displays the actual flow rate (in arbitrary units).
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Parameter

Description

Sweep Gas Flow Rate

Displays the setpoint APCI source sweep gas flow rate. To change the setpoint
flow rate, click the arrows in the Sweep Gas Flow Rate spin box to increment [up
arrow] or decrement [down arrow] the value. You can set the flow rate to any
value from 0 to 10 units. Alternatively, you can enter a value in the spin box text
field. The mass spectrometer changes the flow rate when you click Apply or with
the Hot link check box being selected.
The Sweep Gas Flow Rate readback is to the right of the spin box. This readback
displays the actual flow rate (in arbitrary units).

Discharge Voltage

Displays the actual APCI source discharge voltage (absolute value, in kilovolts).

Discharge Current

Displays the setpoint APCI source discharge current (in microamperes). To
change the setpoint discharge current, click the arrows in the Discharge Current
spin box to increment [up arrow] or decrement [down arrow] the value. You can
set the discharge current to any value from 0 to 10 μA. (A typical value is 5 μA.)
Alternatively, you can enter a value in the spin box text field. The mass
spectrometer changes the discharge current when you click Apply or with the
Hot link check box being selected.
The Discharge Current readback is to the right of the spin box. This readback
displays the actual discharge current (in microamperes).

Capillary Temperature

Displays the setpoint APCI source heated capillary temperature (in degrees
Celsius). To change the setpoint heated capillary temperature, click the arrows in
the Capillary Temp spin box to increment [up arrow] or decrement [down arrow]
the value. You can set the heated capillary temperature to any value from 0.00 to
300.00 °C. Alternatively, you can enter a value in the spin box text field. The
mass spectrometer changes the heated capillary temperature when you click
Apply or with the Hot link check box being selected.
The Capillary Temperature readback is to the right of the spin box. This
readback displays the actual temperature (in degrees Celsius) of the heated
capillary.
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Parameter

Description

S-Lens RF Level

Displays a numerical factor that the Exactive Plus mass spectrometer uses, along
with the lowest and highest mass, to calculate the S-lens RF amplitude.
The magnitude of the S-lens RF level affects the mass spectrum as follows:
•
•
•
•

Decreasing the S-lens RF level will decrease the amount of fragmentation of
fragile ions in the S-lens.
Decreasing the S-lens RF level will decrease the transmission of high m/z ions
through the S-lens and increase the transmission of the low m/z ions.
Increasing the S-lens RF level will increase the amount of fragmentation of
fragile ions in the S-lens.
Increasing the S-lens RF level will increase the transmission of high m/z ions
through the S-lens and decrease the transmission of the low m/z ions.

To change the S-lens RF level, click the arrows in the S-Lens Level spin box to
increment [up arrow] or decrement [down arrow] the value. You can set the
S-lens RF level to any value from 0 to 100. Alternatively, you can enter a value in
the spin box text field. The mass spectrometer changes the S-lens RF level when
you click Apply or with the Hot link check box being selected.
NOTICE For stable ions, the default value, 50, provides a good starting point. By
default, the S-lens RF level remains at 50 during all calibrations. ▲
Vaporizer Temperature

Displays the setpoint APCI source vaporizer temperature (in degrees Celsius). To
change the setpoint vaporizer temperature, click the arrows in the Vaporizer
Temp. spin box to increment [up arrow] or decrement [down arrow] the value.
You can set the vaporizer temperature to any value from 0 to 600 °C.
Alternatively, you can enter a value in the spin box text field. The mass
spectrometer changes the vaporizer temperature when you click Apply or with
the Hot link check box being selected.
The Vaporizer Temperature readback is to the right of the spin box. This
readback displays the actual temperature (in degrees Celsius) of the vaporizer.

Buttons

Apply

Sends all changes to the instrument.

Help

Displays the Help for this window.

Hot Link

Select the Hot link check box to allow Exactive Plus Tune to send any changes
immediately to the instrument. A green frame around the parameter box
indicates an active hot link.
❖

To display this window

Click the APCI source window title bar in the Instrument Control
window.
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APPI Source Window
Use the APPI source window to specify atmospheric pressure chemical
ionization (APCI) source parameters and to turn on and off the
atmospheric pressure photoionization (APPI) lamp. See Figure 4-30.
The Exactive Plus mass spectrometer updates the APPI source
parameters only after you click Apply or with the Hot link check box
being selected.

Figure 4-30. APPI source window
NOTICE This window is available only when the Exactive Plus mass
spectrometer has detected an installed APPI source. ▲
The APPI source window has the following parameters:
Parameter

Description

Sheath Gas Flow Rate

Displays the setpoint APPI source sheath gas flow rate (in arbitrary units). To
change the setpoint flow rate, click the arrows in the Sheath Gas Flow Rate spin
box to increment [up arrow] or decrement [down arrow] the value. You can set
the sheath gas flow rate to any value from 0 to 80 units. Alternatively, you can
enter a value in the spin box text field. The mass spectrometer changes the flow
rate when you click Apply or with the Hot link check box being selected.
The Sheath Gas Flow Rate readback is to the right of the spin box. This readback
displays the actual flow rate (in arbitrary units).
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Parameter

Description

Aux Gas Flow Rate

Displays the setpoint APPI source auxiliary gas flow rate (in arbitrary units). To
change the setpoint flow rate, click the arrows in the Aux Gas Flow Rate spin box
to increment [up arrow] or decrement [down arrow] the value. You can set the
flow rate to any value from 0 to 40 units. Alternatively, you can enter a value in
the spin box text field. The mass spectrometer changes the flow rate when you
click Apply or with the Hot link check box being selected.
The Aux Gas Flow Rate readback is to the right of the spin box. This readback
displays the actual flow rate (in arbitrary units).

Sweep Gas Flow Rate

Displays the setpoint APPI source sweep gas flow rate. To change the setpoint
flow rate, click the arrows in the Sweep Gas Flow Rate spin box to increment [up
arrow] or decrement [down arrow] the value. You can set the flow rate to any
value from 0 to 10 units. Alternatively, you can enter a value in the spin box text
field. The mass spectrometer changes the flow rate when you click Apply or with
the Hot link check box being selected.
The Sweep Gas Flow Rate readback is to the right of the spin box. This readback
displays the actual flow rate (in arbitrary units).

Discharge Voltage

When APPI is selected as ionization method, the actual discharge voltage displays
‘0’. When either APCI or APCI+APPI is selected as ionization method, the
actual discharge voltage displays APCI voltage readback (absolute value, in
kilovolts).

Discharge Current

Displays the setpoint source discharge current (in microamperes). To change the
setpoint discharge current, click the arrows in the Discharge Current spin box to
increment [up arrow] or decrement [down arrow] the value. You can set the
discharge current to any value from 0 to 80 μA. (A typical value is 5 μA.)
Alternatively, you can enter a value in the spin box text field. The mass
spectrometer changes the discharge current when you click Apply or with the
Hot link check box being selected.
NOTICE When APPI is selected as ionization method, changes in discharge
current have no effect. Discharge current changes are applied only when either
APCI or APCI+APPI is selected as ionization method. ▲
The Discharge Current readback is to the right of the spin box. This readback
displays the actual discharge current (in microamperes).
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Parameter

Description

Capillary Temperature

Displays the setpoint APPI source heated capillary temperature (in degrees
Celsius). To change the setpoint heated capillary temperature, click the arrows in
the Capillary Temp spin box to increment [up arrow] or decrement [down arrow]
the value. You can set the heated capillary temperature to any value from 0.00 to
450.00 °C. Alternatively, you can enter a value in the spin box text field. The
mass spectrometer changes the heated capillary temperature when you click
Apply or with the Hot link check box being selected.
The Capillary Temperature readback is to the right of the spin box. This
readback displays the actual temperature (in degrees Celsius) of the heated
capillary.

S-Lens RF Level

Displays a numerical factor that the Exactive Plus mass spectrometer uses, along
with the lowest and highest mass, to calculate the S-lens RF amplitude.
The magnitude of the S-lens RF level affects the mass spectrum as follows:
•
•
•
•

Decreasing the S-lens RF level will decrease the amount of fragmentation of
fragile ions in the S-lens.
Decreasing the S-lens RF level will decrease the transmission of high m/z ions
through the S-lens and increase the transmission of the low m/z ions.
Increasing the S-lens RF level will increase the amount of fragmentation of
fragile ions in the S-lens.
Increasing the S-lens RF level will increase the transmission of high m/z ions
through the S-lens and decrease the transmission of the low m/z ions.

To change the S-lens RF level, click the arrows in the S-Lens Level spin box to
increment [up arrow] or decrement [down arrow] the value. You can set the
S-lens RF level to any value from 0 to 100. Alternatively, you can enter a value in
the spin box text field. The mass spectrometer changes the S-lens RF level when
you click Apply or with the Hot link check box being selected.
NOTICE For stable ions, the default value, 50, provides a good starting point. By
default, the S-lens RF level remains at 50 during all calibrations. ▲
Vaporizer Temperature

Displays the setpoint APPI source vaporizer temperature (in degrees Celsius). To
change the setpoint vaporizer temperature, click the arrows in the Vaporizer
Temp. spin box to increment [up arrow] or decrement [down arrow] the value.
You can set the vaporizer temperature to any value from 0 to 500 °C.
Alternatively, you can enter a value in the spin box text field. The mass
spectrometer changes the vaporizer temperature when you click Apply or with
the Hot link check box being selected.
The Vaporizer Temperature readback is to the right of the spin box. This
readback displays the actual temperature (in degrees Celsius) of the vaporizer.

4-28

Exactive Plus Software Manual (P/N 1323070, Revision A)

Thermo Fisher Scientific

Explore Exactive Plus Tune
Tasks Panel

Parameter

Description

Ionization

Use this list box to select the ionization method. The following options are
available:
•
•
•

APCI
APCI alone
APPI
Photoionization
APCI + APPI
APCI in combination with APCI

Buttons

Apply

Sends all changes to the instrument.

Help

Displays the Help for this window.

Hot Link

Select the Hot link check box to allow Exactive Plus Tune to send any changes
immediately to the instrument. A green frame around the parameter box
indicates an active hot link.
❖

To display this dialog box

Click the APPI source window title bar in the Instrument Control
window.
DART Source Window
Use the DART source window to specify direct analysis in real time
(DART) source parameters. See Figure 4-31. The Exactive Plus mass
spectrometer updates the DART source parameters only after you click
Apply or with the Hot link check box being selected.

Figure 4-31. DART source window
NOTICE This window is available only when the Exactive Plus mass
spectrometer has detected an installed DART source. ▲
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The DART source window has the following parameters:
Parameter

Description

Sheath Gas Flow Rate

Displays the setpoint DART source sheath gas flow rate (in arbitrary units). To
change the setpoint flow rate, click the arrows in the Sheath Gas Flow Rate spin
box to increment [up arrow] or decrement [down arrow] the value. You can set
the sheath gas flow rate to any value from 0 to 80 units. Alternatively, you can
enter a value in the spin box text field. The mass spectrometer changes the flow
rate when you click Apply or with the Hot link check box being selected.
The Sheath Gas Flow Rate readback is to the right of the spin box. This readback
displays the actual flow rate (in arbitrary units).

Aux Gas Flow Rate

Displays the setpoint DART source auxiliary gas flow rate (in arbitrary units). To
change the setpoint flow rate, click the arrows in the Aux Gas Flow Rate spin box
to increment [up arrow] or decrement [down arrow] the value. You can set the
flow rate to any value from 0 to 40 units. Alternatively, you can enter a value in
the spin box text field. The mass spectrometer changes the flow rate when you
click Apply or with the Hot link check box being selected.
The Aux Gas Flow Rate readback is to the right of the spin box. This readback
displays the actual flow rate (in arbitrary units).

Sweep Gas Flow Rate

Displays the setpoint DART source sweep gas flow rate. To change the setpoint
flow rate, click the arrows in the Sweep Gas Flow Rate spin box to increment [up
arrow] or decrement [down arrow] the value. You can set the flow rate to any
value from 0 to 10 units. Alternatively, you can enter a value in the spin box text
field. The mass spectrometer changes the flow rate when you click Apply or with
the Hot link check box being selected.
The Sweep Gas Flow Rate readback is to the right of the spin box. This readback
displays the actual flow rate (in arbitrary units).

Spray Voltage

Displays the setpoint DART source spray voltage (absolute value, in kilovolts).
To change the setpoint spray voltage, click the arrows in the Spray Voltage spin
box to increment [up arrow] or decrement [down arrow] the value. You can set
the spray voltage to any value from 0.0 to 8.0 kV. The sign of the spray voltages
changes automatically with the ion polarity mode: positive for positive ions and
negative for negative ions. Alternatively, you can enter a value in the spin box text
field. The mass spectrometer changes the spray voltage when you click Apply or
with the Hot link check box being selected.
The Spray Voltage readback is to the right of the spin box. This readback displays
the actual spray voltage (absolute value, in kilovolts).

Spray Current
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Parameter

Description

Capillary Temperature

Displays the setpoint DART source heated capillary temperature (in degrees
Celsius). To change the setpoint heated capillary temperature, click the arrows in
the Capillary Temp spin box to increment [up arrow] or decrement [down arrow]
the value. You can set the heated capillary temperature to any value from 0.00 to
450.00 °C. Alternatively, you can enter a value in the spin box text field. The
mass spectrometer changes the heated capillary temperature when you click
Apply or with the Hot link check box being selected.
The Capillary Temperature readback is to the right of the spin box. This
readback displays the actual temperature (in degrees Celsius) of the heated
capillary.

S-Lens RF Level

Displays a numerical factor that the Exactive Plus mass spectrometer uses, along
with the lowest and highest mass, to calculate the S-lens RF amplitude.
The magnitude of the S-lens RF level affects the mass spectrum as follows:
•
•
•
•

Decreasing the S-lens RF level will decrease the amount of fragmentation of
fragile ions in the S-lens.
Decreasing the S-lens RF level will decrease the transmission of high m/z ions
through the S-lens and increase the transmission of the low m/z ions.
Increasing the S-lens RF level will increase the amount of fragmentation of
fragile ions in the S-lens.
Increasing the S-lens RF level will increase the transmission of high m/z ions
through the S-lens and decrease the transmission of the low m/z ions.

To change the S-lens RF level, click the arrows in the S-Lens Level spin box to
increment [up arrow] or decrement [down arrow] the value. You can set the
S-lens RF level to any value from 0 to 100. Alternatively, you can enter a value in
the spin box text field. The mass spectrometer changes the S-lens RF level when
you click Apply or with the Hot link check box being selected.
NOTICE For stable ions, the default value, 50, provides a good starting point. By
default, the S-lens RF level remains at 50 during all calibrations. ▲
Buttons

Apply

Sends all changes to the instrument.

Help

Displays the Help for this window.

Hot Link

Select the Hot link check box to allow Exactive Plus Tune to send any changes
immediately to the instrument. A green frame around the parameter box
indicates an active hot link.
❖

To display this dialog box

Click the DART source window title bar in the Instrument Control
window.
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MALDI Source Window
Use the MALDI source window to specify matrix-assisted laser
desorption/ionization (MALDI) source parameters. See Figure 4-32.
The Exactive Plus mass spectrometer updates the MALDI source
parameters only after you click Apply or with the Hot link check box
being selected.

Figure 4-32. MALDI source window
NOTICE This window is available only when the Exactive Plus mass
spectrometer has detected an installed MALDI source. ▲
The MALDI source window has the following parameters:
Parameter

Description

Sheath Gas Flow Rate

Displays the setpoint MALDI source sheath gas flow rate (in arbitrary units). To
change the setpoint flow rate, click the arrows in the Sheath Gas Flow Rate spin
box to increment [up arrow] or decrement [down arrow] the value. You can set
the sheath gas flow rate to any value from 0 to 80 units. Alternatively, you can
enter a value in the spin box text field. The mass spectrometer changes the flow
rate when you click Apply or with the Hot link check box being selected.
The Sheath Gas Flow Rate readback is to the right of the spin box. This readback
displays the actual flow rate (in arbitrary units).

Aux Gas Flow Rate

Displays the setpoint MALDI source auxiliary gas flow rate (in arbitrary units).
To change the setpoint flow rate, click the arrows in the Aux Gas Flow Rate spin
box to increment [up arrow] or decrement [down arrow] the value. You can set
the flow rate to any value from 0 to 40 units. Alternatively, you can enter a value
in the spin box text field. The mass spectrometer changes the flow rate when you
click Apply or with the Hot link check box being selected.
The Aux Gas Flow Rate readback is to the right of the spin box. This readback
displays the actual flow rate (in arbitrary units).
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Parameter

Description

Sweep Gas Flow Rate

Displays the setpoint MALDI source sweep gas flow rate. To change the setpoint
flow rate, click the arrows in the Sweep Gas Flow Rate spin box to increment [up
arrow] or decrement [down arrow] the value. You can set the flow rate to any
value from 0 to 10 units. Alternatively, you can enter a value in the spin box text
field. The mass spectrometer changes the flow rate when you click Apply or with
the Hot link check box being selected.
The Sweep Gas Flow Rate readback is to the right of the spin box. This readback
displays the actual flow rate (in arbitrary units).

Spray Voltage

Displays the setpoint MALDI source spray voltage (absolute value, in kilovolts).
To change the setpoint spray voltage, click the arrows in the Spray Voltage spin
box to increment [up arrow] or decrement [down arrow] the value. You can set
the spray voltage to any value from 0.0 to 8.0 kV. The sign of the spray voltages
changes automatically with the ion polarity mode: positive for positive ions and
negative for negative ions. Alternatively, you can enter a value in the spin box text
field. The mass spectrometer changes the spray voltage when you click Apply or
with the Hot link check box being selected.
The Spray Voltage readback is to the right of the spin box. This readback displays
the actual spray voltage (absolute value, in kilovolts).

Spray Current

This readback displays the actual MALDI source spray current (in
microamperes). MALDI spray current is typically less than 5 μA.

Capillary Temperature

Displays the setpoint MALDI source heated capillary temperature (in degrees
Celsius). To change the setpoint heated capillary temperature, click the arrows in
the Capillary Temp spin box to increment [up arrow] or decrement [down arrow]
the value. You can set the heated capillary temperature to any value from 0.00 to
450.00 °C. Alternatively, you can enter a value in the spin box text field. The
mass spectrometer changes the heated capillary temperature when you click
Apply or with the Hot link check box being selected.
The Capillary Temperature readback is to the right of the spin box. This
readback displays the actual temperature (in degrees Celsius) of the heated
capillary.
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Parameter

Description

S-Lens RF Level

Displays a numerical factor that the Exactive Plus mass spectrometer uses, along
with the lowest and highest mass, to calculate the S-lens RF amplitude.
The magnitude of the S-lens RF level affects the mass spectrum as follows:
•
•
•
•

Decreasing the S-lens RF level will decrease the amount of fragmentation of
fragile ions in the S-lens.
Decreasing the S-lens RF level will decrease the transmission of high m/z ions
through the S-lens and increase the transmission of the low m/z ions.
Increasing the S-lens RF level will increase the amount of fragmentation of
fragile ions in the S-lens.
Increasing the S-lens RF level will increase the transmission of high m/z ions
through the S-lens and decrease the transmission of the low m/z ions.

To change the S-lens RF level, click the arrows in the S-Lens Level spin box to
increment [up arrow] or decrement [down arrow] the value. You can set the
S-lens RF level to any value from 0 to 100. Alternatively, you can enter a value in
the spin box text field. The mass spectrometer changes the S-lens RF level when
you click Apply or with the Hot link check box being selected.
NOTICE For stable ions, the default value, 50, provides a good starting point. By
default, the S-lens RF level remains at 50 during all calibrations. ▲
Buttons

Apply

Sends all changes to the instrument.

Help

Displays the Help for this window.

Hot Link

Select the Hot link check box to allow Exactive Plus Tune to send any changes
immediately to the instrument. A green frame around the parameter box
indicates an active hot link.
❖

To display this dialog box

Click the MALDI source window title bar in the Instrument
Control window.
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Acquisition Window
Use the Acquisition window to enter parameters for acquiring and
storing scan data as well as to monitor the progress of the active
acquisition. See Figure 4-33.

Figure 4-33. Acquisition window
The Acquisition window has the following parameters:
Parameter

Description

Acquisition state

Displays the status of the current acquisition.

Progress

Displays the elapsed time of the current acquisition.

File in use

Displays the name of the raw file to be acquired to disk for the current sample. To
display the file in Qual Browser, click the
button.
This value is up to date even when Exactive Plus Tune is acquiring data under control
of Xcalibur.

Destination file

Displays the full path of the folder where your *.raw files will be saved. To change the
path, type the full path (Drive:\path) in the text box or click the
button to the
right of the text box to browse your directories and select the folder where your *.raw
files should be saved.
NOTICE Saving raw files on network drives typically causes problems. Preferably
select a local path (for example, C:\Xcalibur\data). ▲
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Parameter

Description

Method file

Displays the name of the instrument method (*.meth) to be used during the current
acquisition. The tune file used in that instrument method will be used for your scan
but other devices configured in that instrument method will not be included. Type in
the name of the instrument method, or click the
button to the right of the text
box to browse your computer for an instrument method file (typically saved in
C:\Xcalibur\methods).
When the active acquisition is controlled by the settings of the parameter Acquisitions
time, this parameter is not available. Instead, the text field shows by time.

Sample

Displays the name of the current sample. To change the sample name, type the new
name in the text field.

Comment

Displays a comment on the current sample, if available. To change the comment, type
the new name in the text field.

Acquisition time

Displays the duration of the acquisition time. Use the option buttons to select one of
the following settings:
•

•

•

Continuously
The acquisition, once it is started, will continue until you stop (Stop button) or
pause (Pause button) it.
Scans
Specify the number of scans for the current acquisition. You can set the number of
scans to any value from 1 to 10000.
To change this value, click the arrows in the spin box to increment [up arrow] or
decrement [down arrow] the value. Alternatively, enter a value in the spin box text
field.
Minutes
Specify the time in minutes for the current acquisition. You can set the acquisition
time from 0.01 to 15000.00 minutes.
To change this value, click the arrows in the spin box to increment [up arrow] or
decrement [down arrow] the value. Alternatively, enter a value in the spin box text
field.

When the active acquisition is controlled by a method file, this parameter is not
available. Instead, the text field shows by method.
On start
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Use the list box to set the start mode of the data acquisition. The options are as
follows:
• don’t wait
Initiates acquisition of the raw file immediately when you click Start in the
Acquisition window.
• wait for contact closure
When you click Start in the Acquisition window, the acquisition pauses. Exactive
Plus Tune initiates acquisition of the raw file either when it receives a contact
closure signal (for example, from an analog autosampler) or when you click
Resume.
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Parameter

Description

After acquisition

Use the list box to set the instrument mode after the data acquisition has stopped. The
options are as follows:
•
•
•

keep being on
The instrument remains On when the current acquisition is completed.
enter standby mode
Sets the instrument to Standby when the current acquisition is completed.
switch off
Switches Off the instrument when the current acquisition is completed.

Buttons

Start / Stop

Allows starting and stopping data acquisition. When no acquisition is in progress,
Exactive Plus Tune displays Start. When an acquisition is in progress, Exactive Plus
Tune displays Stop. To start an acquisition, click Start. To stop an acquisition, click
Stop. To pause an acquisition, click the Pause / Resume button.
NOTICE No Exactive Plus Tune controlled data acquisition is possible if the
instrument is controlled by Xcalibur or Pathfinder. ▲

Pause / Resume

Allows pausing and resuming an acquisition in progress. When no acquisition is in
progress, the button is inactive (gray). When an acquisition is in progress, Exactive
Plus Tune displays Pause. When an acquisition is paused, Exactive Plus Tune displays
Resume. To pause an acquisition in progress, click Pause. To resume an acquisition
that is paused, click Resume. To stop an acquisition in progress, click the Start / Stop
button.
NOTICE The acquisition can be started by pressing Resume if the mass spectrometer
is waiting for contact closure. ▲

Help

Displays the Help for this window.
❖

To display this window

Click the Acquisition window title bar in the Instrument Control
window.
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Tune Window
Use the Tune window of the tasks panel to optimize the tune of the mass
spectrometer. See Figure 4-34.

Figure 4-34. Tune window
The tuning procedure requires that you introduce tuning solution, or a
solution of your analyte of interest, into the mass spectrometer at a
steady rate for several minutes (or longer). You can introduce the
solution directly from the syringe pump or from the syringe pump into
the effluent of the LC by using a Tee union. Refer to the Exactive Plus
Operating Manual for information.
The Tune window has the following parameters:
Parameter

Description

TIC

Select the TIC option button to perform an automatic tuning of the mass spectrometer
using the total ion current (TIC) intensity.

Mass

Select the Mass option button to perform an automatic tuning of the mass spectrometer
using a peak of interest at any specified mass-to-charge ratio. When you select the Mass
option button, the spin box becomes active. The spin box displays the mass-to-charge ratio
to optimize on. You can set the mass-to-charge ratio to any value from m/z 50 to m/z 6000.
To change this value, click the arrows in the spin box to increment [up arrow] or
decrement [down arrow] the value. Alternatively, enter a value in the spin box text field.

Progress bar

Displays the elapsed percentage of the current tuning procedure.

Buttons

Tune

Click Tune to start an automatic tuning of the mass spectrometer. The instrument needs
to be in On state to start a tuning procedure. Automatic tuning requires about one minute.
When tuning is in progress, Exactive Plus Tune displays Stop.
For advanced users, this button is available only when at least one check box in the
Elements window is selected.

Stop

Click Stop to stop a tuning in progress.

Help

Displays the Help for this window.
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❖

To display this window

Click

in the tasks panel.

Elements Window
The Elements window is shown below the Tune window. See
Figure 4-35. Use the window to select what tune parameters you want to
optimize. Select at least one parameter to enable the Tune button in the
Tune window.

Figure 4-35. Elements window
The Elements window has the following parameters:
Parameter

Description

HCD Mode

Select this check box to optimize the tune parameters
of the HCD cell.

Mass Traces Window
Use the Mass Traces window to display mass traces for the total ion
current and up to five m/z values in the Analysis Graphs window. See
Figure 4-36. You can plot mass traces when manually adjusting source
parameters like gas flows or spray voltage. You can also optimize
normalized collision energy or in-source CID energy.
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NOTICE Make sure to tune your instrument for both ion modes if you
want to use a switching method! Settings for both polarity modes are
safed in the same tune file! ▲

Figure 4-36. Mass Traces window
The Mass Traces window has the following parameters:
Parameter

Description

Plot

TIC

Select this check box to plot the total ion current.

Masses to plot

Select a check box for each m/z value that you want to plot (up to five). When
you select a check box, the spin box becomes active. The spin box displays the
mass-to-charge ratio to plot. You can set the mass-to-charge ratio to any value
from m/z 50 to m/z 6000.
To change this value, click the arrows in the spin box to increment [up arrow]
or decrement [down arrow] the value. Alternatively, enter a value in the spin
box text field.

Scan HCD Energy

Select this option button to optimize the normalized collision energy on the
total ion current.

Scan in-source CID energy

Select this option button to optimize the in-source CID energy on the total ion
current.

Just plot

Select this option button to plot the mass trace without optimization.
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Parameter

Description

Buttons

Start

Click Start to start plotting the mass traces. The instrument needs to be in On
status to start a plotting procedure.
When plotting is in progress, the Exactive Plus Tune displays Stop.

Stop

Click Stop to stop plotting the mass traces.

Help

Displays the Help for this window.

Calibrate Window
Use the Calibrate window of the tasks panel to perform an automatic
optimization of the calibration parameters. See Figure 4-37. Calibration
parameters are instrument parameters whose values do not vary with the
type of experiment.

Figure 4-37. Calibrate window
Standard users can choose the ion mode they want to calibrate in the
Calmix Calibration window. Advanced users can use the Calmix
Calibration window to calibrate the instrument with the standard
calibration solution (calmix). Alternatively, they can use the Customized
Calibration window to enter parameters for a calibration with a
calibration solution of their choosing.
NOTICE If the system was in Off mode before, it is necessary to put the
instrument into On mode for at least 90 minutes before a mass
calibration is performed. ▲
The calibrating procedure requires that you introduce calibration
solution into the mass spectrometer at a steady rate for several minutes
(or longer). You can introduce the solution directly from the syringe
pump. Refer to the Exactive Plus Operating Manual for information.
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The Calibrate window has the following parameters:
Parameter

Description

Progress bar

Displays the elapsed percentage of the current
calibration procedure.

Buttons

Calibrate

Click Calibrate to start an automatic
calibration of the mass spectrometer. The
instrument needs to be in On status to start a
calibration. The duration of the automatic
calibration depends on the selected check
boxes; a complete automatic calibration
requires about four minutes.
When calibration is in progress, Exactive Plus
Tune displays Stop.

Stop

Click Stop to stop a calibration in progress.

Help

Displays the Help for this window.

❖

To display this window

Click

in the tasks panel.

Calmix Calibration Window
Use the Calmix Calibration window to select parameters and ion modes
when performing an automatic calibration with the standard calibration
solution (calmix). See Figure 4-38 and Figure 4-39. The window
displays the current statuses of the individual calibration items on the
right side.

Figure 4-38. Calmix Calibration window (for standard users)

Figure 4-39. Calmix Calibration window (for advanced users)
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The Calmix Calibration window has the following parameters:
Parameter

Description

Base Calibration

The Base Calibration item displays a
hierarchical list of items in a tree view. Here,
you can select individual parameters that you
want to calibrate.
If a check box is not selected ( ), no subentry
is selected. If the check box is selected ( ), all
subentries are selected. If the check box is
filled ( ), some subentries are selected.
This parameter is not available for standard
users.

MS Mass Calibration Select this check box to perform an automatic
(pos)
calibration for all calibration parameters in the
positive ion mode.
NOTICE Use the calibration solution for
positive ion mode. Refer to the Exactive Plus
Operating Manual or the Exactive Plus
QuickStart Guide for information. ▲
MS Mass Calibration Select this check box to perform an automatic
(neg)
calibration for all calibration parameters in the
negative ion mode.
Use the calibration solution for negative ion
mode. Refer to the Exactive Plus Operating
Manual or the Exactive Plus QuickStart Guide
for information. ▲
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Customized Calibration Window
Use the Customized Calibration window to perform a mass calibration
with a user-defined calibration solution. Enter the m/z values on which
to calibrate. See Figure 4-40. This window is not available for standard
users.

Figure 4-40. Customized Calibration window
NOTICE Use this window for (positive and negative) mass calibration
only! For all other calibration procedures, use the standard calibration
solution (calmix)! ▲
The Customized Calibration window has the following parameters:
Parameter

Description

Masses to calibrate

Select a check box for each m/z value that you
want to plot (up to ten for each ion mode).
When you select a check box, the spin box
becomes active. The spin box displays the
mass-to-charge ratio to plot. You can set the
mass-to-charge ratio to any value from m/z 50
to m/z 6000.
To change this value, click the arrows in the
spin box to increment [up arrow] or decrement
[down arrow] the value. Alternatively, enter a
value in the spin box text field.
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Evaluate Window
Use the Evaluate window of the tasks panel to perform an automatic
check of the instrument calibration. See Figure 4-41.

Figure 4-41. Evaluate window
To enable an evaluation, standard users must select the check box in the
Calmix Evaluation window. Advanced users must select at least one
check box either in the Calmix Evaluation window or in the Customized
Evaluation window.
The evaluation procedure requires that you introduce calibration
solution (calmix) into the mass spectrometer at a steady rate for several
minutes (or longer). You can introduce the solution directly from the
syringe pump. Refer to the Exactive Plus Operating Manual for
information.
The Evaluate window has the following parameters:
Parameter

Description

Progress bar

Displays the elapsed percentage of the
current evaluation procedure.

Buttons

Evaluate

Click Evaluate to start an automatic
evaluation of calibration parameters.
The instrument needs to be in On
status to start an evaluation.
When evaluation is in progress,
Exactive Plus Tune displays Stop.

Thermo Fisher Scientific

Stop

Click Stop to stop an evaluation in
progress.

Help

Displays the Help for this window.
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Calmix Evaluation Window
Use the Calmix Evaluation window to enable the evaluation with the
standard calibration solution (calmix). See Figure 4-42.

Figure 4-42. Calmix Evaluation window (for advanced users)
The Calmix Evaluation window has the following parameters:
Parameter

Description

In a hierarchical list of items in a tree view, you can select individual
parameters that you want to evaluate.
If the check box is not selected ( ), no subentry is selected. If the
check box is selected ( ), all subentries are selected. If the check box
is filled ( ), some subentries are selected.
Positive Ion Evaluation

Select the check boxes to evaluate
various parameters in the positive ion
mode.

Negative Ion Evaluation

Select the check boxes to evaluate
various parameters in the negative ion
mode.

Extra Evaluation

Select the check boxes to evaluate
various parameters that are not
contained in the standard evaluations.

Long-term Mass Accuracy
Test

Select this check box to enable a mass
accuracy test over an extended period.
This parameter is not available for
standard users.
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Customized Evaluation Window
Use the Customized Evaluation window to enter the m/z values on
which to evaluate by using a user-defined calibration solution. See
Figure 4-40. This window is not available for standard users.

Figure 4-43. Customized Evaluation window
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The Customized Evaluation window has the following parameters:
Parameter

Description

Masses to evaluate

Select a check box for each m/z value that you
want to plot (up to ten for each ion mode).
When you select a check box, the spin box
becomes active. The spin box displays the
mass-to-charge ratio to plot. You can set the
mass-to-charge ratio to any value from m/z 50
to m/z 6000.
To change this value, click the arrows in the
spin box to increment [up arrow] or decrement
[down arrow] the value. Alternatively, enter a
value in the spin box text field.

Duration

The spin box displays the duration (in minutes)
of the evaluation procedure. You can set the
duration to any value from 0.2 to
2160 minutes. The default duration is
0.5 minutes.
To change this value, click the arrows in the
spin box to increment [up arrow] or decrement
[down arrow] the value. Alternatively, enter a
value in the spin box text field.

❖
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in the Tasks window.
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Vacuum / Bakeout Window
The Vacuum / Bakeout window of the tasks panel reads back the
pressure values at the vacuum gauges and allows performing an
instrument bakeout. See Figure 4-44.

Figure 4-44. Vacuum / Bakeout window
NOTICE After the bakeout time has expired, the instrument requires a
cooling and stabilization time of about three hours. ▲
The Vacuum / Bakeout window has the following parameters:
Parameter

Description

Vacuum

Green LEDs indicate that the readback values are sufficient for operating the Exactive Plus mass spectrometer.
If an LED indicates a vacuum problem, use the instrument status window for error diagnosis.
Fore vacuum

This readback displays the actual pressure (in mBar) in the forevacuum line
and ion source region as read by the Pirani gauge.

High vacuum

This readback displays the actual pressure (in mBar) in the high vacuum
chamber as read by the ion gauge.
This parameter is visible only when the ion gauge in the high vacuum
chamber is switched on. With exception of standard users, users can switch
on this gauge by using the shortcut menu of the Vacuum System node of the
instrument status window.

UHV

Thermo Fisher Scientific

This readback displays the actual pressure (in mBar) in the Orbitrap
chamber as read by the ion gauge.
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Parameter

Description

Bakeout

Bakeout time

Enter the desired baking duration (in hours) into the spin box. The range is
4 to 100 hours. When you click Bake out, the mass spectrometer starts the
baking routine.
The baking script is stopped after the preset duration. Click Stop to abort
the baking routine.
NOTICE The instrument has to cool down for another three hours before it
can be used. ▲

Enter standby after Bakeout

Select the check box to set the instrument to standby mode after the bakeout
procedure is finished.

Progress bar

Displays the elapsed percentage of the current baking procedure.

Bake out

Click Bake out to start the bakeout routine. To stop a bakeout in progress,
click the Stop button.
NOTICE Bakeout is possible only when the instrument status is Off. ▲

Stop

Click Stop to abort the bakeout routine.
NOTICE The instrument has to cool down for another three hours before it
can be used. ▲

Help

Displays the Help for this window.
❖

To display this window

Click

in the tasks

panel.
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Display Panel
The windows in the display panel provide real-time information about
the instrument status, the Exactive Plus Tune software, or other
programs.
The following windows are available:
•

Spectrum Window

•

Instrument Status Window

•

Messages Window

•

Analysis Graphs Window

•

Debug Messages Window

The spectrum window is always visible. The debug messages window is
not available for standard users.
Exactive Plus Tune offers various ways to arrange windows in the display
panel:
❖

To display a window in the display panel

Choose the respective command in the Windows menu.
❖

To hide a window in the display panel

•

Choose the respective command in the Windows menu.

•

Right-click the title bar of a window to display the shortcut menu.
Choose Hide.

❖

To change the position of a window in the display panel

•

Use the mouse to drag the window by its title bar to the new
location, which can be even outside the Exactive Plus Tune window.

•

Within the display panel, you can dock the window to any one of
the four sides. While you drag the window, Exactive Plus Tune
displays icons to indicate the available docking positions.

•

Right-click the title bar of a docked window to display the shortcut
menu. Choose Floating to undock the window.
Alternatively, double-click the title bar of the window.

•

Right-click the title bar of an undocked window to display the
shortcut menu. Choose Floating to dock the window to its last
docking position.
Alternatively, double-click the title bar of the window.
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Spectrum Window
The spectrum window displays real-time data generated during
calibration, tuning, and diagnostic tests. See Figure 4-45. The spectrum
window is always visible.

Figure 4-45. Spectrum window
The spectrum window allows using the mouse for zooming.
❖

To zoom in or out on a spectrum

•

Click and drag with the left mouse button (hand cursor) from
the beginning to the end of the portion you want to see
enlarged.

•

Alternatively, use the mouse wheel for zooming. Position the
mouse pointer within the spectrum and roll the wheel forward
to zoom in on the spectrum area.

•

To zoom in on the spectrum with respect to one axis only,
position the mouse pointer within the axis area and roll the
mouse wheel forward. Roll the wheel backward to zoom out.

•

To increase the zooming factor by two, keep the <Shift> key
pressed while using the mouse wheel.

To return to a display of the full spectrum, click the
the toolbar or choose Un-Zoom in the shortcut menu.
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Press the <Shift> key to enable mouse panning. When mouse panning
is active (mouse pointer changes to hand cursor), you can shift the
spectrum along the X-axis while keeping the left mouse button pressed.
The spectrum window has the following parameters:
Parameter

Description

Header

Scan #

The number of scans since the beginning of the
last acquisition (or since the last time the mass
spectrometer was rebooted)

μS

Number of microscans

IT

Inject time (in milliseconds)

NL

Normalization level

Type

Scan type
The scan type information comprises ion
polarity, source type, fragmentation type and
energy (if active), and scan range. When the
acquisition is controlled by an instrument
method, the information includes the current
scan segment and the current scan event.

❖

To display this window

Choose Windows > Spectrum.
Toolbar
Use the buttons in the toolbar to manipulate the spectrum display.
The toolbar of the spectrum window has the following parameters:
Parameter

Description

Click to copy the current spectrum into the clipboard.
Click to plot the current spectrum.
You can view a print preview before the spectrum is
printed. In a Page Setup dialog box, you can set up
printer’s parameters (paper size and orientation, for
example).
Click to zoom in on the Y-axis (factor 2).
Click to zoom out on the Y-axis (factor 2).
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Parameter

Description

Click to normalize the Y scale: Exactive Plus Tune always
displays the largest peak in the spectrum at full scale
(vertical scale = largest peak in spectrum).
Click to zoom in on the X-axis (factor 2).
Click to zoom out on the X-axis (factor 2).
Click to display the entire mass range.
Click to normalize the display (X-axis, Y-axis).
Click to set to fixed mode: the height of the Y-axis is set
equal to the height of the largest peak in the current
spectrum and remains fixed even if larger peaks occur.
Click to set the Y-axis to the height of the highest peak so
that the largest peak in the spectrum is always displayed
at full scale.
Click to set to creep mode: the Y scale of the mass
spectrum automatically increases if the peak intensity
increases, but does not decrease if the peak intensity
decreases.
Click to toggle between mouse panning and mouse
zooming:
• When mouse panning is active, you can shift the
spectrum along the X-axis while keeping the left
mouse button pressed (hand cursor).
• When mouse zooming is active, you can zoom in the
spectrum by using the mouse.
Shortcut Menu
Right-clicking on the spectrum window displays the shortcut menu. It
has the following commands:
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Command

Description

Save Image As

Saves the current graph as image file. A Save As
dialog opens and you can enter the file name,
file type, and the directory.

Un-Zoom

Reverts the zoom action.

Display options

Opens the Display Options dialog box.
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Instrument Status Window
The instrument status window displays real-time status information for
the instrument components. All parameters are arranged in a tree view.
See Figure 4-46. The Control node is not available for standard users.

Figure 4-46. Instrument status window
In addition to showing numerical values of parameters, the instrument
status window uses icons to indicate the statuses of system components.
Thus, you can use the instrument status window for a quick error
diagnosis.
When expanded, some nodes provide shortcut menus that are displayed
when you right-click an item. The available commands depend on the
selected node and the user privileges. Generally, the shortcut menus
allow changing the current settings.
NOTICE For normal operation, it is not necessary to change the settings
in the instrument status window. It just allows monitoring the system in
more detail (more readbacks etc.) than the other windows. ▲
❖

To display this window

Choose Windows > Instrument Status.
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Messages Window
The messages window displays real-time information about the statuses
of the instrument, the control service, or other programs. See
Figure 4-47.

Figure 4-47. Messages window
For further analysis, you can copy the content of the messages window
to a text editor.
❖

To copy content from the messages window to a text editor

1. Select part of the content with the mouse, or
press <Ctrl> + <A> to select the complete content of the messages
window.
2. Press <Ctrl> + <C> to copy the text to the clipboard.
3. Open a document in the text editor.
4. Press <Ctrl> + <V> to insert the copied text into the document.
The messages window has the following parameters:
Parameter

Description

The messages are sorted with respect to time. To change the sort order,
click the respective table column header. To invert the sort order, click
again.
Priority

The message priority is indicated by symbols:
Info; status is normal / command successful
Warning; no user action required
Error; user action required
Fatal error; program cannot proceed

Source

The message source is indicated by symbols:
Message from Exactive Plus Tune program
Message from instrument
Message from service
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Parameter

Description

Time

Time and date of the message

Description Displays the message text.
❖

To display this window

Choose Windows > Messages.

Analysis Graphs Window
The analysis graphs window displays real-time data generated during
calibration, tuning, and diagnostic tests. See Figure 4-48. To save data
displayed in the window, choose Save Image As in the shortcut menu of
the window.

Figure 4-48. Analysis Graphs window
The analysis graphs window allows using the mouse for zooming.
❖
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To zoom in or out on an analysis graph

•

Click and drag with the left mouse button (hand cursor) from
the beginning to the end of the portion you want to see
enlarged.

•

Alternatively, use the mouse wheel for zooming. Position the
mouse pointer within the graph and roll the wheel forward to
zoom in on the graph area.

•

To zoom in on the graph with respect to one axis only, position
the mouse pointer within the axis area and roll the mouse wheel
forward. Roll the wheel backward to zoom out.

•

To increase the zooming factor by two, keep the <Shift> key
pressed while using the mouse wheel.
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To return to a display of the full spectrum, click the
the toolbar or choose Un-Zoom in the shortcut menu.

button in

Press the <Shift> key to enable mouse panning. When mouse panning
is active (mouse pointer changes to hand cursor), you can shift the graph
along both axes while keeping the left mouse button pressed.
❖

To display this window

Choose Windows > Analysis Graphs.
Toolbar
The toolbar of the analysis graphs window has the following parameters:
Parameter

Description

Click to copy the current graph into the clipboard.
Click to plot the current graph.
You can view a print preview before the graph is printed.
In a Page Setup dialog box, you can set up printer’s
parameters (paper size and orientation, for example).
Click to normalize the display (X-axis, Y-axis).

Shortcut Menu
Right-clicking on the analysis graphs window displays the shortcut
menu. It has the following commands:
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Command

Description

Save Image As

Saves the current graph as image file. A Save As
dialog opens and you can enter the file name,
file type, and the directory.

Un-Zoom

Reverts the zoom action.
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Debug Messages Window
The debug messages window displays messages that can be used during
method development. See Figure 4-49. The debug messages window is
not available for standard users.

Figure 4-49. Debug Messages window
For further analysis, you can copy the content of the debug messages
window to a text editor.
❖

To copy content from the debug messages window to a text editor

1. Select part of the content with the mouse, or
press <Ctrl> + <A> to select the complete content of the messages
window.
2. Press <Ctrl> + <C> to copy the text to the clipboard.
3. Open a document in the text editor.
4. Press <Ctrl> + <V> to insert the copied text into the document.
The debug messages window has the following parameters:
Parameter

Description

The messages are sorted with respect to time. To change the sort order,
click the respective table column header. To invert the sort order, click
again.
Priority

The message priority is indicated by symbols:
Debugging message
Info; status is normal / command successful
Warning; no user action required
Error; user action required
Fatal error; program cannot proceed
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Parameter

Description

Source

The message source is indicated by symbols:
Message from Exactive Plus Tune program.
Message from instrument.
Message from service.

Time

Time and date of the message

Description Displays the message text.
❖

To display this window

Choose Windows > Debug Messages.
Shortcut Menu of the Debug Messages Window
The debug messages window has a shortcut menu that is displayed when
you right-click into the window. Use the commands of the shortcut
menu to configure the scope of the messages displayed in the window.
Click a command to activate it; click it again to deactivate it.
The following message priorities can be displayed:
•

Debug

•

Log

•

Info

•

Warning

•

Error

•

Fatal

For each message priority, the following message sources are available:
•

Instrument

•

Service

•

Application

A
icon in front of a message source shows that it is selected. A
icon in front of a message priority shows that it is shown for all three
message sources. A
icon in front of a message priority shows that it
is shown for one or two message sources.
In addition to the commands for configuring the content of the debug
messages window, the Clear list command allows removing the
complete content of the window.
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Dialog Boxes
This section provides a reference to the dialog boxes in Exactive Plus
Tune.

Dialog Boxes Displayed from the Menu Bar
•

About Dialog Box

•

License Dialog Box

Dialog Boxes Displayed from the Toolbar
•

Syringe Pump Settings Dialog Box

Dialog Boxes Displayed from the Scan Parameters Window
•

Fragmentation Dialog Box

•

Scan Parameters History Dialog Box

•

Scan Range Dialog Box

Dialog Boxes for Editing Lock Masses
•

Collection Modification Dialog Box

•

Delete Lock Mass Collection Dialog Box

•

Lock Masses Dialog Box

•

Lock Mass Removal Dialog Box

•

Lock Mass Replacement Dialog Box

•

Name Change Dialog Box

•

New Lock Mass Collection Dialog Box

Dialog Boxes Displayed from the Spectrum Window
•

Thermo Fisher Scientific

Display Options Dialog Box
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About Dialog Box
Use the About dialog box to display information about the instrument,
the current Exactive Plus Tune version, and the active licenses. See
Figure 4-50. To copy the instrument identification to the clipboard,
click the
button.

Figure 4-50. About dialog box
The About dialog box has the following parameters:
Parameter

Description

Third party license
information

Displays a dialog box with information about
third party licenses used by Exactive Plus Tune.

Buttons

OK

Saves your changes and closes the dialog box.

Add license

Displays the License dialog box.

Help

Displays the Help for this dialog box.

❖

To display this dialog box

Choose Help > About.
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License Dialog Box
Use the License dialog box to enter licenses that activate additional
features. See Figure 4-51.

Figure 4-51. License dialog box
The License dialog box has the following parameters:
Parameter

Description

License key

Use the text box to enter the license key.

Buttons

OK

Saves your changes and closes the dialog box.

Cancel

Discards your changes and closes the dialog box.

Help

Displays the Help for this dialog box.

❖

To display this dialog box

1. Choose Help > About to display the About dialog box.
2. In the About dialog box, click Add license.
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Syringe Pump Settings Dialog Box
Use the Syringe Pump Settings dialog box to specify parameters of the
syringe and the syringe pump. See Figure 4-52. Additionally, use the
dialog box to manually operate the syringe pump.

Figure 4-52. Syringe Pump Settings dialog box
NOTICE With exception of standard users, users can select the syringe
pump type and enter parameters for the syringe pump in the instrument
status window. ▲
The Syringe Pump Settings dialog box has the following parameters:
Parameter

Description

Syringe type

Use this list box to specify the syringe type (Hamilton, Unimetrics, or
Other). If you select Hamilton or Unimetrics, you must specify the volume
of the syringe in the Volume list box. If you select Other, you must specify
the inside diameter of the syringe in the Syringe inner diameter spin box.

Volume (μL)

Use this list box to specify the syringe volume for Hamilton and Unimetrics
syringes. The acceptable values depend on the syringe type:
•
•

Syringe inner diameter (mm)

Hamilton:
0.5, 1, 2, 5, 10, 25, 50, 100, 250, and 500 μL.
Unimetrics:
10, 25, 50, 100, 250, 500, 1000, 2500, 5000, 10000, 25000, and
50000 μL.

Use this spin box to specify the inside diameter for syringes other than
Hamilton and Unimetrics syringes. The acceptable range of values is 0.1 to
35 mm.
To change this value, click the arrows in the spin box to increment [up
arrow] or decrement [down arrow] the value. Alternatively, enter a value in
the spin box text field.
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Parameter

Description

Flow rate (μL/min)

Use this spin box to specify the volume of solvent solution passing through
the syringe pump per unit time (in microliters per minute). The acceptable
range of values depends on the selected syringe volume or syringe inner
diameter.
To change this value, click the arrows in the spin box to increment [up
arrow] or decrement [down arrow] the value. Alternatively, enter a value in
the spin box text field.

Buttons

Apply

Sends all changes to the instrument.

Help

Displays the Help for this window.

Manual Control

Sets the syringe pump to manual control. Use the buttons on the syringe
pump to switch it on and off. When the syringe pump is under manual
control, Exactive Plus Tune displays

Start

Switches on the syringe pump. When the syringe pump is On, Exactive Plus
Tune displays

Stop

.

.

Switches off the syringe pump. When the syringe pump is Off, Exactive
Plus Tune displays
❖

.

To display this dialog box

In the toolbar, right-click the

symbol.

Scan Parameters History Dialog Box
Use the Scan Parameters History dialog box to select from a list of recent
scans based on short scan descriptions. See Figure 4-53. Select a scan
from the list to populate all scan parameters in the Scan Parameters
window with the parameters from that scan.
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If the Hot link check box is selected in the Scan Parameters window,
selecting another list item immediately changes the instrument
parameters.

Figure 4-53. Scan Parameters History dialog box
❖

To display this dialog box

In the Scan Parameters window, click the History field.

Scan Range Dialog Box
Use the Scan range dialog box to specify the scan range of the data
acquisition. See Figure 4-54. The scan range affects the amount of
stored and transmitted data.

Figure 4-54. Scan range dialog box
The Scan Range dialog box allows setting either minimum and
maximum or center and width of the scan range. If you change one pair
of values, the other pair is changed accordingly.
NOTICE The ratio for maximum-to-minimum should not exceed 15. If
necessary, Exactive Plus Tune will correct the settings automatically. ▲
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The Scan range dialog box has the following parameters:
Parameter

Description

Minimum

Use this spin box to select the minimum value for the
scan range (in mass-to-charge ratio units) used during
the currently selected scan event.
To change the value, click the arrows in the spin box
to increment [up arrow] or decrement [down arrow]
the value. You can enter any value from 50.0 to
2500.0. The default value is 150.

Maximum

Use this spin box to select the maximum value for the
scan range (in mass-to-charge ratio units) used during
the currently selected scan event.
To change the value, click the arrows in the spin box
to increment [up arrow] or decrement [down arrow]
the value. You can enter any value from 50.4 to
6000.0. The default value is 2000.

Center

Use this spin box to select the center mass (in
mass-to-charge ratio units) of the scan range.
To change the value, click the arrows in the spin box
to increment [up arrow] or decrement [down arrow]
the value. You can enter any value from 50.2 to
4250.0. The default value is 1075.

Width

Use this spin box to select the width of the scan range
(in mass-to-charge ratio units) used during the
currently selected scan event.
To change the value, click the arrows in the spin box
to increment [up arrow] or decrement [down arrow]
the value. You can enter any value from 0.4 to
5600.0. The default value is 1850.0.

❖

To display this dialog box

In the Scan Parameters window, click the Scan range field.
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Fragmentation Dialog Box
Use the Fragmentation dialog box to activate a fragmentation with
in-source CID or the HCD collision cell. You can specify the
fragmentation voltages to be used. See Figure 4-55.

Figure 4-55. Tune—Fragmentation dialog box
The Fragmentation dialog box has the following parameters:
Parameter

Description

In-source CID

Activates the in-source CID.
To change the CID collision energy, click the arrows in the spin box to increment [up
arrow] or decrement [down arrow] the value. You can set the CID collision energy to any
value from 0.1 to 100 eV. Default is 25.0 eV.
NOTICE Automatic tuning is disabled when in-source CID fragmentation is on. To use
automatic tuning, clear this check box. ▲

NCE

Activates the HCD collision cell.
Use the list box to set the normalized collision energy (NCE). This dimensionless number
is approximately equivalent to the HCD collision energy (in eV) for a reference ion of
mass 500 and charge 1. The actual HCD energy is calculated on basis of mass and charge
of the selected precursor ion.
To change the NCE value, click the arrows in the spin box to increment [up arrow] or
decrement [down arrow] the value. You can set NCE to any value from 10 to 200. Default
is 35.
NOTICE When HCD fragmentation is on, automatic tuning comprises only
HCD relevant parameters. ▲

Charge

Enter the charge state of the ion to be fragmented. The required collision energy for
fragmenting an ion depends on its charge state. The higher the charge state, the lower the
required collision energy. The algorithm for calculating the absolute collision energy is
based on empirical data taken from measurements on peptides. For example, the required
absolute collision energy to fragment a [M+2H]2+ ion is about 90 percent of that of the
corresponding [M+H]+ ion. For a [M+3H]3+ ion the value decreases to 85 percent.
The spin box is active only if NCE is selected as the activation type. The available range is
1 to 5.
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❖

To display this dialog box

In the Scan Parameters window, click into the Fragmentation field.
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Collection Modification Dialog Box
Use this dialog box to modify a lock mass collection by importing lock
masses from an xml file See Figure 4-58. This dialog box appears only
when the xml file contains information about lock mass collections that
differs from the available lock mass collections.

Figure 4-56. Collection Modification dialog box
The Collection Modification dialog box has the following parameters:
Parameter

Description

OK

Saves your changes and closes the dialog box. The lock
mass collection is updated with the data contained in the
xml file.

Cancel

Discards your changes and closes the dialog box.

Help

Displays the Help for this dialog box.

❖

To display this dialog box

1. Choose Import > Merge with file content in the shortcut menu of
the Lock Masses dialog box.
2. In the file selection dialog box, select an xml file to import from.
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Lock Masses Dialog Box
Use the Lock Masses dialog box to edit lock mass lists. See Figure 4-57.
The table shows all available lock masses. Lock mass collections store
information about lock mass usage.

Figure 4-57. Tune—Lock Masses dialog box
The Lock Masses dialog box has the following parameters:
Parameter

Description

Lock mass lists

Lock mass lists

Use the list box to select an existing lock mass collection.
Displays the New Lock Mass Collection dialog box where you can enter the name for a
new lock mass collection.
Deletes the active lock mass collection. The lock masses themselves are still available.
This button is not available when no lock mass collection is selected.
Displays the Name Change dialog box where you can edit the name of the active lock
mass collection.
This button is not available when no lock mass collection is selected.

Available lock masses

The table displays the properties of the available lock masses and whether they are used in the selected lock
mass collection. To change the sort order, click the respective table column header. To invert the sort order,
click again.
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Parameter

Description

Lock mass table

•

•

Use
Select the check box to use the lock mass. A indicates that the lock mass is used in
the active lock mass collection. The lock mass is displayed in the Lock masses field of
the Scan Parameters window.
Polarity
Click the symbol to change the polarity of the lock mass.

NOTICE During a scan, the Exactive Plus mass spectrometer uses only the lock masses
with a polarity that matches the active ion mode. ▲
•
•

m/z
Enter the mass of the lock mass into the field (with a maximum of five decimals).
Comment
Enter a comment for the lock mass into the field. This field is optional.

Creates a new lock mass.
Deletes the selected lock masses.

❖

To display this dialog box

In the Scan Parameters window, click into the Lock Masses field.
Shortcut Menu of the Lock Masses dialog box
The Lock Masses dialog box has a shortcut menu that is displayed when
you right-click into the dialog box.
It has the following commands:
Command

Description

Select all masses in use

Selects all masses used in the active lock mass collection.
This command is not available when no lock mass is used.

Import > Merge with clipboard

Appends the content of the clipboard to the available lock masses.
NOTICE The clipboard stores lock mass data as tabulator-separated text
files. When the data in the clipboard are not in this format, the
command is not available. ▲

Import > Replace by clipboard

Replaces the available lock masses by the content of the clipboard.
NOTICE The clipboard stores lock mass data as tabulator-separated text
files. When the data in the clipboard are not in this format, the
command is not available. ▲
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Command

Description

Import > Merge with file content

Opens a dialog box so that you can select a csv, txt, or xml file that
contains a list of lock masses. The content of the file is appended to the
available lock masses.
See Exporting and Importing Lock Masses for information about the
format of lock mass files.

Import > Replace by file content

Opens a dialog box so that you can select a csv, txt, or xml file that
contains a list of lock masses. All available lock masses are replaced by
the masses contained in the imported file. The present lock masses are
removed from all existing lock mass lists. You have to confirm your
action in the Lock mass replacement dialog box.
See Exporting and Importing Lock Masses for information about the
format of lock mass files.

Export > Copy selected to clipboard Copies the data of the selected lock mass to the clipboard.
Export > Copy all to clipboard

Copies the data of all available lock masses to the clipboard.

Export > Copy selected to file

Opens the dialog box, where you can save the data of the selected lock
mass(es) as a csv, txt, or xml file.
See Exporting and Importing Lock Masses for information about the
format of lock mass files.

Export > Copy all to file

Opens the dialog box, where you can save the data of all available lock
masses as a csv, txt, or xml file.
See Exporting and Importing Lock Masses for information about the
format of lock mass files.

Lock Mass Removal Dialog Box
Use this dialog box to delete one or more lock masses that are selected in
the Lock Masses dialog box. See Figure 4-58.

Figure 4-58. Lock Mass Removal dialog box
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The Lock Mass Removal dialog box has the following parameters:
Parameter

Description

OK

Saves your changes and closes the dialog box. The lock
masses are now removed from the table in the Lock
Masses dialog box.

Cancel

Discards your changes and closes the dialog box.

Help

Displays the Help for this dialog box.

❖

To display this dialog box

In the Lock Masses dialog box, click the

button.

Lock Mass Replacement Dialog Box
Use this dialog box to replace all available lock masses by masses
contained either in a csv, txt, or xml file or in the clipboard. See
Figure 4-58.

Figure 4-59. Lock Mass Replacement dialog box
The Lock Mass Replacement dialog box has the following parameters:
Parameter

Description

OK

Removes the lock masses and replaces them by the
imported lock masses. The present lock mass collections
become void.

Cancel

Closes the dialog box.

Help

Displays the Help for this dialog box.

❖

To display this dialog box

Choose Import > Replace by file content or Import > Replace by
clipboard in the shortcut menu of the Lock Masses dialog box.
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New Lock Mass Collection Dialog Box
Use this dialog box to enter a name for the lock mass collection that is
displayed in the Lock Masses dialog box. See Figure 4-60.

Figure 4-60. New Lock Mass Collection dialog box
The New Lock Mass Collection dialog box has the following
parameters:
Parameter

Description

Name of lock mass Use this text field to enter the name for the new
collection
lock mass collection.
Buttons

OK

Saves your changes and closes the dialog box.
The name of the lock mass collection is now
displayed in the list box of the Lock Masses
dialog box.

Cancel

Discards your changes and closes the dialog box.

Help

Displays the Help for this dialog box.

❖

To display this dialog box

In the Lock Masses dialog box, click the
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Delete Lock Mass Collection Dialog Box
Use this dialog box to delete an existing lock mass collection. See
Figure 4-61. The lock masses themselves are not deleted.

Figure 4-61. Delete Lock Mass Collection dialog box
The Delete Lock Mass Collection dialog box has the following
parameters:
Parameter

Description

OK

Saves your changes and closes the dialog box. The name
of the lock mass collection is now removed from the list
box of the Lock Masses dialog box.

Cancel

Discards your changes and closes the dialog box.

Help

Displays the Help for this dialog box.

❖

To display this dialog box

In the Lock Masses dialog box, click the

button.

Name Change Dialog Box
Use this dialog box to change the name of an existing lock mass
collection. See Figure 4-62.

Figure 4-62. Name Change Dialog Box
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The Name Change dialog box has the following parameters:
Parameter

Description

Name of lock mass Use this text field to enter the new name for the
collection
lock mass collection.
Buttons

OK

Saves your changes and closes the dialog box.
The name of the lock mass collection is now
displayed in the list box of the Lock Masses
dialog box.

Cancel

Discards your changes and closes the dialog box.

Help

Displays the Help for this dialog box.

❖

To display this dialog box

In the Lock Masses dialog box, click the
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button.
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Display Options Dialog Box
Use this dialog box to modify the appearance of the displayed mass
spectrum in the spectrum window. See Figure 4-63.

Figure 4-63. Display Options Dialog Box
The Display Options dialog box has the following parameters:
Parameter

Description

Decimal places for m/z Use this list box to set how many decimal
places of precision are shown when mass
positions are annotated on mass spectra. The
valid range is 0 to 5.
Show resolution

Select this check box to have Exactive Plus
Tune annotate mass peaks with the mass
resolution.

Show charge state

Select this check box to have Exactive Plus
Tune annotate mass peaks with the charge
state.

Show flags

Select this check box to have Exactive Plus
Tune indicate peaks that are contained in the
active lock mass collection.
NOTICE The scan parameters window must
show entries for lock masses. ▲

Buttons

OK

Saves your changes and closes the dialog box.

Help

Displays the Help for this dialog box.

❖

To display this dialog box

In the shortcut menu of the spectrum window, choose Display
options.
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Procedures in Exactive Plus Tune
This chapter describes procedures that you may need when using
Exactive Plus Tune.
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Thermo Fisher Scientific

•

Using Lock Masses and Lock Mass Collections

•

Performing a System Bakeout

•

Changing Default Settings of Exactive Plus Tune

Exactive Plus Software Manual (P/N 1323070, Revision A)

5-1

Procedures in Exactive Plus Tune
Using Lock Masses and Lock Mass Collections

Using Lock Masses and Lock Mass Collections
This section provides instructions for using lock masses and lock mass
collections.
The following topics are available:
•

Adding a Lock Mass

•

Deleting Lock Masses

•

Exporting and Importing Lock Masses

•

Creating a new Lock Mass Collection

•

Renaming a Lock Mass Collection

•

Adding a Lock Mass to a Lock Mass Collection

•

Removing a Lock Mass from a Lock Mass Collection

•

Deleting a Lock Mass Collection

❖

To add a lock mass

Adding a Lock Mass

1. In the Lock Masses dialog box, click the
button. A new row
appears at the end of the lock mass table. See Figure 5-1.

Figure 5-1.

Adding a new lock mass

2. Enter the data for the new lock mass into the new table row:
a. Select the Use check box if you want to use the new lock mass in
the active lock mass collection.
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b. Click the cell in the Polarity column until the correct sign
appears:
for positive or
for negative.
c. Enter the m/z value for the new lock mass (with a maximum of
five decimals).
d. Optionally, enter a comment for the new lock mass.
The new lock mass is now available to be used.

Deleting Lock Masses
❖

To delete lock masses

1. In the Lock Masses dialog box, select one lock mass or several lock
masses:
•

To select a single lock mass, click into the respective table row.

•

To select adjacent lock masses, click the first table row. Then
hold down the <Shift> key while you click the last row.

•

To select nonadjacent lock masses, click the first table row. Then
hold down the <Ctrl> key while you click the other rows that
you want to add to the selection.

2. Click the
button. The Lock Mass Removal dialog box appears
and requests your confirmation for deleting the listed lock masses.
3. Click OK to confirm your input and to close the dialog box. All
selected lock masses are removed from the list in the Lock Masses
dialog box.

Exporting and Importing Lock Masses
Exactive Plus Tune allows exporting lock mass data to the clipboard or
to a file. Other applications can then use the data. You can also copy the
export files to other computers where Exactive Plus Tune is installed. So
you can reuse the lock masses without having to recreate them. To reuse
the lock masses, import the data either from the clipboard or from a lock
mass file.
With a spreadsheet, a text editor, or an XML editor, you can create lock
mass files even without using Exactive Plus Tune.
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Lock Mass Files
Exactive Plus Tune uses the following file formats for exporting and
importing lock mass data:
•

Comma-separated value lists (.csv)

•

Tabulator-separated text files (.txt)

•

XML files (.xml)

Lock mass data are stored in the following order:
1. Usage status: True for used, False for unused
2. Ion polarity: positive mode or negative mode
3. m/z: up to five decimals
4. Comment: optional
The clipboard stores lock mass data as tabulator-separated text files. In
contrast to csv and txt files, xml files additionally store information
about lock mass collections and lock mass usage.
Exporting Lock Masses
Exactive Plus Tune allows exporting lock mass data to the clipboard or
to a file.
❖

To export selected lock masses to the clipboard

1. In the Lock Masses dialog box, select the lock masses you want to
export:
•

To select a single lock mass, click into the respective table row.

•

To select adjacent lock masses, click the first table row. Then
hold down the <Shift> key while you click the last row.

•

To select nonadjacent lock masses, click the first table row. Then
hold down the <Ctrl> key while you click the other rows that
you want to add to the selection.

2. Right-click into the dialog box to display the shortcut menu.
3. Choose Export > Copy selected to clipboard to copy the selected
lock mass to the clipboard.
❖

To export all lock masses to the clipboard

1. In the Lock Masses dialog box, right-click into the dialog box to
display the shortcut menu.
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2. Choose Export > Copy all to clipboard to copy all available lock
mass to the clipboard.
❖

To export some lock masses to a file

1. In the Lock Masses dialog box, select the lock masses you want to
export:
•

To select a single lock mass, click into the respective table row.

•

To select adjacent lock masses, click the first table row. Then
hold down the <Shift> key while you click the last row.

•

To select nonadjacent lock masses, click the first table row. Then
hold down the <Ctrl> key while you click the other rows that
you want to add to the selection.

2. Right-click into the dialog box to display the shortcut menu.
3. Choose Export > Copy selected to file to open the file selection
dialog box. See Figure 5-2.

Figure 5-2.

Selecting the lock mass export file

a. Browse to the destination of the export file.
b. Select the format of the export file.
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c. Enter a new name for the export file or select an existing file.
d. Click Save to export the selected lock masses to the file. If you
want to overwrite an existing file, you have to confirm your
action in a dialog box. The file selection dialog box is closed.
❖

To export all lock masses to a file

1. In the Lock Masses dialog box, right-click into the dialog box to
display the shortcut menu.
2. Choose Export > Copy all to file to open the file selection dialog
box. See Figure 5-3.

Figure 5-3.

Selecting the lock mass export file

a. Browse to the destination of the export file.
b. Select the format of the export file.
c. Enter a new name for the export file or select an existing file.
d. Click Save to export the lock masses to the file. If you want to
overwrite an existing file, you have to confirm your action in a
dialog box. The file selection dialog box is closed.
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Importing Lock Masses
Exactive Plus Tune allows importing lock mass data from the clipboard
or from a file. The imported lock masses either are added to the present
lock masses or they replace them.
❖

To add lock masses from the clipboard

1. Copy lock mass data in an appropriate format to the clipboard. See
Lock Mass Files for information about the requirements.
2. In the Lock Masses dialog box, right-click into the dialog box to
display the shortcut menu.
3. Choose Import > Merge with clipboard to import the lock mass
data from the clipboard to the lock mass table.
Note The clipboard stores lock mass data as tabulator-separated text
files. When the data in the clipboard are not in this format, the
command is not available. ▲
4. The lock mass list in the Lock Masses dialog box displays additional
rows for the imported lock masses.
❖

To add lock masses from a file

1. In the Lock Masses dialog box, right-click into the dialog box to
display the shortcut menu.
2. Choose Import > Merge with file content to open the file selection
dialog box. See Figure 5-4.
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Figure 5-4.

Selecting the lock mass import file

a. Browse to the destination of the import file.
b. Select the format of the import file.
c. Select one of the displayed files.
d. Click Open to import the lock masses to Exactive Plus Tune.
The dialog box is closed.
3. If you are importing an xml file that contains information about
lock mass collections that differs from the present lock mass
collections, the Collection modification dialog is displayed. Click
OK to confirm the operation and to close the dialog box.
4. The lock mass list in the Lock Masses dialog box displays additional
rows for the imported lock masses.
❖

To replace all lock masses by clipboard data

1. Copy lock mass data in an appropriate format to the clipboard. See
Lock Mass Files for information about the requirements.
2. In the Lock Masses dialog box, right-click into the dialog box to
display the shortcut menu.
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3. Choose Import > Replace by clipboard to import the lock mass
data from the clipboard to the lock mass table.
Note The clipboard stores lock mass data as tabulator-separated text
files. When the data in the clipboard are not in this format, the
command is not available. ▲
4. The Lock Mass Replacement dialog box is displayed. Click OK to
confirm the import.
5. The Lock Mass Replacement dialog box is closed. The lock mass list
in the Lock Masses dialog box displays only the imported lock
masses.
❖

To replace all lock masses from a file

1. In the Lock Masses dialog box, right-click into the dialog box to
display the shortcut menu.
2. Choose Import > Replace by file content.
3. The Lock Mass Replacement dialog box is displayed. Click OK to
confirm the import.
4. The Lock Mass Replacement dialog box is closed. The file selection
dialog box is displayed. See Figure 5-5.
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Figure 5-5.

Selecting the lock mass import file

a. Browse to the destination of the import file.
b. Select the format of the import file.
c. Select one of the displayed files.
d. Click Open to import the lock masses to Exactive Plus Tune.
The dialog box is closed.
5. The lock mass list in the Lock Masses dialog box displays only the
imported lock masses.
If you have imported lock mass data from an xml file that contained
information about lock mass collections and lock mass usage, the
dialog box displays the corresponding information.

Creating a new Lock Mass Collection
❖

To create a lock mass collection

1. In the Lock Masses dialog box, click the
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2. In the New Lock Mass Collection dialog box, enter a name for the
new lock mass collection. See Figure 5-6.

Figure 5-6.

Creating a lock mass collection

3. Click OK to confirm your input and to close the dialog box.
4. The name of the new lock mass collection appears in the list box of
the Lock Masses dialog box.

Renaming a Lock Mass Collection
❖

To rename a lock mass collection

1. In the Lock Masses dialog box, select an existing lock mass
collection in the list box.
2. Click the
button. The Name Change dialog box is displayed.
See Figure 5-7.

Figure 5-7.

Changing the name of a lock mass collection

3. In the text field, replace the old name of the lock mass collection
with the new name.
4. Click OK to confirm your input and to close the dialog box.
5. In the Lock Masses dialog box, the new lock mass collection is
displayed in the list box.
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Adding a Lock Mass to a Lock Mass Collection
❖

To add a lock mass to a lock mass collection

1. In the Lock Masses dialog box, select an existing lock mass
collection in the list box.
2. Select the Use check box in the table row of the lock mass.
3. A indicates that the lock mass is used in the active lock mass
collection.

Removing a Lock Mass from a Lock Mass Collection
❖

To remove a lock mass from a lock mass collection

1. In the Lock Masses dialog box, select an existing lock mass
collection in the list box.
2. Clear the Use check box in the table row of the lock mass.
3. A indicates that the lock mass is not used in the active lock mass
collection.

Deleting a Lock Mass Collection
❖

To delete a lock mass collection

1. In the Lock Masses dialog box, select an existing lock mass
collection in the list box.
1. Click the

button.

2. In the Delete Lock Mass Collection dialog box, click OK to confirm
your action and to close the dialog box.
3. The name of the lock mass collection is removed from the list box of
the Lock Masses dialog box.
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Performing a System Bakeout
The system bakeout of the mass spectrometer removes unwanted gases
or molecules (collected or remaining) from the high vacuum region of
the instrument. Ions can collide with those gases or molecules resulting
in lower overall sensitivity. Therefore, Thermo Fisher Scientific
recommends baking out the instrument if the high vacuum decreases
noticeable during routine operation.
Bakeout is mandatory after maintenance or service work is performed in
the analyzer region where the system is vented. You should bake out an
instrument that has been vented for at least twelve hours (12 hours)
before you can start using it again.
In case the system has been vented during a power failure, it is necessary
to bake out the system to obtain the operating vacuum.
Note Before you start the bakeout, ensure that the pumps are up and
running at their operating speed. If you have just switched on the mass
spectrometer, this will take about 10 minutes. To check the pump speed,
open the Instruments Status window and expand the Vacuum System
node of the Instrument tree. ▲
❖

To perform a system bakeout

1. In the Exactive Plus Tune window, click on the On/Standby button
to put the instrument in Off condition. (See image in margin.)
2. In the Tasks panel, click
display the Vacuum / Bakeout window.

to

3. Enter the desired baking duration (in hours) into the spin box. The
range is 4 to 100 hours. See Figure 5-8.

Figure 5-8.
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Vacuum / Bakeout window

Exactive Plus Software Manual (P/N 1323070, Revision A)

5-13

Procedures in Exactive Plus Tune
Performing a System Bakeout

4. Click Bake out. A dialog box shows the duration of the baking
procedure. See Figure 5-9. Click Yes to confirm the message.

Figure 5-9.

Bakeout message box
5. The message box disappears and the baking procedure starts. The
instrument indicates the active bakeout procedure by a flashing
Vacuum LED at the front side. Additionally, the Exactive Plus Tune
software displays a corresponding message box. See Figure 5-10.

Figure 5-10. Message box: Vacuum Bakeout active
6. The baking of the instrument stops after the preset duration. The
Vacuum LED keeps flashing until the cooling and stabilization time
(of about 3 hours) is finished.
Click Stop in the Vacuum / Bakeout window to abort the baking
routine before the preset time.
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Changing Default Settings of Exactive Plus Tune
With exception of standard users, users can use the instrument status
window to change default settings of Exactive Plus Tune.
The following topics are available:
•

Displaying the High Vacuum Readback

•

Entering Parameters for the Syringe Pump

•

Changing the Settings for the Performance Status Check

Displaying the High Vacuum Readback
The High Vacuum readback in the Vacuum / Bakeout window is visible
only when the ion gauge in the high vacuum chamber is switched on.
With exception of standard users, users can switch on this gauge
manually.
❖

To switch on the High Vacuum readback in the Vacuum / Bakeout
window

1. Click

in the tasks

panel to display the Vacuum / Bakeout window.
2. If the instrument status window is not visible, choose Windows >
Instrument Status.
3. In the instrument status window, click Instrument > Vacuum
System.
4. Right-click the High Vacuum parameter to display the shortcut
menu.
5. Choose Turn on to switch on the ion gauge in the high vacuum
chamber.
6. The Vacuum / Bakeout window now displays the High Vacuum
readback.
To extend the lifetime of the ion gauge in the high vacuum chamber, it
is switched off again after a preset time of about thirty minutes.

Entering Parameters for the Syringe Pump
The syringe contact of the Exactive Plus mass spectrometer allows
controlling established syringe pumps by Exactive Plus Tune by means
of the RS-232 serial interface. A suitable syringe pump is the Chemyx
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Fusion 100 pump (available from Thermo Fisher Scientific). Advanced
users can select the syringe pump type and enter parameters for the
syringe pump in the instrument status window
❖

To enter parameters for the syringe pump

1. If the instrument status window is not visible, choose Windows >
Instrument Status.
2. In the instrument status window, click Instrument > System >
Configuration settings > Peripherals. The Peripherals node
displays parameters for the syringe pump. See Figure 5-11.

Figure 5-11. Instrument status window—Peripherals node
3. To change the settings for a parameter, right-click the parameter
entry to display the shortcut menu. If necessary, change the values of
the following parameters:
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•

Syringe Pump Controller Type: In the list box, select either Type
Harvard (for Harvard Apparatus Model 11 Plus Advanced
pump) or Type Chemyx (for Chemyx Fusion 100 pump).

•

Syringe Type Harvard Serial Com Speed: Enter the baud rate for
the interface into the input field. Available options are 1200,
2400, 4800, 9600, and 19200 bauds. Press the <Enter> key to
confirm your input.
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•

Syringe Type Chemyx Serial Com Speed: Enter the baud rate for
the interface into the input field. Available options are 1200,
2400, 4800, 9600, and 19200 bauds. Press the <Enter> key to
confirm your input.

See the manual that came with the syringe pump for the correct
baud rate.

Changing the Settings for the Performance Status Check
By default, the performance status icon on the toolbar turns yellow
25 hours after the last successful mass calibration or check. With
exception of standard users, users can change this value in the System
node of the instrument status window according to their mass accuracy
requirements.
❖

To change the settings for the performance status check

1. If the instrument status window is not visible, choose Windows >
Instrument Status.
2. In the instrument status window, click Instrument > System >
Configuration settings > Performance Check. The Mass
calibration due time (h) field displays the current validity period of
the mass calibration (25 hours, for example). See Figure 5-12.

Figure 5-12. Instrument status window—Performance Check node
3. To change the value, right-click the number in the text field to
display the shortcut menu.
4. In the Set text field, enter the new validity period (40, for example).
See Figure 5-13. You can enter a value between 1 and 500 hours.
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Figure 5-13. Changing the calibration validity period
5. Press the <Enter> key to confirm your input. The shortcut menu
disappears and the new value is displayed in the instrument status
window.
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Log Files
Log files (*.log) are created for a Exactive Plus mass spectrometer. The
default directory for the log files is C:\Xcalibur\system\Exactive\log.
The Instrument Configuration window shows the actual path.
Additional log files are created every time the Exactive window service
starts. The file name shows date and time of the service start, as shown
in the following example:
Thermo Exactive--2008-10-22--08-17-22.log
Each line in a log file is a message. A message has several properties that
are listed at the beginning of the line, followed by the message body.
Properties are enclosed in brackets. A property is a property name
followed by an equal sign followed by the property value. These
properties exist:
Abbreviation

Meaning

Time

Time of the message. The current local time is displayed
followed by the time offset to UTC.

Acc

Windows™ account name that caused this message;
“(none)” is used for an instrument source. Other known
values are “ExactiveUser” and “Xcalibur_System”.

User

User name description of the Windows account

Comp

Computer name on which this message was caused,
“(none)” is used for an instrument source.

App

Application name that caused this message; “(none)” is
used for an instrument source.

PID

Process identifier of the application process

Inst

Instrument affected

Conn

Connection in charge for the communication with the
instrument

Type

Type of the message. Message types are “info”,
“warning”, “error” and “FATAL error”

Access to the log files is regulated by the Microsoft™ Windows user
account or group account. Full access to the log files is granted to
Administrators. Members of the Power User group can read, delete, and
modify these files. Standard users can read these files.
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Tune Files and Calibration Files
Tune files and calibration files contain information for operating the
instrument.

Tune Files
Tuning optimizes voltage settings for API source and ion transfer optics
to ensure highest sensitivity. The resulting tune file (*.mstune) is specific
to a particular analyte and solvent flow rate.
During installation of the instrument, the service engineer creates a tune
file HESI_Installation.mstune in the folder C:\Xcalibur\methods\. Use
this file as a starting point for optimizing the mass spectrometer for your
specific measurement requirements. Use this folder to store your
personal tune files.
NOTICE Do not overwrite the default tune file
C:\Xcalibur\methods\HESI_Installation.mstune! ▲

Calibration File
After having tuned the Exactive Plus mass spectrometer, calibrate the
instrument to ensure the mass accuracy of the measurement results.
Calibration parameters are instrument parameters whose values do not
vary with the type of experiment. They are stored automatically in a
calibration file (*.mscal) in the folder
C:\Xcalibur\system\Exactive\instrument\msx_instrument_files\.
The file master_cal.mscal contained in this folder is the calibration file
used for operating the instrument. It will be overwritten with new
calibration values every time a calibration procedure is successful.
NOTICE Never save or change files in the folder
C:\Xcalibur\system\Exactive\instrument\msx_instrument_files\! Files in
this folder are automatically managed by the instrument software. ▲
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API Source Settings for Various LC Flow Rates
The ESI, H-ESI, and HESI-II probes can generate ions from liquid
flows of 1 μL/min to 1.0 mL/min. With this flow rate range you can use
a variety of separation techniques: capillary LC, microbore LC, and
analytical LC. An optional nanospray ion source is available for
sub-microliter analysis. The APCI probe can generate ions from liquid
flows as low as 50 μL/min, but typical flow rates are from 0.2 to
2.0 mL/min. Within this range of flow rates, you can use separation
techniques such as microbore LC, analytical LC, and semi-preparative
LC.
As you change the rate of flow of solvents entering the mass
spectrometer, you must adjust several of the mass spectrometer
parameters:
•

For ESI, adjust the temperatures of the ion transfer tube and adjust
the gas flow rates for the sheath gas and auxiliary gas.

•

For H-ESI, adjust the temperatures of the ion transfer tube and the
vaporizer, and adjust the gas flow rates for the sheath gas and
auxiliary gas.

•

For APCI, adjust the temperatures of the ion transfer tube and the
vaporizer, and adjust the gas flow rates for the sheath gas and
auxiliary gas.

In general, the higher the rate of liquid flowing into the mass
spectrometer, the higher the temperature of the ion transfer tube (and
vaporizer) and the higher the gas flows.
Table 6-1 provides guidelines for setting H-ESI operating parameters for
various LC solvent flow rates. Table 6-2 provides guidelines for setting
ESI operating parameters. Table 6-3 provides guidelines for setting
APCI operating parameters.
Table 6-1. Guidelines for setting operating parameters for LC/H-ESI/MS
Liquid flow rate
(μL/min)

Capillary (ion transfer
tube) temperature
(°C)a

Vaporizer
temperature
(°C)b

Sheath gas
pressure
(arbitrary units)

Auxiliary gas flow
(arbitrary units)

Spray voltage
(V)

5

240

Off to 50

5

0 to 10c

+3000 (-2500)d

200

350

250 to 300

35

30 (H-ESI probe) +3000 (-2500)
10 (HESI-II probe)
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Table 6-1. Guidelines for setting operating parameters for LC/H-ESI/MS
Liquid flow rate
(μL/min)

Capillary (ion transfer
tube) temperature
(°C)a

Vaporizer
temperature
(°C)b

500

380

300 to 400
60
(H-ESI probe)
300 to 500
(HESI-II
probe)

50 (H-ESI probe) +3000 (-2500)
20 (HESI-II probe)

1000

400

350 to 450
75
(H-ESI probe)
500 (HESI-II
probe)

60 (H-ESI probe) +3000 (-2500)
20 (HESI-II probe)

a Always

Auxiliary gas flow
(arbitrary units)

Spray voltage
(V)

optimize the S-lens RF voltage whenever you change the temperature of the ion transfer tube.

bCompound
c Aux

Sheath gas
pressure
(arbitrary units)

dependent

gas flow must be greater than 0 if the vaporizer is on.

dNegative

ion mode

Table 6-2. Guidelines for setting operating parameters for LC/ESI/MS

a

Liquid flow
rate
(μL/min)

Suggested column ID
size (mm)

Spray voltage
(V)

Capillary
temperature
(°C)

Sheath gas
(arbitrary units)

Auxiliary gas
(arbitrary units)

less than 10

Capillary

3000 (-2500)a

200 to 250

5 to 30

Off

50 to 100

1.0

3000 (-2500)

250 to 300

10 to 30

5 to 10

200 to 400

2.1 to 4.6

3500 (-2500)

300 to 350

20 to 40

10 to 20

greater than
400

4.6

4000 (-3500)

350

30 to 75

10 to 40

Negative ion mode

Table 6-3. Guidelines for setting operating parameters for LC/APCI/MS
Liquid flow rate
(μL/min)

Capillary temperature
(°C)

APCI vaporizer
temperature
(°C)

Sheath gas
(arbitrary units)

Auxiliary gas
(arbitrary units)

200

250

350

25

5

Corona discharge
current
(μA)
+4 (-10)a

1000

250

450

45

5

+4 (-10)

a Negative

ion mode
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Glossary
This section lists and defines terms used in this manual. It also includes acronyms, metric prefixes, symbols, and
abbreviations.
A

B

C

D

E

F

G

H

I

J

K

L

A
A ampere
AC alternating current
ADC analog-to-digital converter; a device that converts
data from analog to digital form.
adduct ion An ion formed by the joining together of
two species, usually an ion and a molecule, and often
within the ion source, to form an ion containing all
the constituent atoms of both species.
AGC™ See Automatic Gain Control™ (AGC).
APCI See atmospheric pressure chemical ionization
(APCI).
APCI corona discharge current The ion current
carried by the charged particles in the APCI source.
The voltage on the APCI corona discharge needle
supplies the potential required to ionize the particles.
The APCI corona discharge current is set; the APCI
corona discharge voltage varies, as required, to
maintain the set discharge current.
See also corona discharge and APCI corona discharge
voltage.
APCI corona discharge voltage The high voltage that
is applied to the corona discharge needle in the APCI
source to produce the APCI corona discharge. The
corona discharge voltage varies, as required, to
maintain the set APCI spray current.
See also APCI spray current.
APCI manifold The manifold that houses the APCI
sample tube and nozzle, and contains the plumbing
for the sheath and auxiliary gas.
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M N

O

P

Q

R

S

T

U

V W X

Y

Z

APCI needle, corona discharge A needle to which a
sufficiently high voltage (typically ±3 to ±5 kV) is
applied to produce a chemical ionization plasma by
the corona discharge mechanism.
See also chemical ionization (CI), chemical ionization
(CI) plasma, atmospheric pressure chemical ionization
(APCI), and corona discharge.
APCI nozzle The nozzle in the APCI probe that sprays
the sample solution into a fine mist.
See also atmospheric pressure chemical ionization
(APCI).
APCI sample tube A fused silica tube that delivers
sample solution to the APCI nozzle. The APCI
sample tube extends from the sample inlet to the
APCI nozzle.
See also atmospheric pressure chemical ionization
(APCI), and API stack.
APCI source Contains the APCI probe assembly,
APCI manifold, and API stack.
See also atmospheric pressure chemical ionization
(APCI), APCI manifold, and API stack.
APCI spray current The ion current carried by the
charged particles in the APCI source. The APCI
corona discharge voltage varies, as required, to
maintain the set spray current.
APCI vaporizer A heated tube that vaporizes the
sample solution as the solution exits the sample tube
and enters the atmospheric pressure region of the
APCI source.
See also atmospheric pressure chemical ionization
(APCI).
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Glossary: API–atmospheric pressure chemical ionization (APCI)

API See atmospheric pressure ionization (API).
API atmospheric pressure region The first of two
chambers in the API source. Also referred to as the
spray chamber.
API capillary-skimmer region The area between the
capillary and the skimmer, which is surrounded by the
tube lens. It is also the area of first-stage evacuation in
the API source.
API heated capillary A tube assembly that assists in
desolvating ions that are produced by the ESI or
APCI probe.
See also API heated capillary voltage.
API heated capillary voltage The DC voltage applied
to the heated capillary. The voltage is positive for
positive ions and negative for negative ions.
See also API source and API heated capillary.
API ion transfer capillary A tube assembly that assists
in desolvating ions that are produced by the ESI, NSI,
or APCI probe.
See also API ion transfer capillary offset voltage and
API ion transfer capillary temperature.
API ion transfer capillary offset voltage A DC voltage
applied to the ion transfer capillary. The voltage is
positive for positive ions and negative for negative
ions.
See also API source and API ion transfer capillary.
API ion transfer capillary temperature The
temperature of the ion transfer capillary, which should
be adjusted for different flow rates.
See also API source and API ion transfer capillary.
API source The sample interface between the LC and
the mass spectrometer. It consists of the API probe
(ESI or APCI) and API stack.
See also atmospheric pressure ionization (API), ESI
source, APCI source, ESI probe, and API stack.
API spray chamber The first of two chambers in the
API source. In this chamber the sample liquid exits
the probe and is sprayed into a fine mist (ESI or NSI)
or is vaporized (APCI) as it is transported to the
entrance end of the ion transfer capillary.
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API spray shield A stainless steel, cylindrical vessel
that, in combination with the ESI or APCI flange,
forms the atmospheric pressure region of the
API source.
See also atmospheric pressure ionization (API).
API stack Consists of the components of the
API source that are held under vacuum and includes
the API spray shield, API ion transfer capillary,
API tube lens, skimmer, the ion transfer capillary
mount, and the tube lens and skimmer mount.
See also atmospheric pressure ionization (API) and
API source.
API tube lens A lens in the API source that separates
ions from neutral particles as they leave the ion
transfer capillary. A potential applied to the tube lens
focuses the ions toward the opening of the skimmer
and helps to dissociate adduct ions.
See also API tube lens offset voltage, API source,
API ion transfer capillary, and adduct ion.
API tube lens and skimmer mount A mount that
attaches to the heated capillary mount. The tube lens
and skimmer attach to the tube lens and skimmer
mount.
API tube lens offset voltage A DC voltage applied to
the tube lens. The value is normally tuned for a
specific compound.
See also API tube lens, adduct ion, and source CID.
AP-MALDI See atmospheric pressure matrix-assisted
laser desorption/ionization (AP-MALDI).
APPI See Atmospheric Pressure Photoionization
(APPI).
ASCII American Standard Code for Information
Interchange
atmospheric pressure chemical ionization (APCI) A
soft ionization technique done in an ion source
operating at atmospheric pressure. Electrons from a
corona discharge initiate the process by ionizing the
mobile phase vapor molecules. A reagent gas forms,
which efficiently produces positive and negative ions
of the analyte through a complex series of chemical
reactions.
See also electrospray ionization (ESI).
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Glossary: atmospheric pressure ionization (API)–consecutive reaction monitoring (CRM) scan type

atmospheric pressure ionization (API) Ionization
performed at atmospheric pressure by using
atmospheric pressure chemical ionization (APCI),
electrospray ionization (ESI), or nanospray ionization
(NSI).

B

atmospheric pressure matrix-assisted laser
desorption/ionization (AP-MALDI) Matrix-assisted
laser desorption/ionization in which the sample target
is at atmospheric pressure.

baud rate data transmission speed in events per second

See also matrix-assisted laser desorption/ionization
(MALDI).
Atmospheric Pressure Photoionization (APPI) A soft
ionization technique in which an ion is generated
from a molecule when it interacts with a photon from
a light source.
atomic mass unit Atomic Mass Unit (u) defined by
taking the mass of one atom of carbon12 as being
12u; unit of mass for expressing masses of atoms or
molecules.
Automatic Gain Control™ (AGC) Sets the ion
injection time to maintain the optimum quantity of
ions for each scan. With AGC on, the scan function
consists of a prescan and an analytical scan.
See also ion injection time.
auxiliary gas The outer-coaxial gas (nitrogen) that
assists the sheath (inner-coaxial) gas in dispersing
and/or evaporating sample solution as the sample
solution exits the APCI, ESI, or H-ESI nozzle.
auxiliary gas flow rate The relative rate of flow of
auxiliary gas (nitrogen) into the API source reported
in arbitrary units.
auxiliary gas inlet An inlet in the API probe where
auxiliary gas is introduced into the probe.
See also auxiliary gas and atmospheric pressure
ionization (API).
auxiliary gas plumbing The gas plumbing that delivers
outer coaxial nitrogen gas to the ESI or APCI nozzle.
auxiliary gas valve A valve that controls the flow of
auxiliary gas into the API source.

Thermo Fisher Scientific

b bit
B byte (8 b)

BTU British thermal unit, a unit of energy

C
°C degrees Celsius
CE central electrode (of the Orbitrap analyzer);
European conformity. Mandatory European marking
for certain product groups to indicate conformity with
essential health and safety requirements set out in
European Directives.
cfm cubic feet per minute
chemical ionization (CI) The formation of new
ionized species when gaseous molecules interact with
ions. The process can involve transfer of an electron,
proton, or other charged species between the
reactants.
chemical ionization (CI) plasma The collection of
ions, electrons, and neutral species formed in the ion
source during chemical ionization.
See also chemical ionization (CI).
CI See chemical ionization (CI).
CID See collision-induced dissociation (CID).
cm centimeter
cm3 cubic centimeter
collision gas A neutral gas used to undergo collisions
with ions.
collision-induced dissociation (CID) An ion/neutral
process in which an ion is dissociated as a result of
interaction with a neutral target species.
consecutive reaction monitoring (CRM) scan type A
scan type with three or more stages of mass analysis
and in which a particular multi-step reaction path is
monitored.
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Glossary: Convectron™ gauge–ESI flange

Convectron™ gauge A thermocouple bridge gauge that
is sensitive to the pressure as well as the thermal
conductivity of the gas used to measure pressures
between X and Y.
corona discharge In the APCI source, an electrical
discharge in the region around the corona discharge
needle that ionizes gas molecules to form a chemical
ionization (CI) plasma, which contains CI reagent
ions.
See also chemical ionization (CI) plasma and
atmospheric pressure chemical ionization (APCI).
CPU central processing unit (of a computer)
CRM See consecutive reaction monitoring (CRM) scan
type.
C-Trap curved linear trap
<Ctrl> control key on the terminal keyboard

D
d depth
Da dalton
DAC digital-to-analog converter
damping gas Helium gas introduced into the ion trap
mass analyzer that slows the motion of ions entering
the mass analyzer so that the ions can be trapped by
the RF voltage fields in the mass analyzer.
data-dependent scan A scan mode that uses specified
criteria to select one or more ions of interest on which
to perform subsequent scans, such as MS/MS or
ZoomScan.
DC direct current
divert/inject valve A valve on the mass spectrometer
that can be plumbed as a divert valve or as a loop
injector.
DS data system
DSP digital signal processor

E

EI electron ionization
electron capture dissociation (ECD) A method of
fragmenting gas phase ions for tandem mass
spectrometric analysis. ECD involves the direct
introduction of low energy electrons to trapped gas
phase ions.
See also electron transfer dissociation (ETD) and
infrared multiphoton dissociation (IRMPD).
electron multiplier A device used for current
amplification through the secondary emission of
electrons. Electron multipliers can have a discrete
dynode or a continuous dynode.
electron transfer dissociation (ETD) A method of
fragmenting peptides and proteins. In electron
transfer dissociation (ETD), singly charged reagent
anions transfer an electron to multiply protonated
peptides within the ion trap mass analyzer. This leads
to a rich ladder of sequence ions derived from cleavage
at the amide groups along the peptide backbone.
Amino acid side chains and important modifications
such as phosphorylation are left intact.
See also fluoranthene.
electrospray ionization (ESI) A type of atmospheric
pressure ionization that is currently the softest
ionization technique available to transform ions in
solution into ions in the gas phase.
EMBL European Molecular Biology Laboratory
<Enter> Enter key on the terminal keyboard
ESD ElectroStatic Discharge. Discharge of stored static
electricity that can damage electronic equipment and
impair electrical circuitry, resulting in complete or
intermittent failures.
ESI See electrospray ionization (ESI).
ESI flange A flange that holds the ESI probe in
position next to the entrance of the heated capillary,
which is part of the API stack. The ESI flange also
seals the atmospheric pressure region of the API
source and, when it is in the engaged position against
the spray shield, compresses the high-voltage
safety-interlock switch.

ECD See electron capture dissociation (ECD).
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Glossary: ESI probe–FWHM

ESI probe A probe that produces charged aerosol
droplets that contain sample ions. The ESI probe is
typically operated at liquid flows of 1 μL/min to
1 mL/min without splitting. The ESI probe includes
the ESI manifold, sample tube, nozzle, and needle.

Fast Fourier Transform (FFT) An algorithm that
performs a Fourier transformation on data. A Fourier
transform is the set of mathematical formulae by
which a time function is converted into a
frequency-domain function and the converse.

ESI source Contains the ESI probe and the API stack.

FFT See Fast Fourier Transform (FFT).

See also electrospray ionization (ESI), ESI probe, and
API stack.

fluoranthene A reagent anion that is used in an
electron transfer dissociation (ETD) experiment.

ESI spray current The flow of charged particles in the
ESI source. The voltage on the ESI spray needle
supplies the potential required to ionize the particles.

firmware Software routines stored in read-only
memory. Startup routines and low-level input/output
instructions are stored in firmware.

ESI spray voltage The high voltage that is applied to
the spray needle in the ESI source to produce the
ESI spray current. In ESI, the voltage is applied to the
spray liquid as it emerges from the nozzle.

forepump The pump that evacuates the foreline. A
rotary-vane pump is a type of forepump.

See also ESI spray current.
ETD See electron transfer dissociation (ETD).
eV Electron Volt. The energy gained by an electron that
accelerates through a potential difference of one volt.
Extensible Markup Language See XML (Extensible
Markup Language).
external lock mass A lock that is analyzed in a separate
MS experiment from your sample. If you need to run
a large number of samples, or if accurate mass samples
will be intermingled with standard samples, you might
want to use external lock masses. These allow more
rapid data acquisition by eliminating the need to scan
lock masses during each scan.
See also internal lock mass.

Fourier Transform - Ion Cyclotron Resonance Mass
Spectrometry (FT-ICR MS) A technique that
determines the mass-to-charge ratio of an ion by
measuring its cyclotron frequency in a strong
magnetic field.
fragment ion A charged dissociation product of an
ionic fragmentation. Such an ion can dissociate
further to form other charged molecular or atomic
species of successively lower formula weights.
fragmentation The dissociation of a molecule or ion to
form fragments, either ionic or neutral. When a
molecule or ion interacts with a particle (electron, ion,
or neutral species) the molecule or ion absorbs energy
and can subsequently fall apart into a series of charged
or neutral fragments. The mass spectrum of the
fragment ions is unique for the molecule or ion.
FT Fourier Transformation

F

FT-ICR MS See Fourier Transform - Ion Cyclotron
Resonance Mass Spectrometry (FT-ICR MS).

f femto (10-15)

FTMS Fourier Transformation Mass Spectrometry

°F degrees Fahrenheit

full-scan type Provides a full mass spectrum of each
analyte or parent ion. With the full-scan type, the
mass analyzer is scanned from the first mass to the last
mass without interruption. Also known as single-stage
full-scan type.

.fasta file extension of a SEQUEST™ search database
file
ft foot

FWHM Full Width at Half Maximum
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Glossary: g–ion optics

G

Hz hertz (cycles per second)

g gram

I

G Gauss; giga (109)

ICR ion cyclotron resonance

GC gas chromatograph; gas chromatography

ID inside diameter

GC/MS gas chromatography / mass spectrometer

IEC International Electrotechnical Commission

GUI graphical user interface

IEEE Institute of Electrical and Electronics Engineers

H

in. inch

h hour

infrared multiphoton dissociation (IRMPD) In
infrared multiphoton dissociation (IRMPD), multiply
charged ions consecutively absorb photons emitted by
a infrared laser until the vibrational excitation is
sufficient for their fragmentation. The fragments
continue to pick up energy from the laser pulse and
fall apart further to ions of lower mass.

h height
handshake A signal that acknowledges that
communication can take place.
HCD See higher energy collision-induced dissociation
(HCD).
header information Data stored in each data file that
summarizes the information contained in the file.
H-ESI probe Heated-electrospray ionization (H-ESI)
converts ions in solution into ions in the gas phase by
using electrospray ionization (ESI) in combination
with heated auxiliary gas.
higher energy collision-induced dissociation (HCD)
Collision-induced dissociation that occurs in the
HCD cell of the Orbitrap mass analyzer. The
HCD cell consists of a straight multipole mounted
inside a collision gas-filled tube. A voltage offset
between C-Trap and HCD cell accelerates parent ions
into the collision gas inside the HCD cell, which
causes the ions to fragment into product ions. The
product ions are then returned to the Orbitrap
analyzer for mass analysis. HCD produces triple
quadrupole-like product ion mass spectra.
high performance liquid chromatography (HPLC)
Liquid chromatography in which the liquid is driven
through the column at high pressure. Also known as
high pressure liquid chromatography.
HPLC See high performance liquid chromatography
(HPLC).

See also electron capture dissociation (ECD).
instrument method A set of experiment parameters
that define Xcalibur operating settings for the
autosampler, liquid chromatograph (LC), mass
spectrometer, divert valve, syringe pump, and so on.
Instrument methods are saved as file type .meth.
internal lock mass A lock that is analyzed during the
same MS experiment as your sample and is contained
within the sample solution or infused into the
LC flow during the experiment. Internal lock masses
provide the most accurate corrections to the data.
See also external lock mass.
I/O input/output
ion gauge Measures the pressure in the mass analyzer
region (high vacuum region) of the vacuum manifold.
ion injection time The amount of time that ions are
allowed to accumulate in the ion trap mass analyzer
when AGC is off. With AGC on, the ion injection
time is set automatically (up to the set maximum ion
injection time) based on the AGC target value.
See also: Automatic Gain Control™ (AGC).
ion optics Focuses and transmits ions from the
API source to the mass analyzer.

HV high voltage
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Glossary: ion source–MH+

ion source A device that converts samples to gas-phase
ions.
ion sweep cone A removable cone-shaped metal cover
that fits on top of the API ion transfer capillary and
acts as a physical barrier to protect the entrance of the
capillary.
ion sweep gas Extra nitrogen gas that flows along the
axis of the API ion transfer capillary (between the ion
sweep cone and the capillary block) towards the API
spray. The sweep gas flow is thus countercurrent to the
flow of the ions.
See also ion sweep gas pressure.
ion sweep gas pressure The rate of flow of the sweep
gas (nitrogen) into the API source. A measurement of
the relative flow rate (in arbitrary units) to provide the
required flow of nitrogen gas out from the Ion Sweep
cone towards the API spray.
See also ion sweep gas.

LED light-emitting diode
LHe liquid helium
liquid chromatography (LC) A form of elution
chromatography in which a sample partitions between
a stationary phase of large surface area and a liquid
mobile phase that percolates over the stationary phase.
liquid chromatography / mass spectrometry
(LC/MS) An analytical technique in which a
high-performance liquid chromatograph (LC) and a
mass spectrometer (MS) are combined.
LN2 liquid nitrogen
lock mass A known reference mass in the sample that is
used to correct the mass spectral data in an accurate
mass experiment and used to perform a real-time
secondary mass calibration that corrects the masses of
other peaks in a scan. Lock masses with well-defined,
symmetrical peaks work best. You can choose to use
internal lock mass or external lock mass.

IRMPD See infrared multiphoton dissociation
(IRMPD).

log file A text file, with a .log file extension, that is used
to store lists of information.

K

M

k kilo (103, 1000)

m micro (10-6)

K kilo (210, 1024)

m meter; milli (10-3)

KEGG Kyoto Encyclopedia of Genes and Genomes

M mega (106)

kg kilogram

M+ molecular ion

L

MALDI See matrix-assisted laser desorption/ionization
(MALDI).

l length
L liter
LAN local area network
lb pound
LC See liquid chromatography (LC).
LC/MS See liquid chromatography / mass spectrometry
(LC/MS).

matrix-assisted laser desorption/ionization
(MALDI) A method of ionizing proteins where a direct
laser beam is used to facilitate vaporization and
ionization while a matrix protects the biomolecule
from being destroyed by the laser.
See also atmospheric pressure matrix-assisted laser
desorption/ionization (AP-MALDI).
MB Megabyte (1048576 bytes)
MH+ protonated molecular ion
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Glossary: microscan–Orbitrap mass analyzer

microscan One mass analysis (ion injection and storage
or scan-out of ions) followed by ion detection.
Microscans are summed, to produce one scan, to
improve the signal-to-noise ratio of the mass spectral
data. The number of microscans per scan is an
important factor in determining the overall scan time.

multipole A symmetrical, parallel array of (usually)
four, six, or eight cylindrical rods that acts as an ion
transmission device. An RF voltage and DC offset
voltage are applied to the rods to create an electrostatic
field that efficiently transmits ions along the axis of
the multipole rods.

min minute

m/z Mass-to-charge ratio. An abbreviation used to
denote the quantity formed by dividing the mass of an
ion (in u) by the number of charges carried by the ion.
For example, for the ion C7H72+, m/z=45.5.

mL milliliter
mm millimeter
MRFA A peptide with the amino acid sequence
methionine–arginine–phenylalanine–alanine.
MS mass spectrometer; mass spectrometry
MS MSn power: where n = 1
MS scan modes Scan modes in which only one stage of
mass analysis is performed. The scan types used with
the MS scan modes are full-scan type and selected ion
monitoring (SIM) scan type.
MSDS Material Safety Data Sheet
MS/MS Mass spectrometry/mass spectrometry, or
tandem mass spectrometry is an analytical technique
that involves two stages of mass analysis. In the first
stage, ions formed in the ion source are analyzed by an
initial analyzer. In the second stage, the mass-selected
ions are fragmented and the resultant ionic fragments
are mass analyzed.
MSn scan mode The scan power equal to 1 to 10,
where the scan power is the power n in the expression
MSn. MSn is the most general expression for the scan
mode, which can include the following:
• The scan mode corresponding to the one stage of
mass analysis in a single-stage full-scan experiment
or a selected ion monitoring (SIM) experiment
• The scan mode corresponding to the two stages of
mass analysis in a two-stage full-scan experiment or
a selected reaction monitoring (SRM) experiment
• The scan mode corresponding to the three to ten
stages of mass analysis (n = 3 to n = 10) in a
multi-stage full-scan experiment or a consecutive
reaction monitoring (CRM) experiment

N
n nano (10-9)
nanospray ionization (NSI) A type of electrospray
ionization (ESI) that accommodates very low flow
rates of sample and solvent on the order of 1 to
20 nL/min (for static nanospray) or 100
to 1000 nL/min (for dynamic nanospray).
NCBI National Center for Biotechnology Information
(USA)
NIST National Institute of Standards and Technology
(USA)
NMR Normal Mass Range
NSI See nanospray ionization (NSI).

O
octapole An octagonal array of cylindrical rods that acts
as an ion transmission device. An RF voltage and
DC offset voltage applied to the rods create an
electrostatic field that transmits the ions along the axis
of the octapole rods.

OD outside diameter
Orbitrap mass analyzer The Orbitrap™ mass analyzer
consists of a spindle-shape central electrode
surrounded by a pair of bell-shaped outer electrodes.
Ions inside the mass analyzer orbit in stable
trajectories around the central electrode with
harmonic oscillations along it.

See also MS scan modes and MS/MS.
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Glossary: OT–raw data

P/N part number

r

p-p peak-to-peak voltage
z

ppm parts per million
Two detection electrodes record an image current of
the ions as they undergo harmonic oscillations. A
Fourier transformation extracts different harmonic
frequencies from the image current. An ion's
mass-to-charge ratio m/z is related to the frequency f
of its harmonic oscillations and to the instrumental
constant k by:
m/z = k/f 2
OT Orbitrap
See Orbitrap mass analyzer.

PQD pulsed-Q dissociation
precursor ion An electrically charged molecular species
that can dissociate to form fragments. The fragments
can be electrically charged or neutral species. A
precursor ion (PR) can be a molecular ion or an
electrically charged fragment of a molecular ion. Also
known as parent ion.
precursor mass Mass of the corresponding precursor
(or parent) ion or molecule.
psig pounds per square inch, gauge

OVC outer vacuum case

PTM posttranslational modification

W ohm

pulsed Q dissociation (PQD) Collision-induced
dissociation that involves precursor ion activation at
high Q, a time delay to allow the precursor to
fragment, and then a rapid pulse to low Q where all
fragment ions are trapped. The fragment ions can
then be scanned out of the ion trap mass analyzer and
detected. PQD eliminates the “1/3 Rule” low mass
cut-off for MS/MS data.

P
p pico (10-12)
Pa pascal
parent ion An electrically charged molecular species
that can dissociate to form fragments. The fragments
can be electrically charged or neutral species. A parent
ion can be a molecular ion or an electrically charged
fragment of a molecular ion. Also called a precursor
ion.
parent mass The mass-to-charge ratio of a parent ion.
The location of the center of a target parent-ion peak
in mass-to-charge ratio (m/z) units. Also known as
precursor mass.
See also parent ion.
PCB printed circuit board
PDA detector Photodiode Array detector is a linear
array of discrete photodiodes on an integrated circuit
chip. It is placed at the image plane of a spectrometer
to allow a range of wavelengths to be detected
simultaneously.
PE protective earth
PID proportional / integral / differential

Thermo Fisher Scientific

Q
quadrupole A symmetrical, parallel array of four
hyperbolic rods that acts as a mass analyzer or an ion
transmission device. As a mass analyzer, one pair of
opposing rods has an oscillating radio frequency (RF)
voltage superimposed on a positive direct current
(DC) voltage. The other pair has a negative DC
voltage and an RF voltage that is 180 degrees out of
phase with the first pair of rods. This creates an
electrical field (the quadrupole field) that efficiently
transmits ions of selected mass-to-charge ratios along
the axis of the quadrupole rods.

R
RAM random access memory
raw data Uncorrected liquid chromatograph and mass
spectrometer data obtained during an acquisition.
Xcalibur and Xcalibur-based software store this data in
a file that has a .raw file extension.
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Glossary: resolution–sheath gas valve

resolution The ability to distinguish between two
points on the wavelength or mass axis.
retention time (RT) The time after injection at which
a compound elutes. The total time that the compound
is retained on the chromatograph column.
RF radio frequency
RF lens A multipole rod assembly that is operated with
only radio frequency (RF) voltage on the rods. In this
type of device, virtually all ions have stable trajectories
and pass through the assembly.
RF voltage An AC voltage of constant frequency and
variable amplitude that is applied to the ring electrode
or endcaps of the mass analyzer or to the rods of a
multipole. Because the frequency of this AC voltage is
in the radio frequency (RF) range, it is referred to as
RF voltage.
RMS root mean square
ROM read-only memory
rotary-vane pump A mechanical vacuum pump that
establishes the vacuum necessary for the proper
operation of the turbomolecular pump. (Also called a
roughing pump or forepump.)
RS-232 An accepted industry standard for serial
communication connections. This Recommended
Standard (RS) defines the specific lines and signal
characteristics used by serial communications
controllers to standardize the transmission of serial
data between devices.
RT An abbreviated form of the phrase retention time
(RT). This shortened form is used to save space when
the retention time (in minutes) is displayed in a
header, for example, RT: 0.00-3.75.

S
s second
scan mode and scan type combinations A function
that coordinates the three processes in the
MS detector: ionization, mass analysis, and ion
detection. You can combine the various scan modes
and scan types to perform a wide variety of
experiments.
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selected ion monitoring (SIM) scan type A scan type
in which the mass spectrometer acquires and records
ion current at only one or a few selected
mass-to-charge ratio values.
See also selected reaction monitoring (SRM) scan
type.
selected reaction monitoring (SRM) scan type A scan
type with two stages of mass analysis and in which a
particular reaction or set of reactions, such as the
fragmentation of an ion or the loss of a neutral moiety,
is monitored. In SRM a limited number of product
ions is monitored.
SEM secondary electron multiplier
Serial Peripheral Interface (SPI) hardware and
firmware communications protocol
serial port An input/output location (channel) for
serial data transmission.
sheath gas The inner coaxial gas (nitrogen), which is
used in the API source to help nebulize the sample
solution into a fine mist as the sample solution exits
the ESI or APCI nozzle.
sheath gas flow rate The rate of flow of sheath gas into
the API source. A measurement of the relative flow
rate (in arbitrary units) that needs to be provided at
the sheath gas inlet to provide the required flow of
sheath gas to the ESI or APCI nozzle.
sheath gas inlet An inlet in the API probe where sheath
gas is introduced into the probe.
sheath gas plumbing The gas plumbing that delivers
sheath gas to the ESI or APCI nozzle.
sheath gas pressure The rate of flow of sheath gas
(nitrogen) into the API source. A measurement of the
relative flow rate (in arbitrary units) that needs to be
provided at the sheath gas inlet to provide the required
flow of inner coaxial nitrogen gas to the ESI or APCI
nozzle. A software-controlled proportional valve
regulates the flow rate.
See also sheath gas.
sheath gas valve A valve that controls the flow of
sheath gas into the API source. The sheath gas valve is
controlled by the data system.
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Glossary: signal-to-noise ratio (S/N)–V DC

signal-to-noise ratio (S/N) The ratio of the signal
height (S) to the noise height (N). The signal height is
the baseline corrected peak height. The noise height is
the peak-to-peak height of the baseline noise.
SIM See selected ion monitoring (SIM) scan type.
skimmer A vacuum baffle between the higher pressure
capillary-skimmer region and the lower pressure
region. The aperture of the skimmer is offset with
respect to the bore of the ion transfer capillary.
source CID A technique for fragmenting ions in an
atmospheric pressure ionization (API) source.
Collisions occur between the ion and the background
gas, which increase the internal energy of the ion and
stimulate its dissociation.
SPI See Serial Peripheral Interface (SPI).
SRM See selected reaction monitoring (SRM) scan
type.
sweep gas Nitrogen gas that flows out from behind the
sweep cone in the API source. Sweep gas aids in
solvent declustering and adduct reduction.
See also sweep gas flow rate.
sweep gas flow rate The rate of flow of sweep gas into
the API source. A measurement of the relative flow
rate (in arbitrary units) to provide the required flow of
nitrogen gas to the sweep cone of the API source.
See also sweep gas.
syringe pump A device that delivers a solution from a
syringe at a specified rate.

T
T Tesla

total ion current (TIC) The sum of the ion current
intensities across the scan range in a mass spectrum.
tube lens offset The voltage offset from ground that is
applied to the tube lens to focus ions toward the
opening of the skimmer.
See also source CID.
Tune Method A defined set of mass spectrometer tune
parameters for the ion source and mass analyzer. Tune
methods are defined by using the instrument
software’s tune window and saved as tune file.
A tune method stores tune parameters only.
(Calibration parameters are stored separately, not with
the tune method.)
tune parameters Instrument parameters whose values
vary with the type of experiment.
turbomolecular pump A vacuum pump that provides
a high vacuum for the mass spectrometer and detector
system.
TWA time weighted average

U
u atomic mass unit
UHV ultra high vacuum
ultra-high performance liquid chromatography
(U-HPLC) See high performance liquid
chromatography (HPLC).
Ultramark 1621 A mixture of
perfluoroalkoxycyclotriphosphazenes used for ion trap
calibration and tuning. It provides ESI singly charged
peaks at m/z 1022.0, 1122.0, 1222.0, 1322.0, 1422.0,
1522.0, 1622.0, 1722.0, 1822.0, and 1921.9.

target compound A compound that you want to
identify or quantitate or that a specific protocol (for
example, an EPA method) requires that you look for.
Target compounds are also called analytes, or target
analytes.

UMR Universal Mass Range

TIC See total ion current (TIC).

V AC volts alternating current

TMP See turbomolecular pump.

V DC volts direct current

V
V volt

Torr A unit of pressure, equal to 1 mm of mercury and
133.32 Pa.
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Glossary: vacuum manifold–XML (Extensible Markup Language)

vacuum manifold A thick-walled, aluminum chamber
with machined flanges on the front and sides and
various electrical feedthroughs and gas inlets that
encloses the API stack, ion optics, mass analyzer, and
ion detection system.

W

vacuum system Components associated with lowering
the pressure within the mass spectrometer. A vacuum
system includes the vacuum manifold, pumps,
pressure gauges, and associated electronics.

WEEE European Union Waste Electrical and
Electronic Equipment Directive. Provides guidelines
for disposal of electronic waste.

vent valve A valve that allows the vacuum manifold to
be vented to air or other gases. A solenoid-operated
valve.
vol volume
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w width
W watt

X
XML (Extensible Markup Language) A
general-purpose markup language that is used to
facilitate the sharing of data across different
information systems, particularly via the Internet.
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Symbols
.csv file 4-73–4-74, 5-4
.exclude-masses file 3-48
.include-masses file 3-45
.lock-masses file 3-42
.log file 6-2
.meth file 4-36
.mscal file 6-3
.mstune file 4-5, 4-8, 6-3
.raw file 3-17, 4-35
.txt file 4-73–4-74, 5-4
.xml file 4-70, 4-73–4-74, 5-4

DART 4-30
ESI 4-14
H-ESI 4-18
MALDI 4-32
NSI 4-20

B
bakeout
duration 4-50
purpose 5-13

C
A
About dialog box 1-2, 4-62
acquisition time 4-36
Acquisition window 4-35
AGC target value 3-30, 3-32, 3-34, 3-36–3-37, 4-13
analysis graphs window
description 4-57
shortcut menu 4-58
toolbar 4-58
zooming 4-57
APCI
capillary temperature 4-24
corona discharge current 4-24
corona discharge voltage 4-24
sheath gas flow rate 4-23
source 4-23
source window 4-22
sweep gas flow rate 4-24
vaporizer temperature 4-25
apex trigger 3-39
APPI
sheath gas flow rate 4-26
source 4-26
source discharge current 4-27
source discharge voltage 4-27
source heated capillary temperature 4-28
source vaporizer temperature 4-28
source window 4-26, 4-29, 4-32
sweep gas flow rate 4-27
asterisk, in the title bar 4-2
Audit Trail 3-4
autosampler 4-36
auxiliary gas
APCI 4-23
APPI 4-27
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Calibrate window 4-41
calibration file 6-3
calibration parameters 4-41
calibration solution 4-41, 4-45
Calmix Calibration window 4-42
Calmix Evaluation window 4-46
capillary temperature 4-15, 4-18, 4-21
center mass 3-31, 3-33, 3-35–3-36, 4-67
charge exclusion 3-39
charge state 3-39, 3-46, 3-48
chromatogram display 3-17
clipboard 3-44, 3-47, 3-49, 4-56, 4-62, 4-72–4-73
comma separated values text file 5-4
comment, on current sample 4-36
communication status 2-2, 4-9
connection status 1-2
contact closure 3-15, 4-36–4-37
cooling and stabilization time 4-49
creep mode 4-54
Customized Calibration window 4-44
Customized Evaluation window 4-47

D
DART
sheath gas flow rate 4-30
source 4-29
source heated capillary temperature 4-31
source window 4-29
spray current 4-30
spray voltage 4-30
sweep gas flow rate 4-30
data acquisition 4-37
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Index: E–L

debug messages window 4-59
dialog boxes 3-42, 4-61
Display Options dialog box 4-78
display panel 4-4
Divert Valves page 3-11
duration, of bakeout 4-50
dynamic exclusion 3-40

spray current 4-18
spray voltage 4-18
sweep gas flow rate 4-18
HESI source window 4-17
high vacuum chamber 4-49, 5-15
Home Page window 2-1
Hot link 4-12–4-13

E

I

elapsed time
of current acquisition 4-35
of current procedure 4-38, 4-42, 4-45, 4-50
Elements window 4-39
error diagnosis 4-49, 4-55
ESI
auxiliary gas flow rate 4-14
sheath gas flow rate 4-14
source window 4-14
spray current 4-15
spray voltage 4-15
sweep gas flow rate 4-15
Evaluate window 4-45
evaluation procedure 4-45
Exactive window service 6-2
exclusion masses list 3-36
Experiment Setup page 3-7
exporting lock masses 5-3–5-4

image files 4-54, 4-58
importing lock masses 5-7
inclusion masses list 3-36
inject time 4-53
inside diameter, for syringes 4-64
in-source CID
activation 4-68
collision energy 3-30–3-31, 3-33, 3-35, 4-68
settings 4-12
instrument bakeout 4-49
Instrument Configuration program 3-2–3-3
Instrument Configuration window 1-1
Instrument Control panel 4-11
instrument files 1-2
instrument identification 4-62
instrument method 3-4–3-5, 4-36, 4-53
Instrument Setup window 3-2–3-3
instrument status 1-2, 4-8
instrument status window
shortcut menus 4-55
Vacuum System node 4-49
instrument type 1-2
ion polarity 4-53
ion source region 4-49
ionization method 4-29
IP address 1-2

F
File menu 3-3
File Summary Information Dialog Box 3-5
first mass 3-37
flow rate 3-27, 4-65
forevacuum line 4-49
fragmentation
settings 4-12, 4-68
type 4-53
Fragmentation dialog box 4-68

H
hardware status 2-2, 4-9
HCD cell
activating 4-68
tuning 4-39
header information 3-4–3-5
Help menu 3-5
H-ESI
heater temperature 4-19
sheath gas flow rate 4-17
source 4-17
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L
LC 4-38
license
key 4-63
settings 4-62
License dialog box 4-63
list, of recent scans 4-12
lock mass collection
deleting 4-76
name 4-75–4-76
Lock Mass Replacement dialog box 4-74
lock masses 3-24
creating 4-72
editing 3-42, 3-45, 3-47, 4-71
exporting 5-3
usage 4-13, 4-78
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Index: M–S

Lock Masses dialog box 3-42, 3-45, 3-47, 4-71
log file 1-2
Loop count 3-37

M
mains failure 5-13
MALDI
sheath gas flow rate 4-32
source 4-32
source heated capillary temperature 4-33
source window 4-32
spray current 4-33
spray voltage 4-33
sweep gas flow rate 4-33
manual control, of syringe pump 4-65
mass accuracy 5-17
mass calibration 5-17
mass resolution 3-30, 3-32, 3-34, 3-36, 4-12, 4-78
Mass Traces window 4-39
maximum injection time 3-31–3-32, 3-34, 3-36–3-37, 4-13
maximum value, for apex trigger 3-39
maximum value, for scan range 3-31, 3-33, 3-35–3-36, 4-67
menu bar 4-3
messages window 4-56
Method Editor 3-6
microscan 3-30, 3-32, 3-34, 3-36, 4-13, 4-53
minimum value, for apex trigger 3-39
minimum value, for scan range 3-31, 3-33, 3-35–3-36, 4-67
mouse
panning 4-53–4-54, 4-58
wheel 4-52, 4-57
zooming 4-54

O
Orbitrap chamber 4-49

P
page setup 3-4
Pathfinder 4-37
peptide match 3-39
peptide-like isotopic distributions 3-39
performance status 2-2, 4-10, 5-17
Pirani gauge 4-49
polarity 3-30–3-31, 3-33, 3-35, 3-43, 3-45, 3-48, 4-12
positive ion mode, calibration 4-43, 4-46
precision, of mass positions 4-78
pressure values 4-49
print preview 4-53, 4-58
printer’s parameters 4-53, 4-58
printing 3-4, 3-41
pumping, the system 5-13

Q
Q Exactive Tune
version 4-62
window 4-2
Qual Browser 4-35

R
removing, gases 5-13
Reports menu 4-6
resolution 3-30, 3-32, 3-34, 3-36, 4-12
RS-232 5-15

N
nanospray ionization 4-20
negative ion mode, calibration 4-43, 4-46
network address 1-2
network drives 4-35
noise level 4-53
normalized collision energy (NCE) 3-32, 3-34, 3-37, 3-46, 4-68
NSI
sheath gas flow rate 4-20
source 4-20
source window 4-20
spray current 4-21
spray voltage 4-21
sweep gas flow rate 4-21
number, of scans 4-53
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S
sample name 4-36
scan event 4-53
scan groups 3-18
Scan Parameters History dialog box 4-65
Scan Parameters window 4-12
scan range 4-12, 4-53, 4-66
Scan range dialog box 4-66
scan segment 4-53
scan type 4-53
Sequence Setup View 4-8
setup parameters 3-2–3-3
shortcut menus
analysis graphs window 4-58
debug messages window 4-60
instrument status window 4-55
Lock Masses dialog box 4-72
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Index: T–Z

spectrum window 4-54
Status page 2-1
tray icon 4-2
S-lens RF amplitude 4-16, 4-19, 4-22, 4-25, 4-28, 4-31, 4-34
source type 4-53
spectrum window
display options 4-78
toolbar 4-53
visibility 4-51
zooming 4-52
standby mode 4-50
Status page, of Information view 2-1
status, of current acquisition 4-35
Stepped NCE 3-32, 3-34, 3-38
Summary page 3-41
switch positions
of switching valves 3-25
of syringe pump 3-24–3-26
of tune files 3-24
syringe
diameter 3-27
type 3-27, 4-64
volume 3-27, 4-64
syringe pump
interface 5-15
manual control 4-65
operating status 3-26, 4-9
parameters 4-64
system bakeout 5-13
system tray, in Microsoft Windows 4-2

U
user role 4-3, 4-5

V
Vacuum / Bakeout window 4-49
vacuum gauges 4-49
Vacuum System node 4-49
validity period, of mass calibration 5-17
valve position 4-9
View bar 3-3

W
width, of scan range 3-31, 3-33, 3-35–3-36, 4-67

X

T
tasks panel 4-3, 4-11
text editor 4-56
title bar 3-43, 3-46, 3-48, 4-2
toggling, between mouse panning and mouse zooming 4-54
toolbars
analysis graphs window 4-58
Exactive Tune window 4-8
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spectrum window 4-53
tooltip 4-6
TopN 3-37
total ion current (TIC)
intensity 4-38
plotting 4-40
tune file 6-3
Tune Method 4-2, 4-5, 4-8
Tune window 4-38
tuning solution 4-38

Exactive Plus Software Manual (P/N 1323070, Revision A)

Xcalibur 4-8, 4-35, 4-37

Z
zooming
analysis graphs window 4-52, 4-57
spectrum window 4-52
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